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Introduction
You may be coming to Linux and KDE from another operating system, and you are probably familiar
with browsing the Web, sending email, preparing documents, and doing other jobrelated tasks with
your computer. Whether you’re somewhat experienced or completely new to computers, this book
was written for you.

In general, this book does not assume any computer experience on your part. We explain what
Linux and KDE are (Chapter 1, “Learning about the Pieces”), and we even tell you how to use your
mouse (with Linux there are three buttons). Of course the more experience you have, the more
quickly you’ll learn, because working with the KDE interface is very much like using other popular,
windows− based interfacesóbut with many important differences.

Although there are many commercial programs available for Linux, they are not the focus of this
book. Instead, we focus on programs that are available for free and commonly included in most
Linux distributions.

We don’t cover every application that comes with KDE, focusing instead on those you are most
likely to need in a typical of fice, or even home, environment. Once you become comfortable with
the material, it should be easy for you to learn about any specific commercial or free programs you
may wish to use.

Why This Book Is Different

Traditionally, Linux has been a favorite operating system of the more technically literate computer
users. So, you’ll find many Linux books that tell you Linux is like UNIX (it is), how to load Linux, why
Linux is g reat, and how to do specific things with Linux (such as run a webserver). There are also
many books that go into great detail about how to use specific software available for Linux (such as
The GIMP graphics program), as well as books that compare Microsoft Windows’ features to those
of Linux.

This book is different in that we assume you don’t want to install Linux, don’t want to learn how to be
a system administrator, and aren’t concerned with doing some of the more complicated tasks. We
assume you already have a working Linux system on your desk and need to use it to get your work
done. That work probably involves email, the Web, working with documents, and performing general
office tasks. Additionally, we assume that, in most cases, you will want to use the KDE graphical
user interface (GUI) that comes with Linux to perform these tasks. (Of course, once you become
proficient at all these tasks, you may want to learn what the command line is and how to do some
tasks more efficiently from it.)

This book is also unique in that it is the product of a number of employees at our company, SSC.
Contributors include Phil Hughes, our publisher; Carlie Fairchild, Rebecca Cassity, Clarica Grove,
and James Gray from the marketing department; Richard Vernon, Jill Franklin, Don Marti, Heather
Mead, and Joel Megal from editorial; our graphic artist, Lydia Kinata; our webmaster, Scott
Blanchard; and one of our sy stem administrators, Mike Orr.

SSC, as a publishing company, has been using Linux since 1993. Some of us have been working
with UNIX since 1980 and have progressed from the UNIX command−line interface to doing some
tasks with the GUI. Others came “off the street” with no UNIX or Linux experience, learned the GUI
first, and then expanded their knowledge to include command−line tools.
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As a result, we all remember what it’s like to learn certain job− related tasks with Linux and to be
exposed to the KDE desktop for the first time.

With the exception of magazine layout and some accounting tasks, all of our work is done on Linux.
A lot of it is done using the KDE desktop and the utilities included with most Linux distributions. We
have written this book to get you up and working on Linux and KDE quickly.

For the writing and testing of this book, we have used the Debian “Woody” and SuSE 7.3 and 8.0
distributions (see Chapter 1, “Learning about the Pieces,” for information on distributions). Also, like
Linux itself, many open−source programs are under constant development. For this reason, the
version of a given program that you are using may be different from the version discussed here. The
differences are normally in added features, however, and usually do not affect the core functions of
the program. So if you follow the instructions you find in these pages, you shouldn’t have any
trouble learning to use the applications, even if the version seems a little different.

So welcome to Linux and the KDE desktop! With a little practice, we’re confident that you’ll soon be
working proficiently and will come to appreciate the power, reliability, and even fun of the Linux
operating system.
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Chapter 1: Learning About the Pieces
Linux is said to be a “free” operating system (OS). This chapter explains exactly what that means
and how it affects the way Linux is distributed. It also provides an introduction to the KDE desktop,
its relation to Linux, and some of the more popular office− related software used on Linux.

What Is Linux?

Linux is a computer operating system, the most important program your computer runs. It controls
all of the programs that run on your computer by allocating resources, interpreting your instructions
(by using your mouse and keyboard), sending output to the monitor, keeping track of all files, and
performing many other important tasks.

Linux is different from most operating systems in that it has been developed by scores of
programmers around the world. Linux is free, both in the sense that you don’t have to pay for it
(though you can, and many people do) and in the sense that the source code (its internal pieces) is
available to anyone who wants to look at or modify it. Having its source code “open” makes it
possible for anyone to try Linux out, find bugs, and submit fixes that go to a central control point
before making their way into future versions of Linux.

The kernel is Linux’s central nervous system; it’s the operating system code that runs the whole
computer. Though some advanced Linux users make modifications to the kernel on their systems,
you probably won’t have anything to do with it. However, you should know that this is the core of
your computer’s system and that it is under constant development.

Because so many developers work on Linux, the pace of Linux development is quick, and problems
are usually found and addressed rapidly.

The Roots of Linux

Linux’s lineage goes back to UNIX, the most proven operating system in the world in that it (and its
variants) has been the most used networked computer OS for over three decades. UNIX was
developed at Bell Telephone Laboratories and designed to support many users working at many
computers at one time, all linked together and sharing information and resources. When using such
an operating system, more than one person can use a single computer’s hardware to do many
things at once, and a single user can do more than one thing ( multitask) on a single machine as
well. This makes for more efficient use of resources and a more powerful system.

Linux runs on a variety of platforms, including x86, PowerPC, DEC Alpha, Sun Sparc, and ARM, so
no matter what type of computer hardware you have, Linux will probably run on it. Linux aims for
POSIX (Portable Operating System Interface for UNIX) compliancy. POSIX is a set of standards
that defines an interface between programs and operating systems. By sticking to these standards,
software developers can be reasonably confident that their programs can be ported easily to any
POSIX− compliant operating systems, such as the various versions of UNIX. This means that Linux
users can take advantage of software made for general UNIX systems.

5



Linux Performance

Linux has been praised for its stability—computers running the Linux OS have been known to run
months or even years at a time without crashing, freezing, or having to be rebooted.

Linux machines are also known to be extremely fast because Linux is especially efficient at
managing resources such as memory, computer power, and disk space. In fact, much of the World
Wide Web is powered by older computers running Linux and the Apache webserver. Additionally,
organizations such as NASA, Sandia, and Fermilabs have built powerful, yet inexpensive,
supercomputers by combining groups of lesser−powered Linux machines and having them all work
together in clusters.

Linux Distributions

Because Linux is freely available, any company (or individual) can take it, add software to it, and
offer the resulting compilation (either free or for sale) as a Linux distribution. The result is a range of
available distributions. Some of the companies producing these distributions also make small
modifications to the Linux kernel and include their own software tools for managing and configuring
Linux in an effort to simplify installation and management. Although each distribution varies in minor
ways, most differ merely in the software they include.

The good news is that even if your distribution doesn’t include a tool or application you want, it
usually can be downloaded free from the Internet.

Ways of Communicating with Linux: Text and Graphical

One way to communicate with Linux is by typing text at a command line, similar to the C prompt
(C:>) for anyone used to working with DOS. A text− based interface requires the user to type
specific commands with a specific syntax that the operating system understands. The computer
displays a prompt letting the user know it is ready to receive a command. The place where the
command is typed is known as the command line. Anyone who used a personal computer in the
mid− 1980s or earlier is probably familiar with some kind of text− based user interface.

Many utilities, or programs, are command−line based. This means that instead of using a mouse
button to access the program, you type a word into what is called a terminal window when the
computer displays a prompt. This book will not discuss these utilities until the final chapter. Chapter
13 discusses the command−line interface and some of these utilities, but you can rest assured that
this chapter is optional.

The other method of communicating with Linux is by way of a graphical user interface (GUI). This is
often called the desktop and consists of the icons, windows, dialog boxes, toolbars, and panels that
you see when using Linux as a point−and− click operating system. This is considered more
user−friendly because it provides visual clues you can use to get the computer to do something,
instead of requiring that you memorize myriad commands.

Using the KDE GUI is the focus of this book. Though we introduce the command line and some of
the commands associated with it, you should be able to do everything that you need to do with the
KDE GUI.
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What Is KDE?

KDE  is a GUI, a piece of software that interacts with the operating system but is not an integral part
of it. It simply provides a means of communicating with it. You might think of it as an interpreter
between you and Linux.

GNOME is another popular desktop GUI that works with Linux. GNOME and KDE are each created
and maintained by different teams of software developers. Both function well, and making the
choice between them is largely a matter of personal preference. We focus on KDE here because it’s
what we use in our offices and because it is included in almost every Linux distribution.

What Else Is Included?

Besides Linux itself and the KDE desktop, you’ll find many other programs included with your Linux
operating system. KDE alone includes over 100 programs, such as image viewers, text editors,
email programs, web browsers, and games. You’ll even find a free office software suite
(OpenOffice) and a Photoshop−like program (The GIMP), both of which are discussed in this book.
OpenOffice and The GIMP are generally considered to be the leading free applications in their
respective fields. For this reason we have given each one a separate chapter.
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Chapter 2: Loggin in and Moving Around
This chapter discusses the basics of using the KDE graphical interface on Linux. If you’ve worked
with another GUI environment, this information will probably seem elementary, but you may want to
skim it to pick up some possible differences.

Logging In and Out

When you first start Linux, you are greeted with a login screen. Before you can do anything, you’ll
need to enter your login name, sometimes called a username, and your password, both of which
should be supplied by your administrator. This is called logging in.

Because a Linux system can have multiple users, each with their own customized desktop and
settings, entering your login name tells Linux who you are and instructs it to load your particular
settings. Usernames are especially important when several people have access to the same
computers.

Figure 2.1: Login Screen
Linux uses your password to verify your identity, so you should always keep it secret. When you
enter your password, the characters you type will not appear in the box. Instead, you should see
plus signs or asterisks as you type. (Depending on the way your Linux system is configured, there
may be no on−screen representation of your password at all, and you’ll have to type it in blindly.)

After typing your login name and password, press ENTER. There will be a short delay as your
computer loads everything for your session. A KDE graphic will show the loading progress. Once
your machine is initialized, the KDE desktop should appear, and you will be ready to begin working.
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Changing Passwords

When selecting a password, it is important to choose one that you will remember easily (it’s best to
avoid writing it down) and that’s not easy for others to guess. Avoid names, dictionary words, or
anything related to easily obtainable personal information. A good password combines upper− and
lowercase letters with nonalphanumeric keys. Passwords such as *nCk&Ve or *uG]y$Uds− are
good examples. Your system administrator may assign you a password, but if you are responsible
for your own, it’s a good idea to change it approximately every two months.

You can change your password using the KPasswd utility found in the Utilities submenu of the K
menu. You’ll learn to navigate this menu later in this chapter.

Figure 2.2: The Change Password Dialog Box
Logging Out

To log out from your computer at the end of a session, click the K button on the panel, and choose
Logout from the pop−up menu. A dialog box will come up asking whether to restore your current
session when you next log in and to confirm that you really want to log out. Click Logout to confirm.

Figure 2.3: Logout Screen
Tip Before you log out of the system, make sure that all your work has been saved. This will help
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prevent losing data.
A Word about Root

When KDE is first installed, the installation program will prompt you to create at least two accounts:
root and normal user. Root is thought of as a superuser account and is reserved for system
administration, as it lets you do almost anything to your system. Most offices limit root access to the
system administrator.

If you have root control on your system, beware—changes to system files can radically alter the way
the system works. As you are experimenting and getting familiar with KDE, you will probably come
across things that are designated as root−access only, and you will be unable to change them
without the help of your system administrator.

The Landscape of the KDE Desktop

Once you’ve logged in to the computer, you will see a fairly blank background with some small
pictures and a bar across the bottom of the screen with more pictures. The background is called the
desktop; the bar is called the panel; and the pictures are icons —symbols representing the
programs and tools on your computer that are probably used most often. For example, the life
preserver is the icon for the Help program, and the globe represents the Konqueror web browser,
used for navigating the Internet.

Tip Programs and groups of programs are also called applications.

The desktop icons have their functions listed beneath them, such as Printer or Email. Text will pop
up to explain the functions of the panel icons when you hold the mouse pointer over them. This
applies to almost every icon or button you see in KDE or any of its applications. Using the panel and
desktop icons is discussed in the “Navigating Your Desktop” section of this chapter.

To open a program from its icon, position the mouse pointer directly over it and click the left mouse
button once— a single click. A blinking mini− icon appears next to the mouse pointer indicating that
your computer is opening the program or file. The type of mini− icon will show which program is
opening. For instance, if you click on the globe icon in the panel to open the Konqueror web
browser, a blinking globe will appear.

Menus, Windows, and Toolbars

Menus offer a list of tasks to perform. For example, if you click the K button in the lower left corner
of the panel, you will see a pop−up menu that lists the names of various programs and utilities
available on your system. As you move your mouse pointer up, other pop−up menus appear. These
are submenus, menus specific to an item on the main menu.

For example, here we show the submenu for Toys. When you find a program on a menu or
submenu that you want to open, single− click on the program name to launch the program.
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Figure 2.4: Submenu of a K Menu Item
Tip If a small black arrowhead appears next to an icon or an item on a menu, a submenu is

available. Place the mouse over the item to bring up the submenu.
When a program opens, it does so in a window, an enclosed rectangular area on the screen. You
can have multiple programs open simultaneously on your desktop in multiple windows. (You’ll learn
exactly how many desktops and windows you can open at once in the next section.) This is part of
the multitasking capability of Linux. While one program is running a task, you can be working on
another. For instance, while your computer is running the installation of a program, you can be
happily typing a letter with AbiWord.

Each program window will usually have a menubar at the top that lists menu items—groups of
options and commands that apply to the specific program you have open.
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Figure 2.5: A Typical Menubar within a Program, with Submenu Options
Although the left mouse button is used the most, clicking the right mouse button will often bring up a
hidden option menu for a program if one is available. For example, if you click the right mouse
button when the pointer is on the empty desktop (not on an icon or a file), a menu will pop up with
options to log out, lock the desktop (meaning a password will be needed to access anything), open
a new document, arrange icons and windows, and perform various other tasks. These pop−up
menus of available options change depending on which program you are using, so be sure to check
them for the icons and tools you use most often.
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Figure 2.6: Hidden Menu for the Desktop
Other Mouse Uses: Moving and Copying

You can also use your mouse to move items on the desktop by clicking on them and dragging them
to a new location— a method called drag and drop. To do this, position the mouse pointer directly
over the item you want to move. Then hold down the left mouse button and move the mouse itself to
drag the item across the screen. Once you reach the desired location, release the mouse button to
drop the item there. You can even use drag and drop to perform actions. For example, you can drag
a file to the printer icon to print it.

To move a window to another location on your screen, place your pointer in the window’s titlebar
(the topmost section of the window) and then drag and drop the window to a new location. Once the
window is where you want it, release the mouse button.

To resize a window, move the mouse pointer along the window border. When a double−headed
arrow appears, click and drag the arrow inward or outward to the desired size. Adjusting from a
window corner lets you change the width and height at the same time (by dragging diagonally).

Tip To move a window whose titlebar is inaccessible (maybe in your excitement, you
moved it clear off the top of the screen), hold down the ALT key, click anywhere on the
window, and drag.

You can also use the mouse to copy text from within any window that has a place for text placement
into another window. For example, you can use the mouse to copy text from a web page into a
document or email message. Simply highlight the text you want to copy by placing the mouse at the
beginning, pressing the left button, and moving the pointer across the desired text ( doubleclick to
highlight word by word rather than space by space). Clicking the middle mouse button (or the left
and right button simultaneously on a two− button mouse) will paste the text wherever the text cursor
is.

Windows that display more than will fit in a single screen will have a vertical gray bar at the far right
side, with a small black arrow pointing up at the top and another pointing down at the bottom. This is
a scroll bar that allows vertical movement in a document. Clicking the down arrow will make the
lower part of the document visible, and clicking the up arrow will take you up again. You can also
click on the bar itself with the mouse pointer and drag it up or down. The same is true for something
too wide, except the scroll bar is across the bottom.

Navigating Your Desktop

As described previously, when you log in to KDE, you’ll see a colored background with several
icons on the left and a bar at the bottom lined with more icons, called the panel.
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Figure 2.7: The KDE Desktop
The Panel

The panel provides quick access to the programs used most often. It also helps navigate the
windows you open. Each panel icon represents a menu, directory, application, or helpful tool that’s
only a mouse click away from appearing on your screen for you to use. The most significant of
these icons is the big K in the far left corner.

Figure 2.8: The K Panel
The K Menu

When you click on the K, a menu pops up. This is KDE’s main menu, the K menu. Each entry in this
menu is like a folder in a filing cabinet, representing either an application or a directory on your
computer.
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Figure 2.9: The K Menu
Most entries in the K menu have icons, and some have arrows. The icons help you identify what
each entry means; for example, your home directory has a house next to it.

Navigating the K Menu

The K menu offers various ways to access your computer’s contents. Entries are highlighted as
your mouse pointer passes over them, letting you know exactly where you are in the menu. To
access a submenu, highlight an entry with an arrow, then move the pointer into one of these boxes.
These linked submenus and their related main menu headings make up the K menu tree. To close
a submenu, move your pointer to a blank space on the desktop and click.

Tip To keep a submenu open, click the submenu heading, or open the submenu by moving the
mouse pointer to its heading, and then move your mouse pointer off the menu.

Opening and Closing Windows from the K Menu

Of course, your ultimate goal in navigating the K menu is to reach the files and applications you
need. Once you’ve found the entry you want, open it by clicking your mouse (either button will do).
For example, to use your computer’s calculator, open the K menu, place your pointer on Utilities,
then move the pointer to Calculator on the submenu.
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Figure 2.10: Opening a Window from the K Menu
Click Calculator and, presto, a calculator appears. To close a window, click the X at the far upper
right corner of the titlebar.

Tip If you re−open the K menu after opening the calculator, you will notice something new inside it:
the word Calculator and its icon now appear at the top. This is because KDE logs your recently
accessed folders, files, and applications, so you can open them again more quickly. The items
in this part of the menu will change, depending on which programs you used most recently. The
K menu can also be configured to log most frequently rather than most recently used items.
See the “Panel” section of Chapter 11.

Help

One of the panel icons you may use a lot at first is the help icon (the life preserver). Whether you’ve
forgotten how to use the Delay feature in KSnapshot or how to change the speed of your mouse
pointer, Help can provide the answers.

Once launched, you will be presented with the KDE HelpCenter’s opening pages. The left side of
the window contains two tabs, Contents and Glossary, which allow you to search for specific topics
quickly. The main part of the window opens automatically to “Chapter 1. Welcome to KDE.” Here
you can read the full KDE user documentation, or click on certain areas of interest such as KDE
user’s manual and The KDE FAQ (frequently asked questions), or access information on KDE’s
basic applications by clicking on links like Desktop Panel or File Manager. Click on Prev or Next at
the top of the window to flip through the chapters of the KDE help manual.
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Figure 2.11: The KDE HelpCenter Introduction Screen

Here are some tips for navigating Help:• 
Use the Up, Home, Next, and Prev links to move among the pages you’ve viewed. The Next
and Prev links are shown both below and above the text. The Home and Up links appear
only below.

• 

Click underlined text for further information (such as “What is the K Desktop Environment?”).• 
Use the tabs to switch between Contents and Glossary.

Tip If you open Help from within a program, such as KMail or KOrganizer (by selecting Help
Contents from the top menubar), the help document corresponding to that program will
be presented automatically. Otherwise, you can scroll through the Contents list or the
Glossary to find a specific item.

• 

Most help documents appear as web pages (HTML files) with links to more information.

Virtual Desktops

Virtual desktops are simply additional desktops. It is somewhat like having multiple monitors
connected to the same computer, except only one is visible at a time. Their purpose is to give users
more workspace. Linux’s multitasking capability allows your computer to handle many tasks at
once. Virtual desktops make it easier to manage these mutliple tasks and allow you to have more
windows open at once than you could with only one desktop.

The block of numbers (1, 2, 3, and 4), collectively known as the pager icon, that follows the row of
panel icons represents the virtual desktops. Initially, you may question the need for more than one
desktop, but you’ll learn to love the extra real estate additional desktops provide, as well as their
ability to help you stay organized.
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The default desktop is number 1. If you open a window on this desktop, a small representation of
that window will appear within the square that represents desktop 1 in the pager section of the
panel, indicating the presence of a window on that desktop. If you open an additional window, the
new window will be blue in the pager representation, and the first one opened will be gray to show
that it is not currently in the forefront. Click the other numbers to move from one desktop to another.
With no windows open it will look like nothing has changed. But now try this: go back to desktop 1
and click the terminal icon (the icon showing a monitor and a seashell) to open a terminal window.
Now click on desktop 2. Does it look like the terminal window has disappeared? Return to desktop 1
and you’ll find it hasn’t.

If a window is open on one desktop, it can be moved to another by way of the little pushpin in the
upper left corner of the window. To move the window, click the pushpin so it looks like it’s pushed in,
and the window will follow you to whichever desktop you move. To make the window stay on one
desktop, click the pushpin again.

The panel includes a pop−up menu to the right of the pager icon, indicated by an arrow. Click the
arrow and the Show Windows List will appear, listing the contents of your virtual desktops. You can
also press the middle mouse button on any blank spot on any desktop to get the same menu.

Figure 2.12: The Show Windows List
The Unclutter Windows and Cascade Windows options at the top of the Show Windows menu let
you organize multiple windows on your current desktop. Unclutter Windows spreads the windows
out so you can see all of them at once, while Cascade Windows treats the windows like overlapping
cards. Open different windows on your desktop and experiment with switching between the two
options.

Directly below the Unclutter and Cascade options, you’ll see a list of all four desktops. If you have
any windows open on any of your desktops, they appear as subheadings beneath the appropriate
desktop name. Clicking any one of these windows brings it into the foreground so you can use it.

The Taskbar

The long rectangle (blank if you have no windows open) next to your pager icon is the KDE taskbar,
which shows every open window on your current desktop. The taskbar offers you an efficient way to
manage these windows.
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As you open windows, the taskbar fills with rectangular buttons identifying each window. To bring a
particular window into the foreground, click its button on the taskbar. When you do, that window’s
desktop will be displayed showing that window in the foreground. You should also see that window’s
button pressed down on your taskbar, which tells you that it’s currently in use.

Right− click any of the taskbar buttons to open a shortcut menu with even more options for
managing the window.

Figure 2.13: The Window Menu
The Window menu can also be accessed by right− clicking the window’s titlebar.

Tip In addition to using the Window menu, one way to minimize an open window is to click its
taskbar button. Click this button again, and your window will return to the forefront of your
desktop.

Tip To keep a window open and easily accessible, you can “shade” it. This will make your
window behave like a window shade that has been pulled up. When shaded, the only
visible part of the window is the titlebar. Double−click the titlebar to shade it.
Double−click it again to restore it.

K Panel Extras

To the right of the taskbar are a few buttons offering additional shortcuts for managing your KDE
sessions:

Lock the desktop and Logout: the padlock and computer keyslot icons, respectively. These
buttons let you keep people out of your computer while you’re away from it. Use Lock when
your absence is temporary, and you don’t want to close the windows opened on your
desktop. Clicking it will activate your screensaver, blanketing your desktop but keeping your
windows up and running. Use Logout to quit your KDE session entirely, when you’re done
for the day or when you need to log back in as a different user. (Make sure you remember
your password before clicking either of these buttons, as both of them require it to let you
back in.)

• 

Klipper: the clipboard button opens a box with your most recent cutting, pasting, and copying
activities so you can repeat these actions readily.

• 

Clock: you can change the display on the KDE clock by right− clicking it and choosing• 
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Preferences. Click the clock for a full calendar of the present month, with the current day
highlighted.
Hide Panel: the arrows on both the far right and far left ends of the panel assist
desktop−hungry users and minimalists alike. Click either, and you’ll see the panel zip off the
screen, except for its outer tab that contains an arrow pointing in the opposite direction. Click
this arrow again to restore the panel.

Tip To move the panel to either side of your screen, drag and drop an empty space on the
taskbar toward either side of the desktop. When you see an outline of the panel on the
side to which you want it moved, release the mouse button, and your panel will jump to
its new home on your screen.

• 

The Desktop

Let’s have a look at the desktop itself. To begin, let’s call up two useful shortcut menus from the
desktop.

Desktop Shortcut Menus

Right− click any blank part of the desktop to open a pop−up menu. You’ll find it contains many of
the same options found on the panel, such as the Help menu and the Run Command, among
others.

Figure 2.14: The Desktop Shortcut Menu
Clicking the Enable Desktop Menu option instantly transforms the menu into a bar at the top of the
desktop. To access the menu features using this bar, click the heading you want to access, then
choose the entry from the drop−down menu. To remove the bar, right−click the desktop, then click
Disable Desktop Menu.

If your mouse has a middle button, middle− click on the desktop to call up the Show Windows List,
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also found on the panel.

Desktop Icons

The last group of KDE default icons is the desktop icons, which may vary among distributions. (To
add additional icons or replace existing ones, see the “Adding Icons” section in Chapter 11.)

Trash: opens Konqueror to display discarded files. When the trash is empty, the icon has a
lid; when the trash contains files, the icon displays a can overflowing with trash. (See
“Working with Files” in Chapter 3 to learn more about trash.)

• 

Autostart: opens a Konqueror window in which you can place applications you want
launched each time you log in.

To add an application to Autostart, simply select the program you wish to add from the
Konqueror file manager (See Chapter 3 for how to use Konqueror) and drag it to the
Autostart folder. A menu will pop up allowing you to add the item to Autostart.

• 

Printer: opens the printer configuration window, with options for controlling and customizing
your individual print jobs.

• 

Floppy: allows access to files on a floppy disk.• 
CD−ROM: allows access to files on a CD−ROM disk.• 

The floppy and CD−ROM icons are covered more fully in the “Accessing Files on Removable
Media” section of the Chapter 3.

If you have other drives connected to your system, such as an LS120 or Zip disk drive, icons for
these drives should appear on your desktop as well.

Navigating with the Keyboard

Using keyboard shortcuts instead of the mouse can save a lot of time. Earlier versions of KDE refer
to these keyboard combinations as key bindings, but currently they are referred to as shortcuts. The
default shortcuts for managing your desktop are called global shortcuts.

From the K menu, open the Preferences submenu, then open Look & Feel, and select Shortcuts.
The first tab in this window includes all KDE default global keyboard shortcuts available to you,
giving you both key combinations and their functions. This window offers a quick reference if you
forget a certain key binding. Notice the function descriptions without key combinations; KDE allows
you to create your own key bindings so you can use choose additional shortcuts or modify existing
ones. See Chapter 11 for details.

The ALT Key

The alt key can be used in conjunction with other keys to call up certain menus, close or identify
windows, and show the contents of your virtual desktops.

KDE’s default settings allow ALT to be used with the first five function keys (the keys located in the
top row of your keyboard that start with an F and are followed by a number). Pressing ALT−F1 (at
the same time) takes you to the K menu. Use the arrow keys to scroll down, up, right, and left in this
menu. To open a submenu, press the ENTER key. To escape this submenu, press the ESC key.
Pressing the ALT key takes you out of the K menu altogether.

Pressing ALT−F2 calls up the Run Command window. Pressing ALT−F3 calls up the Window menu
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of the window currently in use. The underlined letters in this menu’s entries are the letters you can
use to access the menu options from your keyboard.

Figure 2.15: Using the Keyboard with the Window Menu
Use the arrow keys to scroll down to the entry you want to use. Press the down arrow key to
highlight Move, and then press the letter M. It looks like nothing happened, but if you press your
arrow keys randomly, you will see that the window is moving again. To get out of Move mode, press
ENTER. Now call up the same menu, highlight the Size option, and press S. Use your arrow keys to
reshape the size of the window. Press ENTER when you’re finished.

Pressing ALT−F4 closes the current window, and pressing ALT−F5 calls up the Show Windows List,
listing all virtual desktops and windows in use.

Tip You can cycle through the windows opened on your desktop with ALT−TAB. Hold down ALT as
you press TAB to move from window to window. Release the ALT key when you find the
window you want to use.

You can also use your mouse in conjunction with your keyboard to move or change the size of your
windows. Open a terminal window from your panel (the icon with the screen and a shell). Place your
pointer over the window’s white space, hold down ALT, and click. Release the ALT key, but
continue to hold down the left mouse button and move your mouse. Release this button when
you’ve repositioned your window to your liking.

Now place your pointer over the white space again, press ALT, and rightclick. Remember this
bidirectional arrow? Depending on where you click, you’ll get a vertical, horizontal, or diagonal
arrow. To reshape the window, release the ALT key while still holding down the right mouse key,
and drag the mouse in any direction.

The CTRL Key

Pressing CTRL in combination with the F1, F2, F3, and F4 keys switches you to desktops 1, 2, 3,
and 4, respectively. Pressing CTRL−TAB moves you to the next desktop; pressing CTRL−ESC calls
up the Task Manager window; and pressing CTRL−ALT−V calls up the Klipper pop−up menu.
Again, to escape these windows, press ALT or ESC.
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Initially, you may want to use the mouse to navigate your desktop, but as you become more familiar
with the KDE environment, you can start experimenting with the shortcuts. You may even get to
where you rarely take your hands off the keyboard.
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Chapter 3: Managing Files
Konqueror is a program that allows you to view and organize your files. Think of it as a smart filing
cabinet. It is customizable to allow you to display your files in a variety of forms. It also functions as
a file−viewing application that displays files, such as JPEG and PDF files and formatted documents,
in a read− only format. It can open helper programs to work with or display file types that it
recognizes, such as AVI files (the most common format for audio−video data on the Internet).

Konqueror is also a web browser that allows you to browse and work with files via the World Wide
Web. In this section, we discuss Konqueror’s use as a file manager. Its other uses are discussed in
Chapter 10, “Accessing the Web,” and Chapter 11, “Customizing Your Desktop.”

Making the Konqueror File Manager Your Friend

Launch the Konqueror file manager by clicking on the home directory icon on the panel (the icon
with the little house).

Figure 3.1: The Home Directory Panel Icon
The Location Bar

Depending on what you have in your home directory, some icons appear in the main display
window, with various menus and a toolbar along the top. Below the menus is the Location bar that
displays the location of the files revealed in the main window below.

Figure 3.2: The Location Bar with a Home Directory Pathname
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Figure 3.3: The Konqueror File Manager Display
Before the “file:” portion of the Location bar is a small folder icon. Together, these indicate that what
is being displayed are files in a directory rather than a web page (remember that Konqueror is also
a web browser). When displaying a web page, the icon changes, and “file:” becomes “http:”.

At the far right side of the toolbar is a spinning KDE logo showing that Konqueror is reading files.
This animated logo is an activity indicator that lets you know when Konqueror is busy and when it
has completed a task.

The Location bar display “file:/home/ username/” is an example of a pathname because it shows the
path to reach the final destination, in this case, the home directory. The / symbol indicates
directories. For instance, /home is the parent directory in which / username resides. You may have
a directory called Mail in your /home/ username directory. If you click it, you will notice that the
pathname in the Location bar changes to /home/ username/Mail, because Mail is a directory
residing in /home/ username.

If you place the mouse cursor in the Location bar by clicking in it and remove the word Mail, you are
left with file:/home/ username again. You may not have much there at this point, but this is probably
the best place to save files and directories that you deal with personally .

One time−saving feature of Konqueror is the arrow button at the far right of the Location bar that
provides a history of recently visited locations. Rather than retype a recent location, scroll down to
the desired address or pathname. Also, the Location bar remembers addresses and pathnames
previously entered and, as soon as it thinks it recognizes your intention, provides a list of options
based on previous entries in a menu that appears immediately below the Location bar. Use the up
and down arrow keys to select the correct one and press ENTER.

Tip The text of the Location bar is draggable, meaning you can drag a directory or web page from it
to your desktop for quicker future access. Just click on the folder icon or the word in the
Location bar, or the word Location, drag it to the desktop, and select Copy from the menu that
appears. Once it’s on your desktop, simply click it, and Konqueror opens with the web page or
directory contents displayed.
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The Konqueror File Display

The Konqueror display has two sections: a narrow panel, or sidebar, on the left and a larger main
window on the right.

By default, Konqueror displays files in the main window with the filename below a small icon that
represents the file type. For instance, directories are displayed with folder icons, text files are shown
with a pencil and piece of paper, and image files are displayed with thumbnails of the image or with
an image icon (depending on how you have your file manager configured). Right− clicking an icon
displays a menu for manipulating the file in some way (more on this in the section “Working with
Files”) and for obtaining information about the file.

Files on your computer are arranged in a hierarchical manner, much like a tree with branches and
subbranches. This structure is exemplified by the file display seen in the sidebar to the left of the
main Konqueror window. The home directory icon represents a directory, or folder, in which
subdirectories can be stored (within which further subdirectories can be stored) or files. This left
sidebar display offers an alternate method of accessing directories. Instead of entering the
pathname for a given directory into the Location bar, you can merely click its icon in the sidebar to
display the contents of that directory in the window on the right. Click the house icon, and you can
see the contents of your home directory shown in the main window.

Next to each icon in the sidebar is a small box to the left with a plus (+) sign. Clicking this box shows
the subdirectories contained within the parent directory in a tree structure display. Clicking the box
again (now with a minus (−) sign) collapses the view of the inside of that directory. Alternatively,
doubleclicking the folder icon, instead of single− clicking, has the same effect as clicking in the little
box.

If you click a subdirectory in the sidebar, its contents are displayed in the main window. Clicking any
file icon in the main window opens that file within Konqueror in read− only format. This means you
cannot alter or manipulate the file, only view it. This is one of the more significant features of
Konqueror: it can be used to view files of many different formats without launching another program.
In addition to selecting files and directories with the mouse, you can use the arrow keys to move
among the files displayed by Konqueror.
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Figure 3.4: Viewing an Image File with Konqueror
Accessing Files on Removable Media—CD−ROM and Floppy Disk Drives

CD−ROM and floppy disk drives constitute filesystems independent of the computer’s hard disk or
other networked drives and need to be mounted to be read by the computer. When you are finished
with such a filesystem, it must be unmounted before the disk or CD can be removed. KDE makes
this process very simple. Your desktop should have both a floppy and a CD−ROM icon. Simply click
on the icon, and the appropriate filesystem is mounted with its contents displayed in Konqueror
(don’t forget to insert either a floppy or a CD before trying this). A little green light appears next to
the icon, indicating that the directory is mounted and its files are accessible. After use, it is
necessary to unmount the directory in order to remove the disk. To unmount, right− click on the icon
and select unmount from the menu. The green light disappears, indicating that no directory is
mounted.

Tip If you are unable to unmount a CD or floppy, it is probably because some program is
accessing it. Close that application and the unmount should work.

Menus and Toolbar Buttons

You can use the buttons in the toolbar near the top of the window to navigate your files. For
example, if you have a subdirectory in your home directory called cutekitties that contains image
files of kittens, and the contents of this directory are displayed in the main Konqueror window, you
only have to click the up button (the blue arrow pointing up) to go back to displaying the contents of
your home directory, rather than the contents of cutekitties.

The back button (the blue button pointing to the left) takes you to whatever the previous display
was, regardless of where its pathname is in relation to the current directory. For instance, if you
were looking in your home directory and then viewed a web page, the back button would return the
display to your home directory.

The button that looks like a house also takes you to your home directory, regardless of your current
location.
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Use the magnifying glass buttons to increase or decrease the display size of the icons. The two
buttons to the right of these can be used to switch back and forth between the Tree View display
(see the “View Menu” section that follows) and the Icon display of files.

Tip The black X button to the left of the Location bar is a single−click erase feature. Click
to erase the current URL or pathname to enter a new one.

Tip Pressing CTRL− O opens a dialog box where you can enter a location (as in the Location bar).
This allows you some navigation ability without taking your fingers from the keyboard.

Some of the items in the Konqueror menus are related more to Konqueror’s use as a web browser
than as a file manager, and some are relevant to both uses. Those that function in file management
are discussed here. See Chapter 10 for more on using Konqueror as a web browser.

Location Menu

The Location menu contains six permanent items. Other items may appear if Konqueror is being
used to open a file for viewing. These items relate to working with the file and depend on the file
type.

Figure 3.5: Location Menu
The six permanent menu items and their functions are:

New Window: adds another Konqueror window that opens displaying the contents of your
/home/ username directory.

• 

Duplicate Window: creates an exact copy of the window from which it is opened, displaying
the same contents rather than those of your /home/ username directory.

• 

Open Location: opens an alternate Location bar.• 
Send Link: opens an email client (KMail by default), so you can email the URL or web
address displayed in the Location bar to someone; mostly used with Konqueror as a web
browser.

• 

Send File: opens up an email client, KMail by default, to send the displayed file.• 
Quit: exits Konqueror.• 

The Print menu item is enabled if a printable file, such as a text document or image file, is being
displayed. Clicking the Print item opens a dialog box for selecting print options, such as which
printer to use, depending on the file and printer.

Besides printing from the print menu, you also can print using the dragand− drop method by
dragging the file icon to the printer icon on the desktop.
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Figure 3.6: The Print Dialog Box
Tip There are two programs accessible from the K menu, on the Utilities submenu, that can be

used for viewing and for modifying the order of any jobs in the print queue: Klpq (Print Job
Administration) and KJobViewer (which may show up on the menu as simply Print Jobs).

Also on the Location menu are options for opening a displayed file with more advanced
applications. Konqueror displays files in a read− only format. If you want to modify a document, you
must open it with another application. This is covered in more detail in the “Opening Files” and
“Right−Clicking Files” sections of this chapter.

View Menu

Figure 3.7: View Menu
The first item on the View menu is View Mode. This item allows you to alter the way directory
contents are displayed. Putting the mouse pointer on this item reveals a submenu with display
options.
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Figure 3.8: View Mode—File Manager Display Options

Icon View: the default view, with which you are already familiar.• 
MultiColumn View: displays the icons, but in vertical columns (alphabetically) rather than
horizontal rows.

• 

Tree View: displays contents in a manner similar to the display in the sidebar, but with
additional information, such as file size, date last modified, and file permissions. Permissions
are discussed further in the “Changing Permissions” section of this chapter and in Chapter
13.

• 

Detailed List View: similar to Tree View but without the plus/minus (+/−) boxes and their
corresponding collapsible menus of subdirectories.

• 

Text View: similar to Detailed List View but with simple text in place of the icons.• 

The next item, Use Index.html, allows you to view a selected directory as a web page if it contains
an index.html file, rather than showing it as a text list of files.

Lock to Current Location locks the current display. In this mode, clicking one of the displayed files
does not replace the current display, but it does open the item (if a file) in a separate window, or not
open it at all (if a directory).

The Link View item causes the current view to be linked to others in a multiple−view window.

The Reload and Stop items are discussed in Chapter 10, “Accessing the Web.” Some of the menu
items change depending on the type of file display you choose from the View Mode submenu.
These items allow you to manipulate further the way files are sorted and displayed.

The Show Hidden Files item reveals files whose names start with a dot (.). These are typically
configuration files that determine the way certain applications behave.

The last two items, Background Color and Background Image, allow you to customize the color
behind your file display or to replace the color with an image. Choosing a color is merely a matter of
selecting Background Color and clicking the color of your choice, and then clicking OK. To select an
image, follow the same process. You can choose one of the images provided, or you may have an
image file of your own for which you can browse. You’ll learn much more about customizing in
Chapter 11.

Tools Menu

The first item on the Tools menu, Run Command, presents you with a dialog box containing a line in
which you can type the name of the program you want to run or the web page you want to view. In
some cases this may be a faster method than searching through menus for the item. This same
dialog box is available in the main K menu as well.
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Figure 3.9: Tools Menu
The Open Terminal item opens a Konsole terminal window, which is a textbased user interface.
Almost everything that can be done by means of a mouse, windows, and icons can be done from
this simple little terminal— and in many cases done more quickly. The disadvantage is that it takes
some time to learn the necessary commands; that little blinking cursor isn’t exactly intuitive. For
more information, see Chapter 13.

Find File allows you to search for files and directories. The Look In bar at the bottom of the dialog
box allows you to enter the directory in which you want to search. If you don’t know exactly which
directory the file is in, you can enable searching in subdirectories. To narrow your search, you can
use the Date Range tab or the Advanced tab. Enter the filename in the Named bar and the directory
(parent or subdirectory) that you expect the file to be in, or use the Browse button.

Figure 3.10: Finding Files
The Find File utility works a little differently than similar programs in other operating systems. You
will notice an asterisk in the Named bar where you enter text. The asterisk represents a wildcard for
any character or even no character. For instance, if you don’t know the filename in its entirety, but
remember that its name begins with “report,” you can enter report* in the Named bar, and the files
returned are all those starting with "report" and ending in anything. If you want to search for all of
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the PDF files on your system (or in the specified directory), type *.pdf, and you get all files beginning
with anything and ending with the file extension .pdf. If you don’t know the first or last characters of
the filename, you can place an asterisk both before and after those for which you are searching. For
instance, typing *report* returns all files with "report" anywhere in the filename.

The Create Image Gallery item allows you to create a web page of thumbnail images that link
automatically to the full−size version. Open a display of image files, select Create Image Gallery
and any preferences from the dialog box, and the page is created.

Figure 3.11: Create Image Gallery
The last item, Execute Shell Command, is similar to the Run Command item. Again, see Chapter 13
for more details on shell commands.

Settings Menu

The Settings menu contains items that give you a great deal of control over the file manager,
allowing you to customize the features of Konqueror. As with other KDE menus that allow you to
change settings with a single click, there is a check mark next to the setting that is currently
activated.
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Figure 3.12: Settings Menu
The first item, Show Menubar, allows you to make the menubar itself disappear, providing more
space for the window displays. The keyboard shortcut CTRL−M returns the menubar. The rest of
the Show menu items are self− explanatory.

Tip The toolbars and the Location bar can be hidden to give your display window more space by
clicking on the vertical lines at the extreme right end of the toolbar. When the bar is hidden
these lines become horizontal. The bar can be returned by clicking the horizontal lines.

As discussed in the previous chapter in the “Navigating with the Keyboard” section, the Configure
Shortcuts option allows you to customize the action Konqueror takes when certain keys are
pressed. Certain functions correspond to, or are bound to, certain keys on the keyboard. For
instance, the display of the Help contents is bound to the F1 key. With this menu item, you can
change key bindings and add new ones.

If you select Configure Toolbars, a window appears that allows you to add or subtract buttons and
their corresponding functions from the four toolbars: Main, Extra, Location, and Iconview.

The Configure Konqueror item brings up the KDE Configuration module, which allows customization
of various aspects of Konqueror. In the left sidebar are the elements of Konqueror that you can
choose to modify. The first is File Manager. From here you can change the font (size and type) and
specify whether to open directories in the same or separate windows.

The second item, File Associations, is covered in the “Dealing with Microsoft Word Documents” later
in this chapter and in Chapter 11. The other items relate to Konqueror’s web browser functionality
and are covered in Chapter 10.
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Figure 3.13: The Configure Konqueror Dialog Box
Window Menu

The Window menu offers further options for customization of Konqueror’s file displays.

Figure 3.14: Window Menu
In addition to options for dividing the main window into different views, there are options for
removing the sidebar, adding an x−terminal child window at the bottom of the Konqueror window,
and switching to full−screen mode.

Accessing Man Pages

Before moving on to “Working with Files,” it may be useful to consider one other handy feature of
Konqueror: the display of man pages. Information on UNIX/Linux system commands and tools are
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documented electronically in man, or manual, pages. The man pages provide information on the
use of commands such as arguments, or specifications, that can be used to customize the behavior
of commands. This is primarily of value only to those who use terminal windows (such as Konsole)
to enter commands. Indeed, man pages are traditionally accessed from the command line (see
Chapter 13), but Konqueror allows quick access as well. In the Location bar, simply type a pound
sign before a given command. For example, type #lpr to display the man page for the lpr print
command.

Figure 3.15: The lpr Man Page
As the Window menu demonstrates, Konqueror is highly customizable. As soon as you’ve become
familiar with the basics of using Konqueror file management, try playing around with some of the
configuration options available. You can make the most of what’s offered and do away with what
you don’t use or like.

Working with Files

Konqueror’s graphical interface makes working with, managing, and accessing your files very
simple. Now that you have learned your way around the menus and toolbars and customized your
file manager, the next step is actually doing something with these files.

Creating New Folders and Files

To begin, you may want to create new folders (subdirectories) and new files. In Konqueror simply
click Edit in the menubar at the top of the window, choose Create New, and then choose what new
entity you want to create. The two most commonly used selections in a typical office are probably
Directory (represented by a folder icon), for storing files or subdirectories, and Text File
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(represented by a paper−and−pencil icon).

Figure 3.16: Creating New Files
Tip You can also right−click anywhere on the background of the file manager screen and see a

menu with options such as Create New, Reload, New Window, Undo, and Paste.
After you make a choice of what to create, a box appears asking you to name it. Type the name,
and the directory or file appears on your file manager page.

Moving Files

The drag−and− drop method of moving files in KDE provides a very simple way to get organized. All
you need to know is how to drag your mouse. It helps significantly if you have two windows open so
you can easily see the original location of the files or directories you want to move, as well as their
final destination. To set this up, click Location in the top menu and choose Open Duplicate Window
if you are moving files within one particular directory. If you are moving items between directories,
you can use the Location menu to choose a new directory to open.

Once you have both windows open, place your mouse over the item, hold down the left mouse
button, and while still holding the button down, move your mouse to the new spot; the item moves
across your screen to its intended destination. Once the item is where you want it, release the left
mouse button. You are then given three options: Copy Here, Move Here, and Link Here. Copy Here
makes a copy of the file or directory in the new location, but the original also remains where it was.
Move Here literally moves the item to the new location and removes it from the old location. Link
Here is similar to Copy Here, in that linking the file allows access to it from the new location, but the
actual file remains only in its original space. The icon that appears in the new location is merely a
link. This saves disk space because you are not copying a new version of the file.
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Figure 3.17: Moving a File

Figure 3.18: Choices for Moving a File
Opening Files

As discussed previously, you can open existing files in a read− only format by leftclicking the icon or
filename. This works for basic text documents, HTML documents, most types of images, and
programs.

Once a file is opened, depending on the type of file, more choices are added to the pull− down
menus (as mentioned in the preceding “Location Bar” section). For example, if you open a text
document, the Location menu now also has the option to open the file with a number of text editors
or word processors. Choose one of these programs to open your file, and you are able to edit, print,
save, or perform whatever task you want with the file. See Chapter 5, “The OpenOffice Suite”;
Chapter 6, “Alternative Office Software”; and Chapter 7, “Working with Graphics” for more detailed
information on how to work with specific types of files and applications.

Because different types of programs create files in different formats, it is customary for files to have
an extension appended to their name that indicates the file type. This helps in deciding what
application to use to open and manipulate a file. File extensions are usually added automatically
when a program creates or saves a file. For instance, if you write a letter to your secret admirer in
AbiWord, when you save the file (with perhaps the name “secret”) AbiWord appends the extension
.abw, making the whole filename secret.abw.

Konqueror looks to the file extension to determine the file type and make suggestions as to what
program would be most appropriate to open it. If a file is a type not recognized by Konqueror, it may
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not open simply by clicking it. If this occurs, try right− clicking the file, choose Open With, and then
choose an appropriate program from the list (or type one in) to open the file. This process is
discussed in more detail in Chapter 11. However, we cover the process for dealing with Microsoft
Word documents here as an example, because you may need to make adjustments to your
Konqueror configuration.

Figure 3.19: Opening a File with a Specific Application
Dealing with Microsoft Word Documents

To configure Konqueror to recognize Microsoft Word documents and open them with an appropriate
application, first click the Settings pull− down menu, choose Configure Konqueror, and then choose
File Associations (located on the left sidebar).
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Figure 3.20: File Associations
Next, under the heading Known Types, click the little box (with the plus sign) next to the word
Application (this looks just like the tree structure that appears in the left part of your file manager
window, which was discussed earlier). From the resulting menu, select “msword.” At this point, a
box opens to the right of the tree that allows you to enter a filename pattern. It may already have the
typical MS Word filename extensions (.doc and .dot). If so, you don’t need to do anything. But if not,
you can now click Add and type them in.
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Figure 3.21: Adding Application Preferences
Below this box is a section called Applications Preference Order. This is where you choose which
programs should be used to open this particular type of document automatically. You can select
more than one program in case your first choice doesn’t work, and then when you try to open a file,
Konqueror goes down the list of programs you have entered to open the given file (depending on
the file type). In the case of MS Word documents, OpenOffice should do the trick. So next click Add,
and a box appears that allows you to choose a program. Scroll down the list and click the program
you want to use (OpenOffice in this case), and then click OK. You are then back at the File
Associations screen, and you should see OpenOffice in the Applications Preference Order window.
Click Apply. Click OK. The next time you click a .doc file on your Konqueror file manager screen, it
should open with OpenOffice.

Right−Clicking Files

Another easy way to open or work with documents and images is to right−click a file. This causes a
menu to appear with the following list of options: Cut, Copy, Paste, Rename, Move to Trash, Delete,
Shred, Add to Bookmarks (this option deals with Konqueror as a web browser and is covered in
Chapter 10), Open With, Preview in, Copy To, Move To, Edit File Type, and Properties. These
options are also available on the Edit pull−down menu at the top of the Konqueror screen.
Familiarize yourself with them to make working with files easier.
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Figure 3.22: Edit Menu
Using Cut, Copy, Paste, and Rename

The Cut, Copy, Paste, and Rename options are self−explanatory if you’re used to working with just
about any word−processing program. You can highlight text within a file, and then choose Cut or
Copy (cutting removes it from the original spot; copying makes a copy and leaves the original in the
original location), and finally click Paste to place your selection where you want (once you have a
file open, right− clicking anywhere on the page gives you these options). With Konqueror, you can
do this with files and directories also, easily moving or copying files or folders between directories
and subdirectories. Simply right− click a file or folder and choose cut or copy. Then place your
mouse cursor on the destination folder (by pointing there and clicking), click the folder to open it,
rightclick somewhere on the background of your file manager window, and click Paste; the folder or
file appears in its new location.

Tip There are two types of cursors on your computer: the text cursor, which appears
inside of an x−terminal, Konsole window, or word processor−type program and
shows where the next typed words will appear, and the mouse cursor, which relies
on mouse movement for its placement.

Tip Another method that works both with highlighted text and with folders and files (with the mouse
cursor on them) is to use your keyboard. Pressing CTRL−X will cut, CTRL− C will copy, and
CTRL−V will paste.

To give a file a different name, simply right− click it and choose Rename; a box pops up beneath the
icon for the file or folder with the current name highlighted, allowing you to type over it and change
the name of the file. If you want to keep a file or folder with the old name as a reference, make sure
you make a copy of it before renaming it.
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Figure 3.23: Renaming a File
Using Move to Trash, Delete, and Shred

These are all methods of removing unwanted files or folders. Move to Trash moves the file or folder
to your trash can. This option allows you to get rid of files but also to restore them if you realize
you’ve put them in the trash accidentally—just as with a real trash can. If you need something
you’ve tossed, you can go to the trash can by clicking on it. A Konqueror window opens showing the
contents of the Trash directory. From there, you can do whatever you want with the file, just as if it
were still in its original location. If you decide that you really and truly don’t need it any longer, right−
click anywhere on the Trash directory screen, and you will see the option Empty Trash Bin. Clicking
this causes your file to be deleted for good. Make sure that when you click Empty Trash Bin there is
nothing else in the Trash directory you might want, because it is all gone at this point— as if you’ve
just emptied your household trash into the compactor.

Figure 3.24: Trash Can
Tip You can move items to the trash by dragging them there with your mouse—exactly like you

move files or folders between directories, as explained earlier in the “Moving Files” section.
The Delete and Shred options (Shred may only be available from the Konqueror Edit menu) get rid
of files more immediately, without the lingeringin− the−Trash− directory phase. Choosing Shred
removes the file in such a way that it is almost completely irretrievable. Shredding removes the
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filename and performs repeated writes over the entire file so that it is nearly impossible to recover. If
you are trying to get rid of sensitive data, this is obviously the more secure option.

When you click either of these options, you still have one last chance to change your mind,
however; a small box appears asking if you really want to delete (or shred). So decide how badly
you want to be rid of the file, and then click the appropriate button.

The dialog also features a check box that gives you the option of skipping the confirmation
regarding deletion and shredding of files in the future.

Figure 3.25: Delete Confirmation
Using Open With

As mentioned earlier in the “Opening Files” section of this chapter, the Open With option allows you
to choose the program with which to open your file. The default programs usually appear,
depending on which type of file you are working with, and you can choose the program with which
you are most familiar. For example, for a text file, you may be given a choice between OpenOffice,
KWrite, and a few other word processors and text editors. If there is something you would rather
use, simply click Other, and you will see a box with Known Applications to choose from, or type your
preference in the bar at the top.

Figure 3.26: Open With Options
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For more on the relationships between programs and files, see Chapter 11.

Using Preview In

The Preview In option is similar to Open With; however, it allows you only to look at the file in a
chosen program. You won’t be able to alter it in any way (similar to when you simply click on a
particular file).

Using Edit File Type

Edit File Type lets you configure the filename patterns (or filename extensions) that Konqueror
recognizes for a particular type of file. For example, a JPEG image will be recognized if it has any of
the following file extensions appended: .jpeg, .jpg, or .JPG. If you want to add more possible
extensions for a given file type, click the Add button and type it in.

Figure 3.27: Edit File Type
In the lower half of the window, you can configure the Application Preference Order, which shows
you the default programs used to open the file and also allows you to add more programs or change
the order in which the programs are used.

If you click the Embedding tab, you can choose the left− click action for that particular file, alter the
Services preference order, or add more services.

Using Properties

Clicking Properties allows you to see information about the particular file, including the type of file,
where it is located, its size, the date and time that it was last modified, and the date and time that it
was last accessed.
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Figure 3.28: File Properties
Changing Permissions

The other tab on the Properties screen (see the previous section) is Permissions. Clicking this tab
allows you to see who has which type of permissions for this particular file. File permissions
determine who can do what to a file. There are three types of permissions: read, write, and execute.
Read allows a file to be viewed, but not altered; write allows alteration; and execute allows use of
the file if it is a program.

Each file has three classes of permissions: owner (user), group, and others. The members of the
group are set by the system administrator. The default group is the group you belong to. For
example, many companies’ groups might be set by department—with everyone in Accounting in the
same group. Others is everyone else and is sometimes referred to as world permission.

If you create a file, you are the file owner and can set the permissions for the other categories.
Place an X in the box for the permissions you want to allow. You are probably able to change
permissions only within your home directory. If you are unable to access a file you need because of
a permissions problem, see your system administrator.

For further information on permissions, see the “File Attributes and Permissions” section in Chapter
13.
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Figure 3.29: Permissions Settings
Middle−Clicking

If your mouse has a middle button, try using that to click a file you want to work with. It opens the file
directly with the default program, allowing you to begin working with it instantly, without having to go
through the steps of choosing which program to use. Middle− clicking is the quickest way to get right
to work.

Using File Compression

If you have a compressed file, such as one with a .tgz extension, right− click it, and you will see the
option to open it with Ark, an archiving utility, added to the usual list of options on the pop−up menu.
Click this, and you will be able to see all of the files within the compressed file, along with
information about them (the filename, permissions information, size, and timestamp). A typical
menu at the top of the Ark screen allows you to open the individual files, extract them, and perform
related tasks. See Chapter 12 for more details on using Ark.

Figure 3.30: Archiver
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Chapter 4: Getting Organized
This chapter covers a variety of programs designed to help streamline your day−to− day tasks.
Whether it is something as simple as using the calculator on your computer (rather than sorting
through the drawer of stamps and rulers next to your desk) or something a little more complicated,
such as merging y our PDA’s address book with your workstation, KDE can help make you more
organized and efficient.

KOrganizer

KOrganizer is a versatile program with organization options to meet many different needs. To open
KOrganizer go to K menu Applications • KOrganizer. Newer versions of KOrganizer have
groupware. This means that other people will be able to view the same events on their calendars if
that option is enabled when you enter events and your network is properly configured. Talk to your
system administrator about enabling the groupware feature.

KOrganizer has two basic features: the Events calendar and the To−Do list. For those of you who
might be a little forgetful, the calendar can create event reminders that pop up on your desktop. If
you like to plan ahead, the calendar can be viewed daily, weekly, or monthly. Or if you have a lot of
things that need to be done as soon as possible, you can make use of the KOrganizer To−Do list.

Figure 4.1: Opening KOrganizer
When KOrganizer opens, you see your daily calendar, your To−Do list, and a small monthly
calendar.

Configuring KOrganizer

In KOrganizer, you can configure the preferences to view your business hours, assign colors to
different views, and have reminders pop up on your monitor a few minutes before scheduled events.
To access your preferences, select Configure KOrganizer from the Settings menu.
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Figure 4.2: KOrganizer Preferences Window
In the window that pops up, the seven configuration sections are listed with icons on the left. Click
any one of these to modify that section. Click Apply to see your changes immediately; this is handy
for testing the different colors and fonts you might want to use. When you have finished setting your
preferences, click OK to save the changes, and exit the configuration window. If you do not want to
save your changes, click Cancel. To modify more than one section, go from section to section by
clicking the icons.

Tip If you click Default in any one of these windows, all of your configuration settings will be
deleted and replaced with the default settings.

Personal Settings

Personal is for setting the frequency of autosaves. You can also enter your email address and
choose Send copy to owner when mailing events if you want to receive email reminders about
events.
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Figure 4.3: Personal Settings
Time & Date

Time & Date lets you specify your time zone, whether Saturdays and holidays appear on the
calendar, default business hours, and default appointment time. When you open a daily or weekly
view in KOrganizer, the default time at which the calendar begins is the technical beginning of the
day: 12:00 a.m. Here you can set your default business hours to those that better suit your needs.
Likewise, the default appointment time is the time that appears automatically whenever you enter a
new event. Although it’s not necessary, setting a default appointment time can be useful, particularly
if there is a time that you generally set aside for appointments.
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Figure 4.4: Time & Date Settings
Fonts

The Fonts section is where you set the size and style of fonts used in KOrganizer. Try a few
different fonts to see what works best for you.
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Figure 4.5: Font Settings Colors
You can choose colors for different event categories, working hours, the background, and a few
other items. By setting contrasting colors, you will be able to differentiate items more easily when
taking a quick glance at your calendar.
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Figure 4.6: Configuring KOrganizer’s Color Scheme
Views

Under Views, you can adjust the settings for each of the window types available for viewing. To see
your To−Do list in its entirety, you will probably need a full window, so make sure that you have
checked the To−Do View uses full window option; otherwise, you may see only the first few items
on your list. Similarly, choose Month View uses full window to ensure that the monthly calendar
appears large enough on your monitor. You can also enable Show Marcus Bains line, which inserts
a red line with the current time of day into your daily calendar, so you know how close you are to
any given appointment.

52



Figure 4.7: View Settings
Printing Settings

Here you select the program that previews a file you want to print. You should probably use the
default (kghostview) as your preview program, but gv and xv both work well if they are available to
you.

53



Figure 4.8: Printer Preferences
Group Settings

This section is where you configure the email settings to use KOrganizer in a shared environment.
Add all of your group’s email addresses here, and check with your system administrator when
enabling this feature.
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Figure 4.9: Group Settings
Tip The Settings menu also allows you to enable or disable the various toolbars and menus,

configure shortcuts (or keybindings), and change date and time settings.
Menus and Toolbars

You are probably familiar with the options available in the menubar across the top of the window.
The more frequently used items in these menus are also available on the Main toolbar, below the
pull− down menus. As you become familiar with the icons for each action that appear next to the
option on the menus, you will find that toolbars are time−savers.

Toolbar Icons

There are two toolbars available in KOrganizer. To view these, you will need to make sure they
have been selected in the Settings menu. (They will have a check mark next to them if they are
turned on.) The two toolbars are the Main toolbar (on top) and the Views toolbar.

Figure 4.10: The Main and View Toolbars
On the Main toolbar, you will find icons for some of the most frequently used actions.

Blank page: creates a new file.• 
File folder: opens a file.• 
Disk: saves.• 
Printer: prints.• 
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Printer with lightening bolt: opens the Print Preview window.• 
Scissors: cuts.• 
Two pages of text: copies.• 
Page with a clipboard: pastes.• 
Magnifying glass: finds.• 
Backward arrow: goes back a day.• 
Forward arrow: goes forward a day.• 
Calendar with one day filled in: goes to today.• 
Flying envelope: sends email.• 
Calendar with star on it: adds a new event.• 
Calendar with a check mark on it: edits your To−Do List.

Tip You should use onl y one f ile in KOrganizer. Using mor e than one f ile is as danger
ous as keeping mulle appointment books and is never a good idea.

• 

The icons in the Views toolbar are:

Paper with two red dots: lists what’s next (of your scheduled events).• 
Paper with two items listed: lists events.• 
Calendar with one day filled in: shows today.• 
Calendar with five days filled in: shows the workweek.• 
Calendar with seven days filled in: shows the full week.• 
Calendar with all days filled in: shows a month.• 
Calendar with a check mark: shows To−Do list.• 

Printing from KOrganizer

Clicking on the printer icon allows you to select the date range and the type of view you want to print
(Day, Week, Month, or a To−Do list). To select dates for the date range, you can type in the date or
click the calendar icon next to the Date field, and then click the date on the calendar.

Figure 4.11: Printing from KOrganizer
Clicking on the printer with the lightning bolt gives you a chance to view a file before it is printed.
Then, you can make changes to the file before printing. After you select this option, you go through
steps as if you were printing the file, but the end result will be a graphic file, which opens in the
graphics program that you selected in the Printing configuration options.
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Using the To−Do List

With the To−Do list feature, you can create a list of tasks with subtasks, due dates, and priorities,
and then check off each item as you finish it.

Tip When working with your To−Do list, you may find it easier to view it on its own; click the To−Do
List View icon to change your view.

Adding a Task to the To−Do List

To add a new item to your list, select New To−Do from the Actions menu. Enter your task
information in the General and Attendees tabs in the window that opens.

Figure 4.12: Creating a New To−Do Item
The only required field in the General tab is Summary, but you may find it helpful to enter some
additional information about the item, such as due dates and times.

Enter the name or a brief description of the task in the Summary box. This name will be visible on
the left edge of the To−Do list box and will have a check mark next to it. To select a due date, make
sure the box next to Due is checked, and then select a due date from the calendar or type the date
in the text field. If you want to have a due time, check the box next to Time associated, and you’ll be
able to enter a time in that field. If you want to have a start date also (or instead), follow the same
procedure with Start that you used for setting a due date.

Use the pull− down menu on the right to set the priority of the task. The default priority level is 3
(medium). You can also select a percentage completed from the pull− down menu on the left to
keep track of your progress.

Enter any notes or comments about the task in the large text field toward the bottom of the window.
You will be able to view these notes by doubleclicking the to− do item after it has been added to
your To−Do list.

To enter a category for the task, click Categories, and a new window will appear showing the
various categories.
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Figure 4.13: Categories List
To add a category that doesn’t appear on the list, click the Edit Categories button, and an Edit
Categories window will appear.

Figure 4.14: Edit Categories
Enter a name for the new category in the blank field toward the bottom of the window, and click
Add. To remove a category, highlight the category and click Remove. Click OK to save your
changes.

If you have groupware capability and you want the same task to appear on the list of everyone in
your group, select Public from the Access menu in the Edit To−Do window. Otherwise, select
Private or Confidential.

Attendees

None of the information in the Attendees tab is required, although you might find it useful if you
manage large projects with a number of participants. Click New to add a new name and email
address. You can choose a Role, such as participant or observer, and a Status, such as Needs
Action or Declined, from the pull− down menus. The Roles and Status menus cannot be edited.
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After you have finished entering the information on the attendee, choose Apply to add the attendee
to the list. All event attendees will appear in the main window of the Attendees screen, and their
details will be listed under the corresponding sections: Name, Email, Role, Status, and RSVP. After
an attendee has been added to the list, you can edit the attendee information by highlighting it,
making your changes, and selecting Apply. You can remove an attendee by highlighting it and
selecting remove.

Viewing and Editing Your To−Do List

Once an item appears on your To−Do list, you can view its details or edit it by right− clicking on the
item. A pop−up window will appear with the following options:

Show: a small window pops up that includes all of the information you have entered about
the item. As a shortcut to this option, double− click the item.

• 

Edit: displays the window in which you originally entered the item (with General and
Attendee tabs), allowing you to make changes.

• 

Delete: pops up a warning that asks if you want to delete the item permanently.• 
New To−Do: adds a new item to your list.• 
New Sub−To−Do: adds subsidiary to− do items. This option is not available from any other
menu.

When you select New Sub−To−Do, you will go through the steps of creating a new item;
however, the item will be listed under the To−Do task that was selected. Each task on the list
with sub−to− do items will have either a − or a + next to it. If there is a −, all of the sub−to−
do items are being shown, and if there is a +, all of the sub−to− do items are hidden. You
can switch back and forth between the two views by clicking the − or +.

• 

Purge Completed: next to each of the items on your To−Do list is a small black box. If you
are using this list to keep track of current projects, you may want to check off each item as it
is completed. Purge Completed deletes all the items you have checked off.

Tip Items can be moved easily among To−Do lists using the drag−and−drop method.

• 

To− do items and sub−to− do items can be sorted in a few different ways. Click Summary to sort
alphabetically or Priority to sort from highest priority to the lowest. Due Date and Due Time both sort
chronologically, although items without a due date will appear first on the list if you sort by Due Date
and last on the list if you sort by Due Time.

Figure 4.15: Sorting Your To−Do List
Scheduling Events

When viewing the calendar, you can move from day to day by clicking the day in the monthly
calendar (the small monthly calendar on the left side of the window) or by using the arrows at the
top of the monthly calendar. The single arrow is for months; the double arrow is for years.

If you are on one of the Week views and click a single date from the monthly calendar, you will be
shown the Daily view for that particular day.
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Adding an Event

To add an event, double− click in the calendar window. The pop−up window that appears has the
same tabs as the one for the To−Do list, with an additional Recurrence tab. So, the process of
creating a new event should be familiar.

Figure 4.16: Adding an Event
Fill in the Summary field and the Start and End dates and times. Once the times are entered, the
duration of the event will be shown to the right of these fields. If a default time was specified in the
configuration settings, it will show up automatically. If there is no time frame associated with the
event (only dates), then check the No time associated box. The event will appear as lasting one full
day if you select this option. If the event will occur on a regular basis, check the Recurring event
box. Then you can enter more information about the repeating event on the Recurrence tab (see the
“Recurrence” section for more on this option).

To receive a reminder, check this box. If it is checked, you can enter the number of minutes, hours,
or days before the event for which you want to receive a reminder. To do this, enter the number in
the text field; then select minutes, hours, or days from the pull− down menu. You can also choose to
have an audio or video file as a reminder for an event. Click the music note or running− man buttons
next to the pull− down Time Increment menu to select either of these options. After you click the
audio or video button, a window pops up where you can choose one of the audio or video files that
comes with KDE, or you can select your own file.

Tip To use the alarm function, you need to choose Make Active from the File menu
before exiting the program. This option keeps track of appointments, even while
KOrganizer is not open, and sends you reminders.

With the Show Time As menu, you can select either Busy or Free. This option shows the time
period in the calendar as being either busy or free.

The Categories window here is the same as the Category window that appears when you create a
new To−Do list item, and it can be edited in the same manner.
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Tip The content of the category lists for both To−Do items and events is the same. When
you edit one list, you actually edit both of them.

Again, enter any notes or comments in the large text field. You will be able to view these notes by
double− clicking the event after it has been added to your calendar.

Also, if you have groupware, select Public to have the event show up in the calendar of everyone in
your group. Otherwise, select Private or Confidential.

The fields on the Attendees tab are identical to those in the Attendees section of the To−Do list (see
the “Using the To−Do List” section).

Tip Mail appointment is available from the Action menu only when an event on the calendar is
selected and attendees have been entered for the event with email addresses. When you
select this option, an email message with the event summary, start date, time, and end time is
generated automatically and sent to the attendees.

Recurrence

The third tab of the Edit Event window, Recurrence, is completely unique to the Event calendar. If
you have not checked the Recurring event box in the General window, you will receive the following
message: “This event does not recur. Enable Recurrence in General Tab.” After you have enabled
Recurrence, you will be able to make the event appear in the calendar on all of the dates when it
occurs. The event must happen on a regular basis for you to be able to use this option, for example,
a meeting held the first Tuesday of every month.

Figure 4.17: Recurring Events
The Appointment Time set in the General tab is used here. If you want to change it, you need to go
back to the General tab. In the Recurrence Rule section, click the correct button for the frequency
with which the event recurs. Then, fill in the correct information for that option. In the Recurrence
Range section, you can choose No Ending Date for the event (it will continue on forever); you can
enter the number of times you want the event to recur; or you can select the date on which the
event ends. In the Exceptions section, you can add an exception by choosing a date from the
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calendar and clicking Add. To remove a date, select the date in the large box next to the event and
click Delete.

Tip Show Filter, available from the Settings menu, provides the following options: Filter Enabled,
Include: Recurring and Floating, and Exclude: Recurring and Floating. These let you select
whether you want to see both recurring and one−time events, or whether you want to exclude
these from your view. Select Filter Enabled to activate the filter. If you do not select any of
these options, both floating and recurring events are included in the view.

Viewing and Editing Events in Your Calendar

Edit events the same way you edit the To−Do list. Right− click on an event, and a menu appears
with the following options:

Show: displays the information about that event.• 
Edit: displays the window in which you originally entered the information, allowing you to
make changes.

• 

Delete: asks if you are sure you want to delete a particular event.• 
Toggle Alarm: if the alarm/reminder is turned on, a small bell symbol appears next to the
event. Click Toggle Alarm to turn the alarm on or off.

TipYou can also use your mouse to edit some e vent properties from any calendar view. To
change an event time or duration, simply drag and drop the event to the new date or
time. To change the duration of the event, position your mouse over the top or bottom
edge of the event, and a double vertical arrow will appear. Press the left mouse button
and stretch (or shorten) the event time by moving the mouse. Release the button when
you are finished.

• 

In the Daily, Workweek, and Week calendar views, a status bar appears above the main calendar
with a summary of events. You can edit an event by right− clicking it in this window, as well as in the
main calendar window.

Importing, Exporting, and Archiving in KOrganizer

Available from the File menu, these options make it simple to access calendars from other
programs and archive appointments with KOrganizer.

Importing

Import from Ical allows you to import files saved in iCalendar format. The only requirement for this is
they must have the correct file extension, .ics.

Merge Calendar is the equivalent of importing a calendar. You can import files from other programs
rather than entering the information all over again. To merge calendars, first make sure you are in
the calendar to which you want to import the information (whether it is a new file or one that you
have been using already, and then select the file to be imported in the Location box.

Archiving

Archive Old Entries allows you to store appointments that have passed but that you don’t want to
forget. To do this, select the start date (the date from which you want the archiving to begin) and a
filename.
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Figure 4.18: Archiving Appointments
Exporting

The three options available here are Web Page, iCalendar, and vCalendar. When you export a file,
it is saved as a new file rewritten in whichever format you have selected.

Tip After you have exported a file, your best option for making changes is to update your
KOrganizer file and export the file again.

When you select Web Page, you can choose to export the To−Do list, the Events list, or both, for
viewing in a web browser. At this time, you can also choose the dates from which you want
information to be exported. In the Event section, you can choose to include Categories and
Attendees. In the To−Do List section, you can choose to include Due Dates, Categories, and
Attendees. After you have finished selecting the features you want exported, click Export.

Tip Use your browser to open your exported files by typing the filename in the URL field.

Note that the Events calendar, while not very detailed, is in an easy−to− read list format. The To−Do
list shows the full description of each item and has links to Sub−To−Do Items (shown below the full
list of To−Do items). If you choose to export either of these separately, your file will include only that
section.

63



Figure 4.19: To−Do List and Events Exported to a Web Page
The two other exporting options, iCalendar and vCalendar, are more advanced options that can be
used in conjunction with KPilot. vCalendar is a file format that stores information in ASCII format,
which is easily imported to other organization programs. iCalendar is a file format that allows
calendars to be shared over the Internet and is com patible with PDAs.

KPilot

KPilot is an application that allows you to transfer information between your desktop computer and a
PalmOS− based (version 3.3 or higher) PDA . The program is compatible with a number of PDAs,
alt hough some of t he options available for each will be slightly different. A docking station is
required, but these are packaged with most handheld devices available today. To open KPilot go to
K menu • Utilities • KPilot.

You will only be able t o transfer files from KPilot to your PDA, and vice versa. This means that,
unless you have files loaded in KPilot, they will not transfer to your PDA, and f iles from your PDA
will be accessible onl y in KPilot. This limits your options, but additional software is available for free
download from several sites. You may be able to find programs that enable calendar sharing, and
so on. Try searching http://www.tucows.com/ to find more information about these options.

Syncing with KPilot

To begin transferring data from your PDA to KPilot, simply set your PDA in the docking station.
Then choose Hot−Sync or Fast−Sync from the File menu, or click the Hot−Sync icon on the toolbar.
You will be prompted to press the Hot− Sync button on the docking station, and the connection
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between computer and PDA will be opened.

While using KPilot, you will be prompted to take action by a small line of text at the bottom of the
window, which can be easy to miss. KPilot does not give thorough information on its s tatus or t he
syncing status, but your PDA probably will.

KPilot Files

The standard file types that KPilot syncs and allows you to open (from KPilot) are Memos, Address
Book, and File Installer. These can be opened from the Conduits menu or the pull− down menu on
the right side of the toolbar. Choosing KPilot v4.x.x will return you to the main screen of the
application.

Address Book

The KPilot Address Book is easy to use and completely compatible with your PDA. Use the
menubar in t he top right corner of the KPilot window to open any of your files.

Figure 4.20: The KPilot Address Book
Memos

Memos are great because you can import small text files from your computer into KPilot and then
sync these to your PDA, and vice versa. This option opens the memos file that includes memos
from your PDA. In the window that opens, you can import text files from your computer into KPilot,
export memos to your computer, delete memos, edit memos, or view memos. By using the pull−
down menu at the top of the window, you can view the different memo categories. These reflect the
categories you have set in your PDA. You will not be able to edit these categories in KPilot; you
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must edit them in your PDA. Then the next time you sync, the changes will be reflected in KPilot. To
view a file, highlight it, and the text will appear in the column on the right.

Figure 4.21: Importing Text to Your PDA
Tip Once you have imported a text file into the Memos section of KPilot, you will not be able to

delete the item until after you have synced and transferred the file to your PDA.
File Installer

As you become a skilled user, you may to want to change the external conduits. For external
conduits, you will have the option of adding new functionality and files to your PDA through the File
Installer, although the exact options will depend on the type of PDA you are using. To import your
KOrganizer To−Do list into KPilot, choose Conduits • External. From here, you can click KOrganizer
To−Do Conduit, and then drag and drop this item from Available to Active. Double− click it to view
the options, and choose the appropriate file from which to import the data. It must have the .vcs
extension. iCalendar is a file format that allows calendars to be shared over the Internet and is also
compatible with PDAs. If you use a Micr osoft Windows PC or Macintosh, you will need to purchase
a version of iCalendar to make the iCalendar f iles on your PDA accessible from that computer.
However, KOrganizer has the ability to import and export iCalendar files.

Tip To import your KOrganizer To−Do list, you must save it in vCalendar format so it can be read
by your PDA.

Configuring KPilot

The configuration options available for KPilot are somewhat different from those of other programs
and are much more technical. The only sections you need to know about, in all likelihood, are
General and Sync. To change the configuration options in KPilot, choose Settings from the File
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menu.

Tip There is no default button in this configuration. After you change the options and click OK, you
will not be able to change them back to the defaults without manually setting them yourself.
You can cancel your c hanges in a session b y clicking Cancel at an y time.

Figure 4.22: KPilot Settings
In the General section, you will need to specify the following:

Pilot Device: the name of the serial port to which the PDA cradle is linked on your CPU. The
default is /dev/pilot, which will probably work for you. You shouldn’t change from the default,
unless you attempt to sync and the process does not work.

• 

Speed: lets you change the speed at which the transfers occur by using the pull− down
menu next to Speed. This setting depends solely on the model of PDA you use, so you may
want to try a few different speeds to see which works best.

• 

Pilot User: enter the name on your PDA, which will be check ed against your login name. If
these do not match, you will be asked which one is correct, and this name will be used as
the Pilot User name.

Tip Newer PDAs can transfer at much faster speeds than older PDAs.

• 

There are four startup options, and you can choose to make active as many as you want. You
should probably get a better feel for KPilot before choosing any of these options, though. Here is a
brief description of each.

Start Hot−Sync Daemon at Login: automatically begins a Hot−Sync operation as soon as
you log in.

• 

Start KPilot at Hot−Sync: lets you begin a Hot−Sync operation even when KPilot is not open,
although the application will be started as soon as you click the Hot−Sync button.

• 
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Show Daemon in KPanel: displays the Hot−Sync option in your panel, although it is available
only to some users.

• 

Stop Daemon on Exit: stops the syncing process when you exit KPilot.

Tip A daemon is a computer process that makes something happen. In KPilot, it is
basically the syncing process.

• 

The Address section can be left with its default settings, but here’s a brief description:

Address Formats: the Import and Export formats both specify the order in which information
(name, address, city, state, and so on) is transferred when syncing. Each field is
represented by three characters: two letters and a %.

• 

Address Display: when you view a list of records, this option allows you to list them either by
last name and then first name, or by company name and then last name.

• 

The DB Specials options are for configuring the databases. The defaults here should be fine.

Show Secrets: any records marked as Pr ivate in your PDA will not appear when transferred
to KPilot.

• 

Backup Only: items in this list indicate the databases that will be backed up when you sync.• 
Skip: skips this database when syncing.• 
AvGo: the abbreviation for AvantGo, a database for news articles that you may have on your
PDA. The AvGo database is listed by default for the Skip option.

• 

The last section, Sync, includes some extra options. You may want to explore these further after
you become a syncing pro.

Sync Files: select this if you want files in the File Installer to be installed on your PDA in the
next sync.

• 

Local Overrides Pilot: assumes t hat the files on your PDA are more recent than those in
KPilot and replaces the KPilot files with the PDA files.

• 

Force First−Time Sync Every Time: select this if you are using more than one PDA with
KPilot.

• 

Do Full Backup When Changing PCs: select this if you are using more than one PC with
your PDA.

• 

Prefer Fast−Sync to Hot−Sync: Fast−Sync does not perform a complete sync. You probably
shouldn’t choose this item.

• 

KArm: Time Management

If you track your time for billing purposes or even if you are curious about where your time goes,
KArm is a handy feature. To open KArm, go to K menu • Utilities • KArm.
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Figure 4.23: Opening KArm
Working with Tasks

The first time you use the time tracker, you will need to create a new task. In the future, you will be
able to either select an old task or create a new one. To create a new task, click the blank−page
icon on the toolbar. You can create as many tasks as you like.

Figure 4.24: Creating a New Task in KArm
Next you are prompted to enter the task name and given the option to Edit Absolute or Edit
Relative. For a new task, click the button next to Edit Relative, and make sure the + sign is selected.
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You don’t need to enter anything in the blank field next to it.

Tip When adjusting times, note that the first field is for hours and the second is for minutes.

To begin using the time tracker, first make sure that the appropriate task is highlighted (single− click
on it), and then click the start icon. To stop, highlight the task and click the stop icon. After you have
started the clock, a small clock will appear next to the item, and the hand on the clock will go in
circles. After you have stopped a task, the clock will disappear.

Tip To run the clock for more than one task at the same time, simply follow the instructions for
starting the clock on each task.

Tip As a shortcut for starting or stopping the clock on a task, simply double−click the task with the
left mouse button.

To create a subtask, first choose the item for which you want to create the subtask, and then click
the subtask icon and follow the instructions for creating a new task. Tasks with subtasks will have +
or − next to them in the list of tasks in the main window. If all of the subtasks are listed, a − will
appear next to the task. A + will appear if the subtasks are hidden. Click the + to make the subtasks
show up and the − to hide the subtasks.

Tip When you delete a task, any subtasks are also deleted.

The list can be sorted in different ways by clicking the column headings for each option. Task Name
sorts the list alphabetically; Session Time sorts from shortest to longest session time; and Total
Time sorts from shortest to longest total time.

The status bar in the lower right corner keeps track of the total time that has elapsed while tasks
were active. When you have finished using KArm, you can select Quit, and your changes will be
saved automatically.

If you need to adjust the times on a task, highlight the task and click the Edit icon. If you want to add
(or subtract) time from both the session time and the total time, choose Edit Relative. Select either +
or − from the pull− down menu, and then enter the number of minutes you want added or subtracted
in the blank text field. To adjust the session time and total time separately, click Edit Absolute and
make adjustments to the session time and total time as they appear in the fields.

Configuring KArm

To configure KArm, select Configure KArm from the Settings menu. From here, you can set the Idle
Detection and Saving preferences. For those of you who often leave your computer unattended, the
Idle Detection definitely will come in handy. To set Idle Detection, check the box next to Try to
Detect Idleness, and then choose the number of minutes to elapse before you will be informed that
your computer is idle. If your computer senses you have not been using it for the selected number
of minutes, a window will appear, and you will be given three options: Revert and Stop, Revert and
Continue, or Continue. Simply click the appropriate button.

KNotes

Also known as Popup Notes, KNotes is the equivalent of having Post− it notes on your
desktop—but you don’t have to tape them to your monitor to make sure they stick. If you tend to
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ignore your lengthy To−Do lists, KNotes are a great way to keep track of life− or− death matters you
may otherwise forget.

Figure 4.25: A KNote
Tip The default color for KNotes is a horrendously bright yellow, and although this can be

changed, it is probably a good idea to change it to an equally blinding color, so the
notes do not go unnoticed.

To open KNotes, go to K menu • Utilities • KNotes. This application seems almost invisible. After
you open KNotes, a small icon will appear on the K panel that looks like a pen writing on a small
yellow notepad. If you had KNotes open when you quit a previous session, it will open automatically
on the startup of another session.

Figure 4.26: The KNotes Icon
To access the main KNotes menu, simply right− click on the KNotes icon in the taskbar on your
desktop. The main menu lets you open new notes, quit, and so on.

A separate menu is also available for each note. Right− click on the title or name of an open note.
The menu options for individual notes include Insert Date, Mail, Print, Note Preferences, Always on
Top, and so forth. The To Desktop option even lets you move notes between virtual desktops.

Tip Choose Always on Top to ensure you don’t “lose” a note on your desktop.

Working with KNotes

To open a new note, right− click the KNotes icon, and then choose New Note from the menu. A
note will appear, and you can click it and begin entering text. To end, simply click elsewhere on the
screen.

Tip To open an older note, left−click on the KNotes icon and choose a note from the menu.
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The next time you open KNotes, any notes still active (notes that have text in them) will open
automatically, and you also will have the option to open a new note. To close a note, click the X in
the upper right corner of the note.

Configuring KNotes

To set the preferences for KNotes, right− click on the small notepad icon and choose Preferences.
You will be given options to change the Display, Editor, and Action settings. If you set the
preferences from this menu, these settings will remain for any new note you open. You also can set
the configurations for each individual note from the individual note menu mentioned earlier.

Figure 4.27: Configuring KNotes
In the Display and Editor settings, you can set the color of text in your notes, the background color,
note width and height, font size, tab size, and so on.

KNotes can open an email program and insert the text from a note into the body of an email
message. You must specify the email program you want to use in the Actions section of the
configuration menu. Ask your system administrator to set this up for you. The default is KMail, but
other email programs will work as well.

KJots

KJots is roughly the equivalent of KNotes with a thorough filing system. In this program, the user
creates books and uses the pages within the books to write notes. One advantage of this program is
that the books, and the pages within the books, can be saved in ASCII format. KJots could be a
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handy way to organize your notes for several different projects. To open KJots, go to K menu •
Utilities • KJots.

Figure 4.28: KJots
Using KJots

To begin using KJots, you must first enter the title of the book you want to create by choosing New
Book from the File menu. A dialog box will open, asking you to enter a name for the book. The title
then appears in the bottom left corner of the KJots window, and you can type your notes into the
text field. If you want to add a page to your book at any point, simply click the blank−page icon in
the toolbar or choose New Page from the Edit menu on the toolbar.

Books that you use frequently can be added to the Hotlist by choosing Hotlist from the menubar and
selecting Add Current Book. All books on the Hotlist may be accessed easily by buttons.

KCalc

KCalc is KDE’s easy−to−use calculator utility. To open KCalc, go to K menu • Utilities • KCalc.
When you open KCalc, a window pops up that looks like an ordinary calculator. You may find this
application useful because the calculator includes some options that are not available on the
standard ten−key calculators used in many offices.
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Figure 4.29: KCalculator
Using KCalc

To perform an operation, simply use your mouse to click the appropriate buttons, as with a
handheld calculator. You can also enter numbers by using your keyboard and pressing ENTER
instead of the equal sign, but to perform most functions, you must click the keys on the calculator.

Configuring KCalc

To change the preferences for KCalc, click the Configure button toward the top of the window. The
Precision settings control the libc and libmath files on your computer. It is best to leave both of these
at the default values, which should be adequate for normal use.

Mode changes the functions of the buttons in the left− most column on the calculator. You may
need to change the mode between Trigonometry and Statistical, depending on the kind of work
you’re doing. You can also customize the fonts and colors of KCalc from here.
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Chapter 5: The Open Office Suite

Overview

This chapter gets you up and running with OpenOffice so you can perform standard tasks such as
building a spreadsheet, making a chart, or writing and formatting a document. This and the following
chapter introduce you to tools well suited for the office. While there are certainly more office
applications available for Linux, we cover only those sufficiently advanced in development to give
you confidence of use.

A vast array of office applications, both commercial and free, is available for Linux. A group of
applications presented in a similar fashion that comes bundled together is often called a suite. The
office suites that come with a price tag include Anyware Desktop, previously known as Applixware
Office (http://www/ vistasource.com); Corel’s WordPerfect (http://www.wordperfect.com/); and Sun
Microsystems’ StarOffice (http://www.sun.com/software/star/staroffice/).

We feature some of those without a price tag in this and the following chapter: OpenOffice, KOffice,
KWrite, and AbiWord. StarOffice version 5.2 was formerly a free offering. With the release of
version 6.0, Sun has begun charging a moderate price for StarOffice (both versions) but has
continued to offer OpenOffice (http://www.openoffice.org/) at no cost. It is included on many Linux
distributions, including SuSE. Keep in mind that a free product in the Linux world does not translate
into an inferior product. In fact, at SSC we have used Sun’s StarOffice as our default office suite for
many years and are now beginning to use OpenOffice.

Most of the differences between OpenOffice and StarOffice can be accounted for by the fact that
StarOffice contains elements that Sun pays to license, and therefore these elements are not
included in OpenOffice. These include certain fonts (such as Asian language fonts), database
support, templates, and certain clip art images. StarOffice also offers manuals and support, while
OpenOffice does not. OpenOffice does, however, boast a rather comprehensive list of topics on the
Help menu.
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Figure 5.1: OpenOffice Help
Those who rely on document templates will miss them in OpenOffice. This is a feature that will
probably be added to future versions, but if you can’t do without it, we recommend purchasing
StarOffice, as it comes with a large variety of document templates.

Introduction to OpenOffice

OpenOffice is a feature− rich office productivity suite distributed and maintained by Sun
Microsystems. Comparable to Microsoft Office, OpenOffice includes a word processor, a
spreadsheet application, presentation software, and graphic program applications. OpenOffice is
incredibly powerful—many believe that not only is it as good as MS Office, but also better in many
ways. OpenOffice is available for other platforms as well, including Solaris and Microsoft Windows,
and runs equally well on all of them.

OpenOffice offers the ability to import many different types of documents and templates from a
variety of other programs, including Microsoft Word. It can also export to a wide range of formats,
including HTML, PDF, and MS Office XP.

OpenOf f ice  may be inc luded on your  d is t r ibu t ion a l ready.  I f  i t  i s  not ,  s imply  v is i t
http://www.openoffice.org/ There you can download the latest version for free. This site also
contains a list of distributors who sell CD−ROMs that install the software.

Tip The users@openoffice.org mailing list is a great way to get help with OpenOffice. Visit
http://www.openoffice.org/ for details. Online help is also available.

The default OpenOffice installation places an OpenOffice submenu in the K menu. From there, you
can launch any of the OpenOffice programs (Writer, Calc, Draw, or Impress). You can also click on
any existing OpenOffice document to open it within the appropriate OpenOffice application. Once
the application is open, another OpenOffice program can be started from the open application’s File
menu.

The menus and toolbars may look familiar to you, as they are similar to those of other office
programs—the main menubar at the top and two tiers of toolbars displayed by default. As usual,
many of the most used menu items are available from the icons in the toolbars. You can discover
the function of an icon by holding the mouse pointer over it.
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Figure 5.2: OpenOffice Writer
Tip If you find yourself using OpenOffice or any OpenOffice document often, add its icon to the

desktop or panel bar. See the “Adding Icons” section of Chapter 11 for details.

Writer: Working with Text

Writer is a word processor that allows you to compose documents such as letters and articles, as
well as import and export documents from other systems in a wide range of file formats that include
HTML, ASCII, RTF, and MS Word.

Creating a New Document

When you launch Writer, you are put into a new document automatically, so there is no need to do
anything other than simply begin typing. If you’d like help building your document, Writer provides a
selection of AutoPilots for commonly used documents such as fax cover pages, sales contracts, and
school papers.

Tip To set a style for your document, use the Paragraph Stylist. It is turned on automatically when
you launch Writer. Turn it on or off by selecting Stylist from the Format menu.

Using the AutoPilot

AutoPilot, often referred to as a wizard in other office programs, guides you through a series of
document customization questions.

To use this feature, select AutoPilot from the File menu. Then choose the type of document you
want to create. Options include memos, faxes, letters, and web pages.

Once selected, the AutoPilot Agenda dialog box appears. You are instructed to customize your
document by choosing a layout style, including a logo or graphic, and naming your file.
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Figure 5.3: AutoPilot Agenda Dialog Box
Click Next to select your desired options, and continue clicking Next each time you are done with a
set of customization questions. When you are finished, click Create, and your document loads.

Figure 5.4: AutoPilot Agenda Document
Tip Turn on the Autotext feature on the Edit menu. Check the Display Remainder of Name as

Suggested While Typing box, and type the word you want to add to the Autotext list.
Tip Count the number of words in your document by selecting File • Properties • Statistics.

Opening an Existing Document

To open an existing document, select Open from the File menu or click the open file icon featured
on the main OpenOffice toolbar (the icon is a file folder with a little arrow indicating that it opens). It
opens your home directory. Double−click on the file you want to open, and your document loads
automatically.
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Figure 5.5: Opening an Existing Document
When you open a file from a directory in this way, the Open Folder dialog box allows you to select a
file type. OpenOffice defaults to All, which lists and searches through all file formats automatically.
You can choose to narrow the number of formats by selecting a specific one from the File Type
drop− down menu. For example, if you have forgotten the name of the document you want to open,
but know it is in MS Word 97 format, select MS Word 97 from the drop− down menu. Only the MS
Word 97 files found within that directory are then listed in the Open dialog box. For more file format
options, see the Open dialog box.

The Open dialog box also allows you to do things like create a new folder in which to save or move
documents; simply click the create new directory icon (it pictures a file folder with an asterisk in the
upper right corner). The default directory icon, featured just to the right of the create new directory
icon and displaying a sledgehammer, allows you to return quickly to the default directory (set by
default as your home directory). To help navigate to the file you are looking for, the up one level
icon to the right of the create new directory icon takes you the parent directory of the current
directory. OpenOffice also lists the most recently used documents at the bottom of the File menu for
quicker access.

Importing and exporting MS Word and other documents created in popular word−processing file
formats is quick and easy in OpenOffice. Follow the example just given in “Opening an Existing
Document” to import a foreign file format. To save a document as a foreign file format, go to the
Save As dialog box, simply click the arrow within the File type text box, and select the desired file
format from the scroll bar.

Tip OpenOffice comes loaded with a thesaurus. You can access it from the Tool menu.

Formatting Your Document

Formatting allows you to choose the font and page styles to apply to your document. There are
many options available in Writer. Here we review standard formatting tools. Advanced users can
feel confident that other formatting features, such as those that let you apply text styles, add tables,
and create indices, are all available. They are located generally in the same places you would find
them in other word processing applications. All of these formatting options can be set before
beginning a new document or applied to existing documents.
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Tip Spell check a document by selecting Spellcheck or AutoSpellcheck from the Tools menu.

Tip When you begin a task or turn on a feature that OpenOffice thinks it can help explain, such as
AutoSpellcheck, a light bulb appears in the bottom left corner of the window. Clicking on it
brings up the relevant topic in the Help contents.

Choosing a Font

The default Writer font is 12−point Thorndale. To change the font, simply highlight the desired text
and select the desired font type and size boxes just above the document. Next to the font name and
size are buttons for Bold, italic, and underline.

Aligning Text

The Writer default is to left−justify all text within a document. If you want some or all of your
document to be aligned differently, highlight the appropriate text and select an alignment icon
(featured just above the document and next to the font attribute icons). Options include left,
centered, right, and forced justification.

Using Bulleted Lists

Place the mouse pointer at the beginning of the paragraph or sentence where you want to insert a
bullet or number. Click either the bullets or numbers icon in the second row of icons at the top of the
OpenOffice desktop. The paragraph or sentence is instantly formatted as the appropriate type of
list. To turn off bulleting, move your mouse pointer to the beginning of the paragraph or sentence
where you want to end the list or delete a bullet, and again click the bullets or numbers icon.

You can apply a different bullet or numbering symbol by selecting Numbering/ Bullets from the
Format menu. The Numbering/Bullets dialog box appears.

Figure 5.6: The Numbering/Bullets Dialog Box
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Select the appropriate tab at the top (bullets, numbers, or graphics). Then click the example box of
your choice and click OK.

Increasing and Decreasing Indents

To increase or decrease the indentation of text, click one of the two indent icons, featured just
above the document to the right of the numbers and bullets icons. The icon featuring text and an
arrow pointing left decrease an indent, whereas the icon featuring text and an arrow pointing right
increase an indent. Click the appropriate icon more than once to add more or less indentation.

Applying Color

Color can be applied to text characters or added as a highlight over a string of text. The color icons
are found next to the indentation icons. Select the text you want to color or highlight by clicking and
dragging your mouse pointer over the desired text. Then click the icon featuring a yellow
background behind the A character, and your text is highlighted.

Color also can be applied to the background of a document. The icon that features a complete
palette of colors (positioned next to the character color icons) performs this task for you. Click the
background color icon. A dialog box appears prompting you to select a color. Once you have clicked
on the desired color, your background changes to the new color.

Figure 5.7: Coloring the Background of a Document
Advanced Formatting Tools

Advanced page formatting tools are available in a central dialog box titled Page Style. To access it,
select Page from the Format menu, and the Page Style dialog box appears.
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Figure 5.8: Page Style Dialog Box
Here you are given the opportunity to select the background color, size, and margins of the
document; apply headers, footers, and borders; and even set columns.

Advanced paragraph and character formatting tools are also available. Select Paragraph or
Character from the Format menu, and the Paragraph or Character dialog box appears. From here
you can apply drop caps, tabs, and alignment, among other advanced paragraph formatting tools.

To add page numbers to your document, choose the Footer tab from Format • Page, check the
Footer On box, and select OK. Next, from the Insert menu choose Fields and then Page Numbers.
A 1 appears in the footer. If you want the page numbers to appear as “1 of 10” or “1 of 18”, and so
on, select Fields and then Page Count. Next, under Footer, edit the text to add the word “of”.
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Figure 5.9: Paragraph Dialog Box
Inserting Graphics into Your Document

From the Insert menu, select Graphics and then From File. The Insert Graphics dialog box appears.

Figure 5.10: Insert Graphics Dialog Box
Select the graphics filename just as you selected an existing document file. Once your graphic
appears in the document, you can double− click it at any time to pull up the Graphics dialog box.
Here you can crop, make the image a hyperlink, or add a border. Once you have selected the
options you want, click OK to proceed with the changes or Cancel to cancel any changes.
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Figure 5.11: Graphics Dialog Box
Tip You can move your graphic by simply clicking and dragging the image anywhere within the

document.

Figure 5.12: Inserting and Moving Your Graphic
To delete the graphic, simply select it with the mouse and select the cut icon, or right− click the
image and select Cut from the pull− down menu.

Saving Your Document

To save your document, select the floppy disk (save) icon from the top toolbar or select the Save or
Save As options located on the File menu. The Save dialog box appears, instructing you to name
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your file (if it is not already named), designate the directory to which you want to save the file, and
choose the file format you want your document to be saved as (click the arrow next to File type to
see a list of file format options). This is where you can prepare your document for exporting, as
mentioned previously.

Tip To save your document as a PostScript file, select Print to File from the File • Print menu. Save
the file with a .ps extension. Keep in mind that if you save a document in this format, it cannot
be re−edited, so you should save a copy in a standard document format as well.

Creating Document Templates

Although the current version of OpenOffice does not come with existing document templates, it is
possible to create templates. Start by opening a new document. Create a set of styles and give it
the desired structure, and simply save the document as a template from the Save As dialog box.

Printing Your Document

Printing your document is easy. Simply select the print icon from the toolbar immediately below the
menubar, or select Print from the File menu. In either case, a Print dialog box opens, giving you the
option to print to your printer or to a file. Options are presented to print a range of pages, if you don’t
need the whole document, or to print multiple copies.

Tip You have more print options if you select Print from the File menu. The Printer toolbar
icon prints according to the defaults.

Figure 5.13: Printer Dialog Box

OpenOffice Calc: Spreadsheets

OpenOffice Calc is a powerful spreadsheet program that also imports and exports other popular
spreadsheet formats, including MS Excel. Spreadsheets are large tables where information is
entered in individual cells that appear in rows and columns. They’re ideal for accounting purposes
and for creating data comparisons.
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Figure 5.14: OpenOffice Calc
It is easy to enter data and formulas in OpenOffice Calc and to create charts from that information.

To launch Openffice Calc, select Calc from the OpenOffice submenu in the K menu.

Tip For advanced users, OpenOffice Basic offers the opportunity to automate some of these
processes with macros. Select Macro from the Tools menu, or see the Basic IDE entry in the
OpenOffice Help.

Creating a New Spreadsheet

When you launch OpenOffice Calc, you are dropped into a new spreadsheet automatically, and you
can begin entering data. Or you can open an existing spreadsheet (New • Open) to begin working.

A spreadsheet contains cells organized in rows and columns. To begin entering data into your
spreadsheet, simply click in a cell. A black outline appears around the selected cell. Enter data,
either text or numbers. When you are finished, simply click in another cell or press ENTER on the
keyboard. You can also use the arrow keys or the TAB key to move to the next cell. This process is
much like entering data into a word processor except that, in this case, each piece of data is
entered into one cell at a time.
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Figure 5.15: Entering Data into Your Spreadsheet
Tip To highlight a table area, click the upper left cell of the desired area and hold down the mouse

button. Then drag the mouse pointer to the bottom right cell and release.
Deleting or Moving Data

Since your spreadsheet is likely structured with formulas, deleting or moving data can be a bit more
complex than it is in a word processor.

To delete data in an individual cell, simply use the BACKSPACE key to delete each character or
number desired. To move data in one cell, right− click within the cell. Select Cut or Copy, depending
on which action you want. In the new cell, right− click again, but this time select Paste.

You also can delete or move all data contained in a row or cell. Use the Delete Cells option on the
Edit menu, or simply right− click on the data and select Delete from the menu that pops up. This
option allows you to specify what should happen to the deleted row—for instance, move rows up or
shift columns.

Figure 5.16: Delete Cells Dialog Box
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Changing Heights and Widths

The cells in a spreadsheet are fairly small, but the size can be changed to accommodate larger
entries and make data more readable on printouts. There are two ways to accomplish size changes.
The first is to place the mouse cursor over the lines separating rows and columns in the guides (the
lettered boxes at the top of the spreadsheet for columns, and the numbered ones along the left side
for rows). For instance, if you want column A to be wider, position the mouse pointer over the
borderline between the column A guide and the column B guide. When the pointer changes to a
double−headed arrow, click and drag to the left or right to shorten or lengthen the column as
desired. For rows, it’s the same procedure except you move the double−headed arrow up and down
to shorten or heighten the rows.

A second way to change cell sizes is more precise, in that it allows you to select measured
increments. From the Format menu, select Cell, Row, or Column. In the resulting submenu, choose
the first entry (Column Width or Row Height). Here you can enter a specific size in inches.

Using Formulas and Functions

Formulas and functions perform mathematical calculations automatically before displaying numbers
within a cell. A formula always begins with an equal sign (=) and is created using alphanumeric
combinations. Each cell has a grid address. The cell in column A, row 1 is referred to as A1. The
cell in column B, row 6 is referred to as B6, and so on.

Formulas can be written to add, subtract, multiply, and divide. To write a formula, start by typing an
equal sign (=) within a cell. This tells Calc that you want to perform a calculation. Then type the
formula, for example, type =A9+A10+A11+A12. Press ENTER when the formula is complete. Calc
performs the calculations. In this case, it adds the numbers in the given cell and displays the results
in the cell in which you entered the formula.

A function is a predefined formula that performs calculations by using specific values in a certain
order. A function begins with the function name, followed by an opening parenthesis, the specific
values (often referred to as the argument) for the function, separated by a colon, and ending with a
closing parenthesis. Again, the function must be preceded by an equal sign. For example, typing
=SUM(A9:A12) into a cell and pressing ENTER yields the sum of the values in A9 and A12 in that
cell. Hundreds of functions are available in a variety of categories (logical, financial, and
mathematical, for instance. Select Function List from the Insert menu for a complete list of available
functions.

Formatting Your Spreadsheet

Formatting a spreadsheet is much like formatting a document. The same capabilities are available,
such as features to alter fonts and font size, and add color to some or all of the background. Refer
to “Formatting Your Document” earlier in this chapter for details.

When formatting a spreadsheet, you can easily format a single cell or an entire group of cells. For
instance, you may want to add a background color to all cells in column D. To do so, highlight a
group of cells by clicking the uppermost cell of the desired area and holding down the mouse
button. Then drag the mouse pointer to the bottom cell and release. Now click the Background
Color icon, select your color of choice— and voila!
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Figure 5.17: Adding Color to a Column of Cells
Tip You can make a row freeze so that it remains visible when you scroll down the window.

Click the bottom line of the last row you want to remain visible, and then select Freeze
from the Window menu.

Making a Chart

It’s easy to convert data from a spreadsheet into a chart. To begin, open an existing spreadsheet.
Highlight the group of rows, columns, and headings from which you want to build the chart. Select
Object from the Insert menu, and then OLE Object from the resulting submenu. The Insert OLE
Object dialog box appears.

Figure 5.18: Insert OLE Object Dialog Box
Select Create new, then Chart. Click OK. Your chart appears.
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Figure 5.19: Creating Your Chart
You easily can change the size of a chart by clicking and pulling on the outlines of the box. To
change text within the chart, click within the box on the appropriate text. Right− clicking within the
chart pops up many additional customization options.

You can choose from many different types of charts. Double− click within the chart, then select
Chart Type from the Format menu. The Chart Type dialog box appears, prompting you to select one
of several 2−D or 3−D charts.
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Figure 5.20: Chart Type Dialog Box
Saving Your Spreadsheet

To save your spreadsheet, use the same menu items as for saving a wordprocessing document.

Select the Save or Save As options from the File menu. The Save dialog box appears, once again
instructing you to name your file (if it is not already named) and choose the file format in which you
want your spreadsheet saved (click the arrow next to File type to see a list of file format options).

As with MS Word documents, you can import or export MS Excel and other popular spreadsheet file
formats in OpenOffice. Follow the example in the earlier section “Opening an Existing Spreadsheet”
to import a foreign file format. To save a spreadsheet in a foreign file format, from the Save As
dialog box simply click the arrow within the File Type box and select the desired file format.

Working with Multiple Pages in One Spreadsheet

Sometimes you may want to have multiple separate pages in one spreadsheet. For example, say
you create a detailed report every month. You want to have every month on its own page, but you’d
like to keep all the pages together. Notice the tabs at the bottom of the screen that say Sheet 1,
Sheet 2, and so on. You can use your mouse to flip between the pages and rename them by
rightclicking a tab and choosing Rename. You can also change the order in which the sheets
appear by placing the mouse pointer on the tab, and then dragging and dropping the sheet to the
new location.
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Printing Your Spreadsheet

Before printing your spreadsheet, you should take the time to think about how you want your
spreadsheet to look. Do you want the grid boxes to appear? Do you want all of the spreadsheet or
only certain data within it to appear?

To print the entire spreadsheet, select Print from the File menu. To print just a portion of your
spreadsheet, highlight that portion, and then select Print Ranges from the Format menu. From
there, select Define. Now continue on with the standard printing procedure.

It is common to turn off grid boxes on a spreadsheet before printing it. Other formatting features
include scaling the spreadsheet to fit on one page, printing only a chart, and printing only the data.
To access any of these formatting tools and others, select Page from the Format menu.

Figure 5.21: The Calc Page Style Dialog Box
Often spreadsheets look better, and are more efficient and effective, if they are printed across the
page sideways to show more columns on a single printed page. By default, all documents print in
the normal 81/ 2 − inch by 11− inch layout, called portrait mode. You can change the layout to
landscape mode, which uses an 11− inch by 81/ 2− inch layout, by selecting Page from the Format
menu. From the resulting dialog box, choose the Page tab, and within the Page format section,
select Landscape.

OpenOffice Impress: Presentations and Slideshow

You can create presentations quickly and simply with Impress. The format for information in a
presentation is slides, which are a single screen in size and can combine text and graphics. The
presentation can then be printed or shown on the monitor.
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From the menubar, select File • New • Presentation. Select Empty presentation from the AutoPilot
Presentation dialog box, then click Next. On the following screens you are asked to make selections
to customize your presentation. The third screen allows you to add effects such as fades. After
making your selections, click Create.

At this point the Modify Slide dialog box appears, and you can choose the layout of your slide. Make
your selection and click OK.

Figure 5.22: Specifying a Layout
The first slide of your presentation now appears. Click the area where you want to feature text or
insert a graphic. Begin typing (where there is existing text, simply click the text and begin typing
over it), or select Graphics from the Insert menu and proceed by selecting the graphics filename of
your choice.
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Figure 5.23: Adding Text to Your Slides
When you’ve completed the first slide of your presentation, you can insert another slide by clicking
the empty gray bar next to the tab of your first slide’s page at the bottom left side of the screen. To
alter this newly created slide, simply right− click the new tab titled Slide 2 and select Modify Slide.
You then continue as you did when creating your first slide.

Fine−Tuning Your Presentation

To alter a slide, click the drawing view icon, which is located in the icon set above the vertical
scrollbar.

To change the sequence in which your slides appear, click the slide view icon, located above the
vertical scrollbar. From here you can easily drag and drop slides into the sequence you desire.

Many other formatting options are available to you in OpenOffice Impress. In fact, these are easily
the topic for their own book. But truthfully, once you have the basics, a little clicking around helps
you discover what you need to know.

Saving and Exporting Your Presentation

You’ve finished the slides, and now it’s time save your presentation. To do so, select Save As from
the File menu, name your presentation, and select Save. Impress is the default file format, although
you can save in a Draw or MS PowerPoint format, if you prefer.

Exporting as a Web Presentation

Exporting your file as a web presentation is particularly handy, as it can then be viewed by any web
browser. Begin by selecting the Export option from the File menu. Don’t worry about which slide you
are on when you do this. This action exports the entire presentation.
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Give your presentation a filename and save it. You are then guided through the exporting process.
First select an HTML design. Select New design from the HTML Export dialog box, and click Next.
You are instructed to choose a publication type. How do you want your HTML presentation to be
displayed? Options include plain HTML pages, frames, automatic slideshow view, or webcast.
Select the desired customization options, and click Next. Depending on which option you choose,
you may be guided through the selection of a short series of other HTML characteristics.

Figure 5.24: Exporting to HTML
Once you’ve selected your HTML characteristics, you are ready to save your HTML presentation.
Select a file type (options include GIF or JPG), compression value, and screen resolution (the lower
the resolution, the smaller the graphic image files), and indicate whether you want a sound played
when slides advance. When you are finished, click Create.

Now you’re ready to view your HTML presentation in a browser (or OpenOffice). Simply open your
web browser of choice and point your browser at your HTML presentation’s filename.

Printing Your Presentation

Printing your presentation (especially handy for overheads) is as simple as clicking the print icon at
the top of the screen.

Viewing Your Presentation

To view your presentation as a slide show, click the start slide show icon above the vertical
scrollbar. Your presentation starts immediately and advances automatically. You can select the time
intervals, or you can choose to advance slides with a mouse click, which is handy if you’re doing a
presentation with input from other people.

To alter presentation settings, choose Slide Show from the menubar, and then select Slide Show
Settings.
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Figure 5.25: Accessing Slide Show Settings
A dialog box appears giving you the opportunity to change basic settings, such as whether to
include previously created slides or altering how the slides change.

OpenOffice Draw for Graphics

OpenOffice features a graphics program called Draw. While it is technically a vector program, it
provides some of the bitmap functionality of programs such as The GIMP and could be classified as
a beginner− to intermediate−level graphics program. It is well suited for combining text, shapes,
lines, and images into a single document, and has a limited ability to do a wide variety of tasks that
usually require a specialized program. While some of its features are not as refined as they are in
programs such as The GIMP, the advantage is that they are combined in one program. So if you
want to create a business card with a graphic, you can do it without moving back and forth between
programs.

As with Kontour, Draw allows you to draw Bezier curves, geometric shapes, and to import bitmap
images into your document. You can also import spreadsheets or charts from spreadsheets. With
Draw, you can add 3−D shapes and convert the boundaries of 2−D images to 3−D so they can be
manipulated as 3−D objects.

A Sample Draw Document

Let’s say you’re a used taxicab salesman and want to create an advertisement for a community
newsletter. You’ll want some captivating text, an illustrative graphic, and some data in the form of a
graph demonstrating the superiority of your product. You may even want some special effects for
good measure.

Starting a new document in Draw is the same as with the other OpenOffice programs (New •
Drawing).
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Let’s start with the text. Click the capital T icon in the left toolbar. This converts the mouse pointer to
crosshairs. This allows you to draw a text box where you enter your text. Hold down the left mouse
button to begin drawing the box, and drag until the box reaches the desired dimensions (the outline
appears as it is drawn). Release the button when done. Then click inside the resulting box to begin
entering text. Remember that the features of OpenOffice Write are available to you when working
with text in Draw—such as spell checking and the thesaurus.

Figure 5.26: Entering Text
To add a graphic, select Graphics from the Insert menu. This presents a dialog box allowing you to
browse for the desired file. Like the text, the graphic appears in a box with border points, and it can
be manipulated by clicking and dragging on the borders.

Tip If you want to add an image from another document to the current one, you can
right−click on it and select Cut or Copy. Then right−click on the current document and
select Paste.

Figure 5.27: The Insert Graphics Dialog
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To insert a chart, select Insert • Object • OLE Object. A dialog box appears to allow you to choose
the desired object. Select your chart, and it appears in your document.

Figure 5.28: The Insert OLE Object Dialog
Now you’ve got a document with text, a graphic, and a chart.

Figure 5.29: Sample Document with Text, Graphic, and Chart
To spice up your ad, you may want to add some kind of effect such as converting your graphic to
look like a charcoal sketch. Select the graphic by clicking on it, making the Edit Points icon in the
upper left corner of the Draw window become a filter icon. Clicking on it reveals a number of options
for modifying the look of your graphic. These include solarization, mosaic, smoothing, relief,
charcoal sketch, and seven other options.
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Figure 5.30: Turning Your Graphic into a Charcoal Sketch
To gain an appreciation of Draw’s other features and an understanding of working with graphics in
general, it is recommended that you read Chapter 7, “Working with Graphics,” and Chapter 8, “More
on Graphics: The GIMP.” Then you should be able to navigate through OpenOffice Draw’s features
fairly easily.

Keyboard Shortcuts in the OpenOffice Suite

Though moving around OpenOffice with the mouse pointer works very well, you may want to speed
things up a bit with keyboard shortcuts as you become more proficient. Not moving your hand from
the keyboard to the mouse can save considerable time.

Two different kinds of shortcuts exist in OpenOffice. The first shortcut uses the ALT key plus a letter
to open a menu, and then a keystroke to select an option within the menu. All shortcut letters are
underlined in their menu listings. For example, if you want to insert a horizontal line into a
document, you can press ALT−I to open the Insert menu, then press the Z key to open the Insert
Horizontal Line option box. Notice the underlined “z” in the word Horizontal, indicating the keyboard
letter to effect the shortcut.

The second type of shortcut is called an accelerator. Using the CTRL key with a keystroke, you can
execute a task instantly, such as saving a file or printing a document. Accelerator shortcuts are
documented in the menus to the right of the listed items. For example, assume that you’re in a
document and want to print it. Rather than using the mouse to select File and then Print, you can
press CTRL−P to open the Print dialog box. Spend some time looking through the menus and
experimenting with the many available shortcuts.

99



Figure 5.31: As shown in the menu, the Accelerator to open a file is CTRL−O
After you’ve spent some time working with the OpenOffice suite and learning the shortcuts for the
functions you use most, you’ll come to appreciate its power, features, and flexibility, and wonder
how it is free of charge.
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Chapter 6: Alternative Office Software

KOffice

KOffice is an office suite still somewhat in its infancy, having reached the 1.x release in 2001. Here
we introduce KOffice’s word processing and spreadsheet applications, both of which are easy to
use and trustworthy. The KOffice suite includes many applications:

KWord: a frame− based, full−featured word processor and desktop−publishing application.• 
KSpread: a standard, table− oriented spreadsheet application.• 
Kontour (formerly known as KIllustrator): a vector− based drawing program along the lines of
CorelDRAW or Adobe Illustrator. This application is covered in Chapter 7.

• 

KPresenter: a presentation application.• 
Kivio: a flowcharting application.• 

The following applications allow you to edit objects you want to insert, like charts and graphics, into
the main applications:

KChart: a chart− drawing program.• 
KFormula: a formula editor.• 
Krayon: a pixel− based, image manipulation program.• 

Although many users opt to use OpenOffice’s more mature environment, we recommend following
the development of KOffice, which may become a standard in the near future.

You should be able to locate KOffice in your Linux distribution. If not, the suite is available for
download at http://www.koffice.org/

KOffice has an impressive lineup of office− related applications that function acceptably well
together, without taking up a lot of space on your hard drive. You might notice that KOffice isn’t as
polished as other office suites, such as MS Office and OpenOffice. However, you’ll find that all of
your bread−and− butter functions, and more, are adequately covered.

Tip Remember to visit KOffice’s website frequently, http://www.koffice.org/ for new releases.

Navigating KOffice

Once KOffice is installed, launch it from the Office submenu of the K menu. You can launch any of
the individual applications from here, or you can type the name of an application in the Run
Command dialog box.

In addition to launching each application in KOffice separately, you have the option of opening the
KOffice Workspace (also from the Office submenu), which opens the entire suite at once. On the left
side are two useful menus: Parts and Documents. You’ll notice that the Parts menu conveniently
allows you to open any of the other applications. If you look toward the bottom you’ll see a button
labeled Documents. Though it’s out of the way and inconspicuous, this menu allows you to switch
back and forth between any open documents. Certainly this navigation method is different from
other standard office suites, but you’ll find it an efficient way to maneuver in KOffice.

Other than that, navigating KOffice is similar to navigating other office suites. If you like using your
mouse, you can click the menus and commands on the top of the application bar. If you prefer the
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keyboard, you can use the same types of keyboard shortcuts explained in the section of Chapter 5
called “Keyboard Shortcuts in the OpenOffice Suite.” For example, in KWord, pressing ALT−T and
then S activates the Tools menu and launches the spell− checker function. Unfortunately, it’s
impossible to move around between different files within the KOffice Workspace without using the
mouse.

Another helpful shortcut is the CTRL key and a letter to activate various commands, which you can
find in the menus on top. You may be familiar with CTRL−S for saving, CTRL−Q for quitting, and
CTRL−P for printing, each of which is standard in KOffice. Be careful, however, because now and
then you’ll come across dead−end keystrokes, especially in text formatting. For example, CTRL−B
will create bold text on most word processors, but not in KOffice applications.

KWord

If you’ve ever experienced severe frustration trying to use a typical word processor for
desktop−publishing (DTP), KWord may be the tool for you. KWord allows you to position a series of
one or more frames in a document, each containing graphics, text, or objects from another KOffice
application. The concept of frames was made popular by Adobe Framemaker software, and it
enables smooth integration of all elements.

One area where KWord needs improvement is file format portability. KWord can import MS Word
documents, but it cannot export them. Furthermore, KWord will not open StarOffice or OpenOffice
documents. However, importing and exporting functions are in the works for AbiWord, ApplixWord,
DocBook, HTML, LaTeX, MIF, RTF, StarOffice, OpenOffice, StarWriter, and WordPerfect.

Creating a New KWord Document

The most intuitive route to a new KWord document is clicking on the KWord icon in the Parts menu.
A dialog box comes up that asks you to select from four options:

Create new document with template, which offers two options:• 

Page layout documents: two templates with multiple frames are offered for desktop
publishing− oriented documents.

1. 

Text− oriented documents: choose from A4, Plain Text, Two Columns or US Letter
templates for standard word−processing documents. Each contains one major frame. (See
“Using Frames” later in this chapter.)

Open an existing document.♦ 
Open a recent document.♦ 
Start with an empty document.♦ 

2. 
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Figure 6.1: Opening a Document in KWord

Once you’ve made your choice, you will have a new KWord document. Other options for creating a
new document include clicking the icon that looks like a piece of paper in the upper left corner or
choosing Open from the File menu.
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Figure 6.2: A New Document
Unfortunately for US users, the only template to offer margin measurements in inches is the US
Letter template. Otherwise, the measurements are in millimeters, which offers a creative way to
practice the metric system.

Furthermore, you will find a dearth of templates in KWord and KOffice in general, meaning you’ll
have to create most types of documents on your own.

Opening an Existing Document

Select Open from the File menu to open an existing document. By default, KWord will search first in
your home directory, so this is a good place to store your documents. Use the dialog box to find
your file, then double− click the file, or highlight it and choose Open.

Figure 6.3: Opening an Existing Document
If you get lost, you always can click the home (the usual house) icon to get back to your home
directory. Also, you’ll be pleased to know about the command Open Recent, located below the
Open command. Here you’ll find a selection of documents that you’ve worked on recently.

Using Frames

If you open a text− oriented document, you essentially get one big frame. It functions like a normal
word processor if you only work with plain text.

For more complex documents, KWord uses a system of frames that makes it much more powerful
than a standard word processor. This function makes KWord work more like a page layout program
than a word processor. A frame is a light gray box in the document. Frames allow you to lay out
blocks of text, images, and objects and place them wherever you like. To create a frame, select
Text Frame from the Insert menu. The mouse cursor will become crosshairs. Put the crosshairs
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where you want one corner of the frame to begin. Left−click and drag the mouse toward what will be
the opposite corner, and an outline will be formed representing your frame. When you reach the
desired frame size, release the mouse button. The Connect frame dialog box appears, asking if you
would like to create a frameset (a frame into which text from other framesets will not flow).

Figure 6.4: Creating a Frame
To enter text, click inside the frame and start typing. If you want to move the frame, place the mouse
cursor along one edge of the frame until it becomes a four−way arrow. When it does, left− click and
drag the frame to the new location. If you place the mouse cursor on one of the blue squares along
the perimeter of the square that appears when you left− click, you will get a double arrow that allows
you to stretch the boundaries of the frame to change the length or height. To change the frame size
in a way that is height−width proportional, place the mouse cursor next to one of the blue squares in
one of the frame’s corners.
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Figure 6.5: Manipulating the Frame
Formatting Your Document

Formatting allows you to choose character and page styles. Scores of options are available in
KWord. Advanced users can rest assured that other formatting features, such as those to apply text
styles, add tables, and create indexes, are all available and generally located in the same places as
they are in other word− processing applications.

106



Figure 6.6: Formatting Your Document
Choosing a Font

KWord’s default font seems to vary with versions. To change the font, highlight the text you want to
modify and select a font type and size from the drop− down Font menus above the document. The
highlighted text will change accordingly. Or simply set these options when starting a new document.
Bold, italic, and underline options are also available. Simply click the B, I, or U buttons, respectively,
to the right of the font toolbars. Superscript and subscript options are also available on the Font
menu or icons in the middle of the toolbar.
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Figure 6.7: Selecting a Font
Aligning Text

KWord’s default is to left−justify all text within a document. If you want some or all of your document
to be aligned differently, highlight the appropriate text. Then select one of the alignment buttons in
the bottom toolbar. Options include left, centered, right, and forced justification. You can also
determine and set the alignment of your document before you begin typing.
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Figure 6.8: Aligning Text
Using Bulleted and Numbered Lists

Position your mouse pointer at the beginning of the paragraph or sentence where you want to insert
a bullet or number. Click the numbers icon on the bottom toolbar. This icon will only give you a
numbered list. (Click the icon again to remove this feature and return to default formatting.) If you
want to change the numbers to bullets, choose Paragraph from the Format menu. In the dialog box,
select the Bullets/Numbers tab, which has options for altering the numeration of the list or for
changing the number to a bullet point.
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Figure 6.9: Choosing the Type of Bullet to Add to Your Document
Increasing and Decreasing Indents

To increase or decrease the indentation of text, click one of the two indent icons, located to the right
of the numbering/bullets icon. The icon with a leftpointing arrow decreases the indentation, and the
icon with text and a rightpointing arrow increases the indentation. Click the appropriate icon more
than once to increase the indent in the same direction.

Applying Color

KWord allows you to add color to text characters, but you cannot highlight blocks of text beyond the
basic function of selecting. After selecting the text you want to color, click the text color icon, the
letter A over a colored box at the far right in the bottom toolbar. A dialog box allows you to choose
from a palette of colors, or you can create your own color by clicking the color scale with the
eyedropper tool and adding the color to the color palette.

110



Figure 6.10: Adding Color to Text Characters
Inserting Graphics into Your Document

Inserting an image into KWord is done differently than in other word processors. First, you need to
select Picture Frame from the Insert menu, which will bring up a dialog box showing the contents of
your home directory.
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Figure 6.11: Inserting a Graphic into Your Document
Once you’ve found the image you want, click OK, and you’ll get a crosshairshaped cursor. Use the
cursor to draw a frame, or simply click, and your image will appear in the frame. You can manipulate
this in the same way as described in the preceding “Using Frames” section.

KSpread

KSpread is a spreadsheet application featured in the KOffice suite. It has the same look and feel as
most spreadsheet programs. With KSpread you can perform basic spreadsheet functions, such as
opening an existing, recent, or empty document, and create formulas. However, this spreadsheet
program is still in development, and handy features such as templates are not yet available.

112



Figure 6.12: KSpread
Creating a New Spreadsheet

To create a new spreadsheet, select KSpread from the Office submenu of the K menu. The Choose
Option dialog box opens, prompting you to open a new spreadsheet or an existing one. Select Open
New Spreadsheet, and a blank spreadsheet will open.

Opening an Existing Spreadsheet

To open an existing spreadsheet in KSpread, select Open from the File menu, or simply click the
open icon to make the Open dialog box appear.
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Figure 6.13: KSpread Open Document Dialog Box
Moving around the Open document dialog box is quite intuitive. The up arrow will take you back one
directory level, the house icon will take you to your home directory, and so on. When you have
chosen the spreadsheet you want to load, click its name and select OK.

Entering Data

Use the arrow keys to navigate between cells. Press ENTER to move down a cell. Select a cell
(with the arrow keys or the mouse) to enter information. You can type either in the cell or in the form
above the spreadsheet. The data appears in both simultaneously, regardless of where you enter it.

To begin entering data into your spreadsheet, click in a cell and enter either text or numeric data.
Then click in another cell and continue building your spreadsheet. This process is much like
entering data into a word processor, except each piece of data is entered one cell at a time.
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Figure 6.14: Entering Data into Your Spreadsheet
When selecting a group of cells with the mouse, the last cell you highlight will not actually be
highlighted. It will, however, be outlined with a dark border along with the other highlighted cells.
The text styles, colors, fonts, and formats can be changed either before entering data in the
document or after the cells have been highlighted. This is ideal if you want rows or columns to be
differentiated by color, font style, or size. To delete the contents of a cell, select t he cell and press
the BACKSPACE or DELETE key.

Using Formulas and Functions

Formulas and functions perform calculations automatically before displaying the results within a cell.
For detailed information on entering formulas and functions into a spreadsheet, refer to the
“OpenOffice Calc: Spreadsheets” section in Chapter 5.

In any cell where you want to create a formula or function, simply click in the cell and begin with the
standard =sum() entry, then add the formula or functions. Then, list the headers of the row and
column for which you want the calculation performed (all within the parentheses).

Tip A sum icon is featured in the KSpread top menubar. By highlighting the desired cells and
clicking the sum icon, you can automate your function process so that you don’t have to type in
the equation manually. Additionally, a pull−down menu is featured to the left of the sum icon
and includes the word SUM. Click the pull−down menu, and other automatic function options
will become available to you.
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Figure 6.15: Entering Formulas and Functions in Your KSpread Spreadsheet

KWrite

KWrite is a simple text editor often favored by programmers because it features colored syntax
formattings customized for many programming languages. For the standard office user, KWrite is an
intuitive application that’s ideal for times when you want a quick and easy program in which to toss
some text.
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Figure 6.16: Opening a New File
To launch KWrite, type kwrite into the Run Command dialog box. Or from the K menu, select Editor
and then Advanced Editor, which should open KWrite automatically. Opening a new file is as easy
as selecting New from the File menu.

Writing, opening, or editing a document in KWrite are all standard tasks in comparison to other text
editors we have discussed. Familiar features such as Undo, Cut, Copy, and Paste are all included.

AbiWord

AbiWord is a good word processor for people who need the basics and don’t like to wait for a
heavy− duty office suite to start up. It’s not part of KDE, and it may not be included on your Linux
distribution, but it’s such a nice, lean, useful little word processor that we wanted to include it here. If
AbiWord is not installed on your computer, you can find and download installation files at
http://www.abisource.com/ Although it looks pretty simple, AbiWord has a powerful extension
capability behind the scenes. You even can extend its capabilities with scripts, if you care to learn a
little bit of the Perl programming language, and use the word processor as a front end for any Perl
task you like.

AbiWord recently released version 1.0, which should be stable, but you should always save your
work frequently.

If you have used a word processor such as Microsoft Word or KWord, most of AbiWord’s features
will be familiar, and online help is available. As with KDE applications, AbiWord’s Help menu
invokes Konqueror to display help files.
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Starting AbiWord

Start AbiWord from the Run Command dialog (ALT−F2 to bring up the Run Command dialog box)
by typing abiword.

From Your Browser or Mailer

AbiWord is an excellent choice for reading and printing word−processor files that people send you
as email attachments. You may want to make it your default application for working with Microsoft
Word documents (see the “Opening Files” section of Chapter 3). AbiWord starts faster than other
word processors, so you can access your documents more quickly.

The AbiWord Screen

Figure 6.17: AbiWord
Unlike some word processors, AbiWord does not have one main window with multiple document
windows inside. If you open multiple documents, you get multiple real, top−level windows that can
be moved to separate KDE workspaces. You might have one instance of AbiWord with several
documents open, spanning several desktops.

Working with Files

Besides its native format, AbiWord understands HTML 4.0, XHTML, Microsoft Word format, RTF,
DocBook, plain text, and other formats. The easiest way to see the list of file formats currently
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supported is to select Save As from the File menu and select the drop− down menu for Open File as
Type. New formats are added regularly.

Tip To see your document in HTML format, choose Preview Web Page from the Web menu.

New, Open, and Open Copy

On the File menu, New and Open let you start working with a new document. New creates a blank
document, and both Open and Open Copy open an existing one. The difference between Open and
Open Copy appears when you select Save. If you have opened the document with Open Copy, the
program will do exactly that: open a copy of the file you selected. You will be prompted for a new
name for the document. This feature is helpful if you want to revise or update a document but
maintain the original, too.

Figure 6.18: The AbiWord File Menu
Save, Save As, and Save Copy

Save is dimmed if there are no unsaved changes, and you won’t be prompted for a filename unless
you haven’t yet named the document or if you opened it with Open Copy.

Save As always opens a File dialog box and prompts you for a new name. When you next save the
file, AbiWord will save it under that name. Save Copy opens a file dialog box and saves under the
name you enter, but keeps the existing filename for the next Save operation.

New, Open, Save, and Save As are also available from the standard toolbar.

Tip Make your work documents group−readable but not group−writable to allow your coworkers to
read your work and continue it under a new name without accidentally overwriting it.
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Setting View Options for Productivity

Nothing in the View menu actually changes any of the text in your document, so it’s a good place to
start. Select Normal Layout to get rid of the gray areas around the edges of your document, and
select Zoom to Page Width to fit a whole horizontal line on screen at once. Before printing, select
Print Layout and Zoom to Whole Page to preview.

Figure 6.19: The AbiWord View Menu
Tip Can’t make up your mind if you want toolbars on or off? Use Full Screen (F11) to toggle

between a toolbar−heavy view and a sparse view with everything but the menubar suppressed.
Formatting

AbiWord has basic formatting commands you may recognize from other word processors. For
example, you can select some text, click the little B on the formatting toolbar, and get bold text. Or,
first click the little B and then type something—bold text, rejoice. Some formatting, such as font
selection and bolding, is applied character by character, and any changes you make will affect only
the currently selected characters or any new text you type. Other formatting, such as text alignment
and line spacing, is applied by par agraph. Changes affect the paragraph where the cursor is,
whether or not any text is highlighted.

You can get to the formatting commands in three ways: from the formatting toolbar, from the Format
menu, or by using the keyboard shortcuts, which are listed in the Format menu. Select Undo from
the Edit menu (CTRL−Z) to undo any format command.

Tip Single−spaced text in lines that span the entire page can be hard to read. Use the twocolumn
button on the Standard toolbar to break the text into two columns, or select double spacing
from the Extra toolbar, or select Paragraph from the Format pull−down menu.

Setting Tabs and Margins

The controls for setting tabs and margins are similar to those in other word processors. Drag the
two squares on top of the horizontal ruler to set the left and right margins, and drag the top left
triangle to set the indentation for the first line of each paragraph.

To set tab stops, drag them to the horizontal ruler from the tab box, which is to the left of the ruler.
Tabs can be left, right, center, or decimal aligned. You can drag tab stops along the ruler to move
them, or drag them off the ruler to clear them.
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Set the top and bottom margins by using the vertical ruler. You can also set the margins from Page
Setup on the File menu, which is the one exception to the rule that formatting items appear only on
the Format menu.

Using Styles

By applying a style, you can specify all the formatting for selected text in one step, instead of
separately selecting the typeface, size, boldfacing, and margins. This will add consistency to your
documents.

To apply a style, either highlight text already present or set the style for text you are about to type.
Next, select a style from the Style combo box at the far left of the Formatting toolbar, next to the
Font menu. You can modify styles or create new ones by selecting Style from the Format menu.

Figure 6.20: Some Possible Styles in AbiWord
Using SpellChecker

AbiWord does spell checking on the fly by default. If you see a wiggly red line below a word, right−
click it to see a spelling menu. If one of the suggestions on the spelling menu matches your
intention, select it to change the word and get rid of the red line. If you intended to type the word
that way and want to add it to the spelling dictionary, select Add.
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Figure 6.21: Some Possible Styles in AbiWord
To ignore a word in the current document only, without adding it to the dictionary, select Ignore All.

You also can spell check t he entire document by clicking the Spellcheck the Document button on
the standard toolbar, or by selecting Tools • Check Spelling • Spelling.

Tip To double−check a document, go to the Spelling tab of the Preferences dialog box and click
Reset to reset the list of ignored words.

Adding Links

You can make any selected text into a hyperlink that invokes Konqueror. If you have the extra
toolbar turned on (it can be activated by selecting Toolbars • View), click the little globe at the left
once you’ve highlighted the word or words that will be the link. If the toolbar is not displayed, select
Hyperlink from the Insert menu.

Setting Preferences

You can display a Preferences dialog box by selecting Preferences from the Tools menu. Most of
the options are self−explanatory; turn off features that you might not want hogging your screen.
Among other things, you can turn off the toolbars, rulers, and status bar individually, disable
on−the−fly spell checking, and suppress the initial AbiWord splash screen.

The Layout tab of the Preferences dialog box lets you turn on invisible layout marks, including tab,
space, and paragraph mark characters. This can be a good choice if you want to make sure you’re
applying a style to only one paragraph, or if you want to make sure you’re not typing extra spaces
by mistake.
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Chapter 7: Working with Graphics
This chapter addresses the standard KDE application KPaint and the third−party application
xscanimage, which is most likely already on your KDE desktop as part of your Linux distribution
bundle. If not, it can easily be acquired online. This chapter also touches on Kontour, KSnapshot (a
standard KDE application designed to capture screenshots), and the image viewers KView and gv.
Other image viewers and graphics applications may be included on your system, depending on your
version and distribution, but if you familiarize yourself with the ones covered here, you’ll find the
others work similarly.

KPaint

KPaint is an easy−to−use graphical painting program. To access it, go to the K menu, scroll to
Graphics, and choose Paint (or KPaint, depending on your version of KDE). You’ll be presented
with an introductory window.

Figure 7.1: KPaint Opening Window
The Toolbar

To get started, familiarize yourself with the toolbar, working from left to right.

Figure 7.2: The KPaint Toolbar
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The Page Icon

You can open a new drawing window with the page icon. You’ll be prompted to choose a numeric
window size in pixels. This is a complicated subject that we’ll address further when we talk about
image scanning. For now, all you need to remember is that images viewed on a monitor (think web
images) should render at 72 pixels per inch. Thus, for an image you want to be 4 inches wide by 3
inches tall, you’ll need a 288 b y 216 pixel “canvas.” You can resize your canvas later by choosing
Image • Resize from the pull− down Image menu above the toolbar. Note: when you resize the
canvas, any art you have already drawn will also be resized.

Tip KPaint is a bitmap drawing tool, meaning that you are drawing with pixels. If you scale up your
image, the program will increase the number of pixels used to represent what was formerly a
single pixel, resulting in jagged edges. You may like this effect, but you’ll most likely want to go
the other direction, i.e., start a bit bigger and then resize smaller to increase image crispness.

The Folder Icon

You can open an existing graphic using the folder icon by entering the path and filename in the
Location bar. The format of the graphic you are opening must be one that KPaint can read. The
accepted file types are listed on the Filter pulldown menu.

Tip KPaint can open TIFF files but may not show color correctly.

Save

It’s a good idea to save your file on a regular basis. Besides normal concerns of system locks and
power failures, KPaint does not have an undo or restore feature. So once you’ve altered a file,
there’s no going back. One work−around is to save your file regularly with another filename. This
harkens back to the bad old days when you had to develop the habit of toggling back and forth
between two or more saved files to ensure that you had a good copy, in case some cool effect you
added didn’t turn out as planned.

Cut, Copy, and Paste to the Clipboard

The cut, copy, and paste icons allow you to cut, copy, or paste your artwork to and from other
applications. Using the tool, drag the mouse around the area you want to cut or copy and select Edit
• Copy (or Cut). Use the paste icon to place the selection back into the image or into another
application.

Magnification

Use the percentage and magnify tools to set your view magnification manually or to zoom in or out
at set increments. Setting your view at 100% shows you how your art will look in print or on the
Web.

The Drawing Tools

KPaint includes two ellipse tools that draw ovals or perfect circles in a chosen color. You also can
draw in straight lines or use the rectangle or rounded− corner rectangle tool by clicking the shape or
line type, and then clicking and dragging the mouse on the canvas. The default colors are red and
green. Press the left mouse button to paint in red (or the color on the left) and the right mouse
button to paint in green (or the color on the right). To change default colors, see the section “Color”

124



later in this chapter.

You can spray colored pixels with the spray can tool or use the A−shaped Text tool to add words to
your image—but only in black. There is no color option with the text tool.

KPaint is a simple program; you cannot choose the brush size, text size, or font. If you need more
control, use The GIMP (see Chapter 8).

Copy and Paste within a Document

The little rectangular marquee allows you to select an area to copy or cut. After you have selected
the area, use the Edit pull− down menu to choose Cut, Copy, or Paste. Place the cursor at one
corner of the area you want to select and drag to the opposite corner. If you are satisfied with the
selection, go to the pulldown menu (Edit • Copy or Edit • Cut). To paste the item back into your
image, click on Paste in the Edit menu, and then go back to your image and position the mouse
cursor at the location where you want the item placed. Leftclick to paste the item (wherever and as
many times as you want). Left− clicking will keep pasting the item until you select another tool to
work with or select another item to copy or cut. You also can paste into a new document by
selecting Paste Image from the Edit menu.

Tip You can configure the toolbar to your liking; try playing around with Settings •
Configure Toolbar.

Color

The Color menu is to the right of the drawing area. You’ll see a thumbnail of your artwork, and
below that are buttons for two color choices (remember, you can toggle between them while
drawing by using the left and right mouse buttons). Below the color buttons is a pull− down menu
with some color swatch options. In the figure here, the web−friendly color swatch menu is selected.
If you click the left or right color buttons below the thumbnail, you’ll enter the Color Mixing Palette,
which allows more advanced color selection. Simply click the swatch where you see the color of
your choice, and move the arrow on the bar on the right up or down, until you see the shade you’re
looking for appear solidly in the box. If you click OK, that color will become the color for the left or
right button.
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Figure 7.3: Color Menu Icon
You can also add new colors to the Custom Color menu, which then appear on the Color Swatch
pull− down menu on the main KPaint window. Simply click the Add to Custom Colors button, and
you’ll see your chosen color appear on the custom color swatch.

The Color menu also allows you to enter HSV (hue/saturation/value), RGB (red/blue/green), or
HTML (RGB colors in hexadecimal format) numeric color equivalent manually. However, color value
and color space are subjects beyond the scope of this book. Images are created for different media,
such as monitoronly presentation software, the Web, or print. Each media works best with a
particular color space model. For most applications you are safe using the RGB color space for
images that will be viewed on a monitor, and the CMYK (also called process color) color space for
images destined for commercial printing.

Document Information

At the bottom of the KPaint window, you’ll find some useful information about window size, view,
current tool selected, and location of the file. Keeping an eye on this information will help you stay
organized.

Figure 7.4: Document Information Menu
Play around with KPaint and become familiar with the KPaint tools and menus. You’ll find it time
well spent when you move on to the much more elaborate, powerful, and exciting world of The
GIMP in Chapter 8. As an intermediate step, play with Xpaint, which is not part of KDE but may be
available on the Graphics menu, depending on your Linux distribution. Xpaint works a lot like
KPaint, but it offers a much larger range of options for color, patterns, brush size, and text insertion.

126



Figure 7.5: A Sample Drawing from KPaint

Scanning

Scanners allow you to take photos, slides, printed materials, or even paper− andpencil drawings
and import them into the computer in a format a graphical application can read. A number of
commercial and free scanning applications are available. Here we discuss the GNU utility
xscanimage.

xscanimage

Depending on your Linux distribution, xscanimage resides on the distribution menu (K menu • SuSE
• Graphic • Graphics • XScanImage) or under Graphics and then under the distribution name (K
menu • Graphics • Debian • xscanimage).

After selecting xscanimage, you’ll be presented with an introductory window.
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Figure 7.6: xscanimage Opening Window
The Preferences pull− down menu (Preferences • Advanced Options) provides further options.
However, depending on your monitor size and screen resolution, this menu window may be too
large to fit on your screen.

Figure 7.7: xscanimage Advanced Options
Eventually, you may want to try out the various options to see what they do, but in the meantime,
leave everything at the default settings except Scan mode and Scan resolution. Determine which
type of scan mode is appropriate: Lineart, Halftone (for drawings), Grayscale, or Color (for
photographs).

128



Figure 7.8: Scan Mode Options
Scan Mode Options

For pen−and− ink drawings, use the Lineart scan mode, which produces highcontrast,
black−and−white line images. You may need to adjust the Contrast settings to get the result you
want. In the figure here, Contrast is set to +58.

Figure 7.9: Example of Type of Artwork Appropriate for Lineart Scan Mode
The Halftone option creates an image composed of all− black pixels. Areas of light or dark are
created by using more or fewer black pixels. You may want to explore this cool effect for use with
low− resolution printing such as photocopies or newsprint.
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Figure 7.10: Output of a Color Photograph Scanned in Halftone Mode
For photos, choose Grayscale or Color, depending on what you need in the finished piece.

Figure 7.11: A Color Photograph Scanned in Grayscale Mode
Under Advanced Options, you’ll find settings for Gamma correction and Geometry. For general
purposes, you can safely leave Gamma correction and Geometry at their default settings. When you
are ready to learn more about gamma correction or scanning resolutions, check out some online
t u t o r i a l s ,  s u c h  a s  h t t p : / / w w w . c g s d . c o m / p a p e r s / g a m m a _ i n t r o . h t m l  o r
http://hem.passagen.se/harsman/gamma.htm
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Preparing to Scan

Before scanning, prepare a Save pathway for your file. Under Output Filename check the directory
pathname, which defaults to your home directory, and give your scan a name.

Figure 7.12: Check the Directory Pathway before Saving New Scan Files
End your filename with the three−character extension of the file type you want: for example, .tif for
TIFF or .jpg for JPEG format. Unlike applications on other operating systems you may be familiar
with, this program smart−saves based on the three−character format extension. This means it will
save in a format based only on the three−character extension; you don’t have to select a file type.

Tip If you are scanning more than one photo, be careful! Check the filename pathway before
you click the Scan button. If it’s the same as the previous scan’s filename, you’ll
overwrite that file.

While scanners come in several configurations, such as drum or slide, most office environments use
the more common flatbed scanner. Flatbed scanners look like desktop photocopying machines and
open from the top.

After cleaning the glass below the scanner lid (known as the plate), use the guides to position the
piece to be scanned on the scanner plate. Take care to line up rectangular items such as pages of
text, photos, or artwork that include straight lines with the edge of the scanner plate. Although you
may rotate scanned images later, with applications like The GIMP or Kontour, the results are
sometimes poor. Take time to ensure the quality of the resulting image prior to scanning.

Open the Preview window by clicking the button at the bottom right corner of xscanimage’s opening
window, and then click Acquire Preview. The scanner will conduct a prescan, and a thumbnail of
your image will appear in the Preview window. Next, use the cursor to select only the part you want
to scan, or go back to the xscanimage window and adjust your settings; keep clicking Acquire
Preview until you are satisfied.
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Figure 7.13: The Acquire Preview Window Showing Low−Resolution Version of an Image, So that
Necessary Adjustments Can Be Made Prior to Scanning
When you are ready, click the Scan button (located to the left of the Preview button). You will not
see scanning results until you actually open the image in a graphical application such as The GIMP.

Tip Clean up prior to scanning! Handle photos by the edges or with gloves. If you are using
a flatbed scanner, clean the glass plate with regular glass cleaner before scanning.
You’ll save valuable retouching time later.

Scanning Resolutions

The xscanimage program has a default resolution of 300 dots per inch (dpi), and you can decrease
or increase the dpi value from 12 to 1,600. The higher the number, the larger your image will be,
both in terms of system resources required to render it and in actual dimensions on the screen. If
your image will be viewed only on a monitor as part of a presentation package (or on the Web), and
you are happy with the original size, scan at 72 or 96 dpi. In the world of computer monitors, there
are 72 or 96 dots per inch on the screen, depending on whether your computer is Mac− or PC−
compatible. Either way, you’ll be fine working with 72 dpi images. If you need a larger image, scan
at 144 dpi or more. The resulting graphic will still be 72 dpi, but it will be larger than the original on
the screen.

If your image is intended for commercial print, things get a lot more complicated. Ink− on−paper
printing technology uses a measure called lines per inch (lpi). The rule of thumb for images intended
for commercial printing is this: lpi x 2 = dpi. Set your scanning resolution to acquire an image at
least four times bigger than you want it to be on the printed page. For images that will be viewed
only on a monitor, scan at a one−to− one aspect ratio, or larger than oneto− one if you want a small
image to appear larger on the screen.
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Moire Patterns

Moire comes from the French language, meaning an irregular wavy pattern in fabric. Moire patterns
occur when you scan something that already includes a halftone screen, such as a printed image.
Printed jobs are usually set to print as little dots on the page. Color is represented by dots of cyan,
magenta, yellow, and black. Because the dots are so small, your eyes will mix the colors so that you
see a continuous range of color and not just colored dots. The press operator at the printer’s will
use a different screen angle for each ink to form a nice rosette pattern of colored dots, which helps
the eye mix the dots into perceived colors. Look at a photo in a magazine with a magnifying glass,
and you’ll see what we mean.

When you scan a printed page, the screen angles won’t match. The rosette pattern will be visible in
your scanned on−screen image, and if you send it to a printer this way, you’ll end up with a messy
final result. There are ways to lessen this problem using The GIMP, but in general, don’t scan
printed images. You’ll be safer legally as well.

Kontour

KDE comes with an Adobe Illustrator clone called Kontour (formerly known as KIllustrator). Kontour
is a vector drawing application. In other words, images you see on the screen are calculated
mathematically by the application, resulting in perfectly smooth edges and text. This is especially
important if your document is intended for traditional printing on paper. The GIMP, as you will see in
Chapter 8, works with images as collections of individual pixels and is the right application to use for
paint effects or photographs. Kontour is also right for working with text or geometric shapes.
However, you can work with both, and bitmapped images from The GIMP can be imported or
placed into Kontour documents.

Getting Started with Kontour

Access Kontour from K menu • Office • Kontour. You’ll be presented with an introductory screen.

Tip If you can’t find Kontour under Office on the K menu, type kontour in the Run
Command dialog box.

Here you can open an existing Kontour document, a recent document, or a new document. You
even can open files formatted for XFig (.fig), MS Office (.msod), or Windows Metafile (.wmf) as
templates.
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Figure 7.14: Opening Kontour
Open a new file, and you’ll see a drawing window with tool options down the left side, and file, view,
copy, and paste options across the top.

Figure 7.15: A Kontour New Document Window
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The toolbar has tools for drawing freehand lines, Bezier paths (see the discussion on Bezier tools in
Chapter 8, under “Smart Selection”), various geometric shapes, text, and text on a path. You also
can import clipart or bitmap images into your document. Use the Layers tab to organize your work.
You can set individual layers to be hidden, to print, or to be the current working layer.

If you are familiar with Adobe Illustrator, note that Kontour includes some of the same features but is
much less sophisticated overall. Experiment with the tools, remembering that the right button on the
mouse provides access to further options and preference settings.

Grab ‘n Go with KSnapshot

Perhaps you need to include a screenshot for a presentation, user documentation, or a website.
KSnapshot allows you to capture screenshots of all open windows on your desktop or of one
specific window.

First, set up the windows you want to capture on your desktop. Next, access KSnapshot (K menu •
Graphics • Screen Capture). A pop−up window will show a small thumbnail image and two buttons,
Grab and Save. Review the directory path and filename, and add the three− character extension of
the file format you desire, for instance, .png, .jpg, or .bmp. If you don’t change the filename,
KSnapshot defaults to PNG format, names the screenshot “snapshot1.png”, and saves this
screenshot to your current directory. Pressing Save will capture an image of your entire desktop in
its current state.

Figure 7.16: The KSnapshot Window
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For more control over a screenshot, check the box for Only grab the window containing the pointer
box. Next, click Grab, and the KSnapshot window will vanish. Now, click within the borders of the
window you want to acquire. Use the Delay option to allow a few seconds’ pause before the
screenshot capture. You’ll need this option, for example, if you want to grab a pull− down menu in
action. This feature works exactly like a timer on a camera.

Figure 7.17: The Delay Option Allows Capture of Fluid Menus in Transition
When the Grab operation is complete, the KSnapshot window will reappear. A small thumbnail
image of the captured screenshot will be displayed in the viewing window. Make any necessary
changes to the directory path and filename, and then click the Save button.

Figure 7.18: Review the Pathway before Saving

KView

Sometimes you may need to view or alter an image, but you don’t need all the bells and whistles of
an application like Kontour or The GIMP. KView is designed for this purpose and is included with all
versions of KDE. KView allows you to place an image on your desktop’s background, adjust
brightness, transform the image, or conduct a slide show of multiple images.

Getting Started with KView

Access KView, sometimes called Image Viewer, from the K menu (K menu • Graphics • Image
Viewer).
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Tip KView can also be opened by typing kview filename on the command line. To open all files in a
particular directory, type kview *. See Chapter 13 on using the command line.

Figure 7.19: Opening a File from the Command Line
Here we have an image of Larry Ewing’s famous Tux the Penguin, the Linux mascot image created
in celebration of the Linux 2.0 kernel.

Figure 7.20: Tux the Linux Penguin
Tip KView defaults to a short window. Resize it by dragging the window’s corner tab.

Playing with KView

A limited number of View, Transform, and Filter options are available from the menubar. Here we
have chosen Transform • Flip vertical.
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Figure 7.21: Oh Ye Flipping Tux!
If you love your image so much that you want to see it every day, you can make it your KDE
desktop background via the Desktop pull−down menu.
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Figure 7.22: Creating a Tiled Desktop with KView
If you change your mind, go to the KDE Control Center’s Look & Feel options to remove the
background image. See Chapter 11 for more details on customizing your desktop.

KView provides a few simple options for adjusting image brightness and gamma on the Filter •
Intensity menu. You also can covert your image to grayscale and blur the image via Filter •
Grayscale or Filter • Smooth.
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Figure 7.23: The Smooth Filter Run Several Times on the Tux Image
You can sort or otherwise reorganize all open files under the Images • List menu (KView allows you
to view only one open image at a time).
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Figure 7.24: The List Menu List Options
The menu option Slideshow scrolls through each open file in sequence. Choose Settings •
Configure Kview to adjust slideshow interval settings.

gv

This useful application does not come standard with KDE, but it is in such common use that it may
be available on your desktop via K menu • Graphics • Viewers • GV or by typing gv from the Run
Command dialog box. gv is a PostScript file viewer. It is used to open, view, and print .ps
(PostScript) or .eps (Encapsulated PostScript) files. Choose File • Open to open a PostScript file.

Figure 7.25: The gv Open Menu Window
Tip These days, a lot of EPS−formatted files include a TIFF−format preview. This allows

users to view a thumbnail of the image before opening the actual file. The gv
program will not open EPS images that include a TIFF preview. Instead, an error
message dialog box will appear in the gv window. If you encounter an error message
dialog box when opening an EPS image, request a version of the file with the
Preview selection set to None.
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Chapter 8: More on Graphics: The Gimp

Overview

The GIMP, which stands for the GNU Image Manipulation Program, is an open−source program
comparable to the popular Adobe Photoshop application. Both Photoshop and The GIMP are huge
applications, with many features that can take years to master. Covering The GIMP is a
book−worthy project in itself; in fact, several excellent books have been written on the subject.
Check out Grokking the GIMP by Carey Bunks, published by New Riders Press, or the invaluable
The GIMP Manual by Karin and Olaf S. Kylander, available online at http://gimp.org/ or in printed
form as GIMP: The Official Handbook from The Coriolis Group. The http://gimp.org/ site includes
FAQs, cool effects you can download and use, and samples of artists’ work to inspire you.

The GIMP, like Photoshop, is a bitmap application. In other words, it uses pixels to represent colors
and shapes. Use The GIMP to create your own original works of art using various painterly effects
and tools, or manipulate, retouch, and otherwise alter photographic images you have scanned into
your computer. You can even create animated banners and buttons for the Web.

This chapter doesn’t explore the whole range of GIMP possibilities, but it does examine some
simple basics that will allow you to retouch photos, add text, and otherwise jazz up images with
special effects. If you keep working with The GIMP, you may eventually become a GNUexpert!

Getting Started

For those who have worked with Adobe Photoshop previously, The GIMP will be both familiar and
strange. The user interface for The GIMP looks at first exactly like Photoshop, but some of the
options are different. The GIMP also makes heavy use of the right mouse button. Many menu
options that appear at the top of the screen in Photoshop are available via a quick right− click in The
GIMP (including Save). This takes a bit of getting used to, but it is quite convenient once you’ve
developed the habit.

To launch The GIMP, go to the K menu, and scroll to Graphics (or your distribution’s name). The
GIMP will appear under the subheading Graphic or under the distribution name (for instance,
Debian).

Tip You can launch The GIMP directly from the command line or a Run Command box
simply by typing gimp.

The GIMP’s opening screen will load, and a tip of the day will appear, after which you’ll move into
the application space itself. Version 1.2 of The GIMP has the added feature of opening with
whichever menus you left open the last time you used it. If you close all the menus when you’re
finished, it will open with only the toolbar visible.

142



Figure 8.1: When You First Launch the GIMP, You’ll Be Presented with a Toolbar

The Toolbar

All of the tools on the toolbar are also available with a right− click of the mouse anywhere within an
open image, so you may find that you don’t need the toolbar to be visible at all times.

File and Xtns

First are the basic File and Xtns menus. From File, you can open files or access dialog boxes,
where you’ll find the Brush, Pattern, Palette, and Gradient menus. These menus allow you to
choose brush size and type, color, and gradients, and all are very intuitive. If you select Acquire
from the File menu, you can use The GIMP to take screenshots as well. This works in almost
exactly the same way as KSnapshot (see Chapter 7). The Xtns menu provides access to extension
and module menus. These are for creating effects and are meant for advanced users. It is probably
best to leave all of them at their default settings. The ever−popular Script−Fu (more about Script−Fu
later) and direct web links to GIMP resources are also available from the Xtns menu.

Color Menu

Figure 8.2: Selected Foreground and Background Colors Shown in the Color Menu
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At the bottom left of the toolbar is the Color Selection menu, where selected foreground and
background colors are visible. Click the arrow icon to toggle foreground color to background color
(the defaults are black and white). Double− click either color to open the Color Selection menu and
choose a new color. Here you can scroll through a rainbow− colored bar to select a hue range. Click
within the large hue range window to select a color tone, or manually enter or adjust HSV
(hue/saturation/value) or RGB (red/blue/green) colorvalue numeric equivalents.

Tip Painting tools in The GIMP draw in the foreground color, and the background color is the color
of your canvas. When you move selected areas or use the erase tool, the background color
appears. Click the arrow icon in the Color menu to toggle between foreground and background
colors.

Dialog Menu

Figure 8.3: Dialog Menu
The Dialog menu located at the bottom right side of the toolbar allows for quick access to the Brush,
Pattern, and Gradient menus, and it also provides a thumbnail that shows which brush, pattern, and
gradient is activated for your reference

from the toolbar. If you select something other than the default for any of these three, that change
will be reflected in the Dialog menu icon on the toolbar.

Access the Brush menu by clicking on the top left block in the Dialog menu icon.
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Figure 8.4: Brush Menu
The Brush menu is used in conjunction with the pencil, paint, and ink tools to control the thickness
and type of strokes these tools make. Click on the top right block to reach the Pattern menu, but
remember that the icon changes to reflect the active pattern.

Figure 8.5: Pattern Menu
Likewise, the rectangular box on the bottom shows the current gradient, and clicking on it activates
the Gradient menu.

Figure 8.6: Gradient Menu
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Tip Double−click on any tool to access its Option menu. The Option menu allows you to adjust the
settings for the tool.

Tip If you let your mouse pointer hover over any tool, a small box will appear telling you what the
tool is.

Selection

Figure 8.7: Selection Tool Icons
Three selection marquee tools allow you to select a rectangular, circular, or freehand area within
your image. These selection tools may be all you need in some instances, but for more control, you
may want to move to the following set of more intelligent selection tools.

Smart Selection

Figure 8.8: More Advanced Selection Tool Icons
Next we have the fuzzy selection, Bezier curves, and intelligent scissors tools. When you want to
grab parts of an image, manipulate, scale, distort, move, or color− correct only a portion of your
image, The GIMP provides these selection tools, offering a range of simple to precise control.

Click within a photograph with the fuzzy selection tool, and the tool will select similarly colored
pixels. You can increase the “fuzziness” of the tool in the Options window. With a fuzziness setting
of zero, The GIMP will search for pixels of the same color as the one you select by clicking within
the image. Increase the fuzziness setting to allow The GIMP to search for an increasing range of
color density from the selected pixel—for instance, not only black, but also a range of grays. The
higher the number in the setting field, the more grays will be selected.

Leave the anti−aliasing radio button on for all selection tools. The antialiasing setting allows The
GIMP to blend areas of high contrast a bit at the edges, which reduces the jagged edge you would
see in a strictly black−and−white pixel halftone image. The Feather option allows any selection to
have a partially transparent edge, for a blurry effect. The Sample Merged option is used only in
multiple−layered files, where the current layer includes a layer mask or a setting other than Normal
and allows for pixel data from subsequent layers to be included in the selection.

The Bezier tool works a bit like a pen and is the most precise tool for selecting areas within an
image. With it, you can draw curves with editable splines (the lines that appear as you drag the
cursor about the selection area with the Bezier tool and anchor points) around shapes for more
precise control. This tool takes a bit of practice, but it will be familiar to previous users of any
vectordrawing application, such as Adobe Illustrator or Kontour. If you don’t have such experience,
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practice some, and you’ll get the hang of it. Keep in mind, however, that you can’t add or subtract
anchor points (which look like small blocks) like you can in Adobe Photoshop.

Once you’ve roughed out a shape by clicking around the image area you want to select, click the
first anchor point again to close the shape. Next, position the cursor over an anchor point, click, and
lines will appear. You may use these to pull the spline between anchor points to curve around areas
for complete control of your selection. Press the CTRL key to reposition anchor points, or press the
SHIFT key to change an anchor point from its default soft corner to a sharp one. When you are
satisfied with your spline and anchor point placements, click inside the closed shape to turn it into a
selection. If you want to select everything else in the image, right− click and choose Selection •
Invert to select everything but the outlined image area.

With the intelligent scissors tool you can “draw” around areas of high contrast within the image. This
area then becomes the selection when you click inside the created shape. You can use the tool’s
Options menu to set the selection sensitivity and convert your selection to Bezier curves. You’ll get
other selection options by right− clicking and choosing Select.

Move, View, and Crop

Figure 8.9: Move, View, and Crop Tool Icons
The next set of tools allows you to move an entire image or a selection within the image, increase
(by left− clicking the image) or decrease (by pressing the

SHIFT key) view magnification, or crop the image.

Move literally means to shove a selected area or the entire image within the image window. The
background color or subsequent layers will then appear beneath the moved selection.

Cropping allows you to focus on only the part of the image you want to work with, discarding the
rest. Click the Crop tool button, then drag the mouse so that the area you want cropped appears in
the square. You will see a window called Crop Information, which gives you the dimensions of the
cropped area. If you click the Crop button, you will be left with only the selected area of the image.
The rest will disappear.

Transform, Flip, and Text

Figure 8.10: Transform, Flip, and Text Tool Icons
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The transform tool allows scaling, rotation, shearing, or perspective scaling of a selected area or the
entire image. The perspective scale allows you to stretch and compress parts of the selection to
give the illusion that elements of the image are closer or farther away from the viewer.

The flip tool flips the image on a horizontal or vertical axis. These settings are available in the
Options window.

The text tool allows the addition of words to the graphic. Use this tool only for large−sized text, a
small amount of text, or text in images intended for onscreen viewing. Fonts loaded on your
desktop’s X server will appear in the Font menu. The text will be drawn in pixels, not in
mathematically defined curves as with a word processor or vector application. If you need perfect
text clarity or have a lot of text to add to your image, save your GIMP image in JPEG, TIFF, or EPS
format and import it into an application such as Kontour or OpenOffice, which handles text and
drawn elements mathematically rather than as collections of pixels, resulting in perfectly smooth text
edges. If you do choose to place text directly within your GIMP image, make sure you are using
PostScript Type I fonts, because non−PostScript fonts will not scale correctly. Check with your
system administrator to ensure that only PostScript fonts are installed on your system.

When you click the text tool in the drawing space, a window pops up with options for font, font size,
spacing, and so on. The text will be colored in the foreground color currently selected. Type the text
in the space provided at the bottom of the window. When you click OK, the text will appear in your
image as a selection. When you click anywhere else in the image, or with another tool, the text will
become part of the image. We’ll discuss layers, but keep in mind that it’s a good idea to type text on
its own layer.

Color Picker, Bucket, and Gradient

Figure 8.11: Color Picker, Bucket, and Gradient Fill Tool Icons
The color picker tool looks like an eye dropper and selects colors from the image. The foreground
color on the Color menu becomes the value of the pixel clicked with the color picker. This allows
you to choose a color from within an image and paint with it.

The bucket tool acts like a spilled can of paint. It fills a color range with the foreground color. Use
the Options menu to set the opacity, threshold (the sensitivity of the selection), or type of fill. You
can also fill your canvas with one of the patterns available from the Pattern menu by selecting
Pattern Fill on the Options menu.

The blend tool creates a gradient blend in whichever direction you click and drag the cursor, either
for the whole image or within a selection. Use the Options menu to select the type of gradient and
whether it blends from foreground to background color, or repeats in a wave form (useful for making
cool metallic blends), or does something else.
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Pencil, Paintbrush, Eraser, and Ink Tools

Figure 8.12: Pencil, Paintbrush, Eraser, and Ink Tool Icons
The pencil, paintbrush, and ink tools draw in the foreground color. Choose a size and type of brush
to use from the Brush dialog menu. Note that the ink tool is a new tool, beginning with version 1.2 of
The GIMP.

Tip The Dialog menus are also accessible from the File menu or by right−clicking on an image and
selecting Dialogs from the pop−up menu.

The pencil and ink tools draw with a smooth edge (even if you select a fuzzy−edged brush). The
paintbrush tool paints with a softer, more brushlike edge. The eraser tool erases (leaving the
background color). Use the Eraser Options menu to set a hard or soft (incremental) edge.

Tip On the Brush menu you’ll find choices to change not only the type of brush you can paint with,
but also the opacity of the paint. Experiment with the different options to see all the possibilities
for drawing or painting.

Airbrush, Clone, Convolver

Figure 8.13: Airbrush, Clone, and Convolver Tool Icons
The airbrush tool works like an airbrush and you can set the rate and pressure from the Options
menu. This tool is handy for hand−painting shadows or blending areas of color. There also are Filter
and Script−Fu options for creating dropshadows and similar effects.

The clone tool allows you to clone a part of the image with either a pattern or an area within the
image. This is an invaluable photo− retouching tool. Double− click to set Options; then press CTRL
and click the image to select the area you want to clone. Next, click and drag to the area to be
retouched. Add hair, remove blemishes or scratches, give someone two noses—you can do it all
with the clone tool.

The convolver tool allows blurring or sharpening of pixels. Blur works by equalizing the color values
of adjacent pixels in the area being blurred. Sharpen does the opposite. The GIMP creates higher
contrast between pixel colors, which helps the sharpened area pop out from the rest of the image.
Both effects can be accessed through the Filter menu (right− click and choose Filter; then choose
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either Blur or Enhance). Use the Options menu for the convolver tool to adjust Blur and Sharpen
pressure settings.

Dodge and Burn and Smudge Tools

Figure 8.14: Dodge and Burn and Smudge Tools
These tools are new additions to The GIMP that allow you to create further effects with your images.
The dodge and burn tool is for adjusting the brightness or shade, and is especially useful for
working with over− or under−exposed photographs. Switch between dodging and burning with the
Options menu.

The smudge tool does exactly what you would think—creates a smudge wherever you click and
drag using that tool.

Finally, Let’s Work with The GIMP!

Click File • New to create a new file. Set the dimensions of your canvas ( remembering that there
are 72 pixels per inch), the color space (either RGB or Grayscale), and the base background color
of your painting space. Background and Foreground provide a space in whatever background and
foreground colors currently are selected in the color menu (defaults are black and white). White is
self−evident. Transparent provides an empty color space; a gray− checkered pattern indicates
transparency. Choose White while you are first learning the painting tools and effects. As you
become more familiar with The GIMP, you’ll find the Transparent background color to be the more
useful option.

Figure 8.15: A Blank Window Appears When You Select File - New
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Layers

Figure 8.16: The Layers Menu
To open the Layers menu, right− click the drawing window and choose Layers • Layers & Channels.
The Layers menu allows you to add or delete levels of painting surface. This can be helpful when
you want to put elements into their own unique space. You can create new layers by clicking the
icon at the bottom that looks like a duplicated page. Double− click the layer’s name to enter a new
layer name. Delete a layer by clicking on the trash symbol.

Figure 8.17: Organize Work By Giving Each Layer a Name that Makes Sense to You
You can set individual layers to be fully or partially transparent. As you become a GIMP expert,
you’ll learn how to mask selected areas to show elements through one layer to the next.

If you click the Channels tab, you can work with individual color channels for red, blue, or green.
This is a complex subject we won’t address here, but it’s helpful to know that, with a bit of additional
research and practice, you can gain complete control over your image’s elements and color space
by manipulating layers and channels.

Open a blank drawing window in The GIMP (File • New) and experiment with the various painting,
selection, and transformation tools until you feel comfortable with them.
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Figure 8.18: Play with the Various Drawing and Painting Tools to See How They Differ from Each
Other
Retouching Photos

To round out our introduction to The GIMP, let’s open a sample photo and practice retouching it to
improve image quality. Here we have a photograph of Linux evangelist and guru Eric S. Raymond
and Linux Journal publisher Phil Hughes taken at the 2000 Annual Linux Showcase tradeshow. As
you can see, lighting conditions were less than stellar, and this photo needs a lot of work.

152



Figure 8.19: Photograph that Needs Retouching
Crop

First, use the Crop tool (right− click and choose Tools • Crop, or select the crop tool from the
toolbar) to focus in on the central figures of the photo.

Figure 8.20: The Crop Tool in Action
Levels

Next, let’s take a look at the Levels menu (right−click and Image • Colors • Levels).
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Figure 8.21: The Levels Menu
By moving the white triangular tab that adjusts brightness levels over to the edge of the black
histogram shape, we already have done a lot to increase the readability of the photo. The Auto
Levels option will adjust the levels of your image automatically, but it’s not recommended that you
use this feature unless you’re in a rush. It’s better to control the image yourself.

Figure 8.22: Adjust the Triangular Controls to Alter Image Brightness
Curves

Image brightness and contrast can also be adjusted using the Curves menu, which is accessed by
right− clicking and choosing Image • Colors • Curves. In some ways, Curves works like Levels but
allows a different type of control over image brightness and contrast. Drag the line up or down from
the middle or add one or more anchor points, and drag them around to tweak brightness, color
levels, and contrast. You can also adjust both levels and curves on individual color channels. If you
look on the Channels tab in Layers & Channels, you’ll see that each color within your current color
space has its own channel: R for red, G for green, B for blue. You can gain a great deal of control
over the image color by manipulating levels or curves on individual color channels. Save the
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Channels options for when you’ve acquired GIMP expertise.

Figure 8.23: The Curves Menu
Note There is a setting for adjusting brightness and contrast on the Image menu, but no

selfrespecting designer uses this feature much. Levels and Curves provide much finer control
over the image. As you can see, simply adding two anchor points to the curve line and
dragging them up and down slightly to form a gentle S shape makes the photo cleaner,
crisper, and easier to read.

Figure 8.24: Manipulating Brightness and Contrast with Curves
More Retouching

Suppose we now want to remove some of the background clutter from the photo. There’s a person
in the background who isn’t adding anything to the overall content of the photo (sorry, Gretchen!).
We can use the free−hand selection tool (the little lasso) to select the background area and either
delete or fill it, but for this image let’s use the finer controls of the Bezier selection tool to separate
the boys from the background.
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Figure 8.25: Tracing around Eric S. Raymond with the Bezier Tool
Tip For better results, you may want to use the Bezier tool at more than 100 percent magnification,

(right−click and choose View •• Zoom In, or use the Magnify tool to increase the view).
When you’ve worked your way around the chosen selection area, click the first anchor point to turn
the outline into a selection. Next, right−click and choose Select • Invert to change the selection to
include everything but the main figures.
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Figure 8.26: Selecting the Background Area
Now let’s create a motion blur on the background using the Blur filter. Right− click and choose
Filters • Blur • Motion blur. We’ve chosen a 45− degree angle and a blur of 37 pixels.

Figure 8.27: The Blur Menu
You may want to use the convolver tool to fix the edges between the motion− blurred area and the
main focus of the image.
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Figure 8.28: Motion Blur Results
Filters

Take some time to experiment with Filters. You’ll find a full range of fun things to try, from the
aforementioned blurring options to edge detection, lighting effects (oooh, Super Nova!), artistic
“painterly” treatments, and more. Select only a bit of your image to play with. Filters are
resource−heavy, and it may take an inordinate amount of time to render the entire image.

Script−Fu and You

With Script−Fu, multiple effects that you can use individually under Filters have been cooked
together into one script you can open or play with on an existing image. The GIMP comes with
some preset Script−Fu options, or you can download others from http://www.gimp.org/ (this site also
includes Script−Fu tutorials worth checking out). Access Script−Fu from the Xtns menu or by right−
clicking the image and choosing Script−Fu. The former option provides access to precreated
images. These Script−Fu files don’t apply to currently open images; they are images supplied with
The GIMP that you may use as is or as part of your own creations. Script−Fu options from the right−
click menu affect the current image or a selected area within the image, allowing you to add cool
special effects to your own artwork.

Figure 8.29: A Preset Image Opened from Xtns - Script−Fu
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Figure 8.30: A Script−Fu Effect Applied to Our Image
Scanning from The GIMP

If the xscanimage plug− in has been added to your GIMP configuration, you can access
xscanimage directly from the Xtns menu by choosing Acquire Image. If this option is not available to
you, talk to your system administrator about adding it.

At this point, we’ve given you a small taste of what’s possible with The GIMP. As always, to learn
more, try the tools, open the menus, and play with the results. Remember to save your test image
under a different filename. Then, if you hopelessly break your image, you can always go back to the
original version.
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Chapter 9: Communication: Working with Email,
Usenet News, and Faxes
Using the computer on your desk, you can communicate with people inside your office and around
the world. Email, short for electronic mail, is the transmission of messages over a communications
network. The messages can be anything from a quick note to a business plan, complete with
supporting files (graphics, documents, and so on). Correlated with email are newsgroups and
Usenet, a worldwide distributed discussion system similar to the Internet, in which discussion
groups (newsgroups) are classified hierarchically by subject. In this chapter, we discuss KMail, the
KDE email application, as well as how you can access Usenet groups. In addition, a few faxing
applications are discussed, offering you one more way to communicate with the world from your
desktop.

KMail

The KDE mail client, KMail, is a user−friendly, graphically oriented email program. You can use it to
send and receive messages, as well as sort and organize them. KMail aims to present an intuitive
interface, so the functions you will need are easy to find and implement. To access the
comprehensive documentation included with KMail, select Contents in the Help menu, and you will
see a hyperlinked document in Konqueror, open to the table of contents.

You can launch KMail from K menu • Internet • KMail.

Tip If KMail has an icon on your K panel, simply click it to start. (See Chapter 11 to learn how to
build icons.)

Figure 9.1: Launching KMail
Your inbox may have been initialized already by the system administrator, with the settings entered
for your personal account and access information. If it hasn’t, you will need to set it up yourself (we’ll
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get to that procedure in a second). Until the inbox is initialized, the Mail Reader window (the main
window of KMail) will open, but it won’t show any messages, and you will be asked to complete the
configuration.

Figure 9.2: The KMail Window
Configuring KMail

To configure your mailbox, select Configuration from the Settings menu.

Figure 9.3: Configuring KMail
Enter your personal information and mail settings by selecting them from the menu panel on the left
side of the KMail Configuration window:

Identity: who you are.• 
Network: Internet setup.• 
Appearance: fonts, colors, layouts, profiles, and address book.• 
Composer: defaults for creating messages.• 
Security: GNU Privacy Guard (GPG) encryption settings.• 
Miscellaneous: other message and mailbox preferences.• 
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Identity

The Identity tab is where information about you is stored. You must fill in your full name and your
email address. Optionally, you can set the organization name and a reply−to address, as well as a
signature.

Figure 9.4: Configuring Identity
Tip A signature is appended to messages you send and may contain alternate contact information

or some other descriptive information.
If you want to access more than one email account with KMail, you will need to set up multiple
identities, one for each account. Fill in the default identity with information for the account you use
most often; create additional identities by clicking the New button. You can also use the Rename
and Remove tabs for existing identities.

Network

Next, select the Network tab, and specify the technical details of mail transfer necessary to send
and receive mail. Most likely, this will already be set for your machine by the system administrator. If
it’s not, your system administrator will provide you with this information and advise you which
options to select.
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Figure 9.5: Configuring Network Settings
On the Sending Mail tab, specify the protocol for sending mail that you have been given. A protocol
is the agreed−upon format for transmitting data between two devices. In this case, it’s the method
the computer uses to send and receive email. On the Sending tab, add an account for incoming
mail. Click the Add button to bring up a window where you can enter the type of account you will
have. Local Mailbox, POP3, Sendmail, SMTP, and IMAP are some possibilities. These protocols
are determined by your network administrators or your ISP, so consult them to find out what to
select. Click OK and fill in the account details. With this completed, along with your account name
and password, you should be able to view your inbox and get started sending and receiving mail.

Tip If your system administrator set a value for Enable Interval Mail Checking (on the Add

Tip Account protocol screen) and filled in a value, don’t reduce this value to get your mail more
quickly. If everyone does this, the entire network slows to a crawl.

Appearance

The Appearance configuration has several sections that allow you to customize the way KMail
presents the mail reader window, folders, headers, and messages.
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Figure 9.6: Configuring Appearance
On the Font tab, you can specify the font name, size, and style (regular, bold, italic, or bold italic)
that will be used for the folder list, message body, message list, and three levels of quoted text.
Select the type of text you want to customize from the list, and then choose the font, size, and style.

On the Color tab, you can select custom colors for the background and all the types of text for which
you can configure the font, as well as the color of new messages, unread messages, URLs, and
followed URLs. Just double− click the item you want to change, and a window pops up where you
can select a new color. See Chapter 11 for a full discussion of how to select colors on the desktop.

Tip Make sure your background color differs from every other color choice you make. If blue text is
printed against a blue background, it is effectively invisible.
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Figure 9.7: Specifying KMail Layout
On the Layout tab, you can check off options that configure additional presentation possibilities. The
folder list normally appears in two−thirds of the Message browser window, but you can choose
Show long folder list, so that it displays from the top all the way to the bottom of the browser
window. Other options allow you to display message sizes in the message header frame or enable
threading in the list of message headers. Threads are visual cues to the order in which messages
were answered, clarifying the sequence of events.

The Profiles tab allows you to pick a style for the overall visual appearance of KMail. The High
Contrast option, for instance, is for the visually impaired.

Composer

The Composer configuration allows you to write your own default response texts. When you reply to
a message, the quoted message body is prefaced by a short description, such as “On 12 January
2002, you wrote:.” You can change these phrases from the Phrases tab. Simply enter the correct
code for the message you want to use from a list that appears at the top of the Phrases section. The
general phrase will pick up the specific bits of information from each message as you reply. For
example, if you select as your message, “On %D, the evercharming %F told me:” this will become,
“On Friday 24 May 2002 06:00, the ever− charming Pete Doe told me:” in your actual reply to Pete.

165



Figure 9.8: Composer Options
Composer options also allow you to use smart quotes, append your signature to each message you
send, sign your messages with GPG, and wordwrap line ends.

Tip Smart quotes are not standard ASCII characters and may look funny on other people’s
mail programs. Save them for desktop publishing.

From the MIME Headers tab, you can set up custom MIME message header tags for your outgoing
email. You can invent new headers with informational content or overwrite the headers that KMail
creates, a feature that may be useful for advanced users.

Security

In the Security configuration panel, you can select the appropriate settings for encrypting your
email, so that it cannot be read in transit from your system to the recipient’s, or by anyone else who
has access to your email account. Email sent through the Internet is either encrypted (encoded) or
in clear text (as you wrote it). If it’s clear text and your message is intercepted, the content is
available to any reader.
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Figure 9.9: Security Settings
One type of encryption is called GNU Privacy Guard (GPG). KMail will invoke GPG for you with one
click on the Security options window; it’s an option under Select encryption tool to use. If you select
GPG and receive a GPG−encrypted message, you will be able to decrypt and view it right inside
KMail. Once you have set up GPG, you will find it a useful and easy−to−use tool. If you want to
encrypt an outgoing message, all you have to do is click the lock button on the Composer window
toolbar.
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Figure 9.10: Selecting GPG Encryption
Setting up GPG and encryption keys is beyond the scope of this chapter and definitely a procedure
recommended for advanced users. For a brief description of how to set up GPG and encryption
keys on your system—with system administrator approval of course—see Appendix C.

Miscellaneous

The last configuration screen is for miscellaneous KMail configuration options.
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Figure 9.11: Other Settings
Click the appropriate check box if you want to see a confirmation message before folders are
emptied, have the trash emptied when you exit the program, and so on.

After you set your network configuration, you should send a test message to yourself (see the
“Sending Email” section of this chapter to learn how). If you do not receive your test message,
check your configuration options or contact your network administrator.

Using KMail

Now that KMail is set up, you’ll be able to receive and send messages, begin an address book, and
perform lots of other useful tasks. Each time KMail launches, it opens to the Mail Client window, in
which you will see menu headings, a toolbar, and three frames (also called panes). The upper left
frame lists your current mailbox folders, and the upper right frame lists message headers. The lower
pane is for the message body or content.
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Figure 9.12: A Configured KMail Mailbox
Reading Email

Several options are available for viewing and organizing your email. By default, the new message
headers appear in blue, with unread message headers in red, and all other messages in black. The
message headers frame lists the subject, sender, date, and size of each message. If you click a
header, the message will appear in the large message frame below. If you click the header with the
right mouse button, a pop−up menu with more options will appear.

With KMail, you can reply, reply to all (if the original message was sent to more than one person),
forward, or bounce (reject) messages, as well as move them or save copies to one of your saved
mailboxes. All of these options are available in the Message drop− down menu. Some options have
shortcuts, such as pressing R for reply and F for forward. The shortcut keys are shown next to the
commands listed in the drop− down menu (see “Configuring K−Mail Shortcuts” in this chapter).

You can also use the icons on the toolbar to do things like delete messages (the red X icon) and
reply (the blue backward−facing arrow). If you want to change the order in which messages appear
in the header frame, click the Subject, Sender, or Date tab.

You can change the size of the tabs themselves or their order across the top of the pane. To
change positions, click a tab and drag to the left or right, then drop it. Notice that as you move the
mouse over the division line between tabs, the icon changes from an arrow to two vertical lines.
With this pointer, you can drag the edge of the column to the left or right, increasing or decreasing
the tab width accordingly.

Tip You can change the size of the frames in the same way as you can the tabs. Click the bar
between them and drag up or down, left or right.

Clicking the Subject tab changes the order in which the messages are listed alphabetically by
subject: ascending (A to Z) or descending (Z to A). You can also group messages in ascending or
descending order by message status: new, unread, and read. Each click on the Date tab changes
the sort order.
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Tip You may need to resize the KMail window to see the Date column in the message header
frame.

You can move among messages by clicking them in the message header frame, using icons on the
toolbar, or using shortcuts. If you want to select several messages in a row, you can click the first
message, and then hold down the

SHIFT key and click the last message. All of the messages from the first to the last will be selected.
To select additional messages individually, hold down the

CTRL key while clicking each one, so you can skip over messages you do not want to include. You
might want to select multiple messages to move them all to another folder or to delete them all at
once. Once they’ve been selected, drag and drop them into the chosen folder or choose an option,
such as Forward or Print, from the toolbar or menus. If you want to change the number of headers
that appear, go to the View menu.

Figure 9.13: Changing Header Display
Of the available options, All Headers shows the most information about a message and Brief
Headers shows the least. All the headers remain attached to your message, no matter which
viewing option you choose; this option affects only the display of your messages.

Folders are extremely useful for organizing your email, allowing you to group together messages
from the same person in one place, or to group together messages on the same topic, and so on.
Folders also help keep your inbox from accumulating hundreds of email messages, making it hard
to find anything. Default folders include one called inbox and another called outbox. You can create
additional folders at any time by opening the Folder menu and selecting Create.
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Figure 9.14: Creating a New Mail Folder
A pop−up box asks you to enter a name for the folder and decide if it should be at the top level of
the folder hierarchy or a subfolder of an existing top−level folder. If you are creating a folder to store
messages, or posts, from a mailing list or newsgroup, the Associated Mailing List tab in the pop−up
box allows you to enter the post address (the actual email address for sending posts to that mailing
list).

Here are some other hints for folders:

To move a message from the inbox to a folder, simply click it in the header frame and drag it
to the desired folder listed in the left frame.

• 

To see a folder’s contents, click it in the left frame, and it will open in the header frame.• 
To view any email that you have sent, open the Sent− mail folder.• 

Messages in KMail display URLs and email addresses as active links for either composing a new
email message to the linked email address or opening the URL in the Konqueror web browser. Just
click a link, and a new window will open. If you click a link with the right mouse button, a pop−up
window will appear with several additional options.
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Figure 9.15: Email or URL Action Menu
You can send a message to, send a reply to, forward to, add to the address book, or copy to the
clipboard any email address links you receive. With a URL link, you can choose to open the URL in
a new Konqueror window, or you can copy it to the clipboard for later use, either in a browser or in a
new email.

Sending Email

When you write a new email message to send, you compose it in KMail’s Composer window. Start
by opening a new message screen, as described earlier.

Figure 9.16: KMail Composer Window
As with KMail in general, the use of these features is intuitive. Specify your intended recipient’s
email address in the To: field; you can CC (or carbon copy) other addresses as well, in the CC:
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field. Next to each of these fields is a button that will open your address book, which you can use to
select a contact. (See the upcoming section “Using the KMail Address Book.”) Be sure to complete
the subject line, which describes the content of your email. In addition, if you have set up several
email accounts for different purposes, the submenu of the field next to Identity lets you select the
identity with which you want to reply. To enter the text of your email message, click in the large
space below the header fields and begin typing.

Figure 9.17: Composing a Message
If you want to include an additional file with your message, you can specify it as an attachment by
clicking the paper− clip icon.

Figure 9.18: Sending an Attached File with Your Message
The Attach File browser window will open to your home directory. From there, you can select the file
you want to send, changing directories as necessary. You even can drag a file into your Composer
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window from your desktop or another directory. The Automatic Preview option gives you a glimpse
of the files you are browsing, if the box is checked.

You can also manage your attachments with the Attach menu, which has options for removing
attachments you’ve already selected and for saving attachments.

Alternatively, if you want to include another file in the body of your message, you can do so by
selecting Insert File from the Message menu. A similar file− browsing window appears.

Figure 9.19: Including a File in Your Message Body
Only text− based files can be included successfully within the body of an email, so you should use
Attach or the paper clip on the toolbar if you want to send anything other than plain text.

Tip It’s almost always preferable to put large files on the Web rather than include them as email
attachments. Recipients who have a slow Internet connection can choose to view the
attachment later. And if you find a mistake right after sending the mail, you can simply fix it on
the Web instead of resending the whole attachment.

As you read your incoming messages, you’ll sometimes see a file icon in the message text; this
indicates that someone has sent you an attachment. KMail lets you specify how the attachments are
shown in the message frame with three options located in the View menu: Inlined, Iconic, or Smart
views.
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Figure 9.20: Attachment Viewing Options
Inlined attachments show up within the message, if the file is a type that KMail can show you
directly. Text files, HTML files, and image files suitable for web pages should be viewable with this
option. Iconic attachments appear first as a document icon with a filename. You must then click the
icon to open the file. Smart attachments attempt to determine the file type and are displayed inline if
possible, and as an icon if not.

When you click an icon for an attached file, a warning message appears.

Figure 9.21: Warning Message
This message warns that the attachment may compromise your system’s security. Attachments are
often the vehicle for transmitting computer viruses that can do great damage to both your computer
and any computer to which you are connected. A virus can even attack your address book and send
replications of itself to everyone listed. You should not open an attachment from somebody you do
not know, and also be careful with unfamiliar file types (the file type is part of the filename on the
icon). The options Save to Disk, Open, and Cancel accompany the warning message.

Tip Right−click on the attachment icon for a quick list of options.

KMail also includes a spell− check feature. To run it on the message you’re composing, click the
Edit menu and select Spelling from the bottom of the list. The KMail Spellcheck window will pop up,
and you can choose to ignore or accept the suggestions.
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Figure 9.22: KMail Spellcheck Window
The Ignore button skips any action on the word it suggests is misspelled. Replace implements the
correction right away. Ignore All and Replace All do the same thing every time that word is found in
your message. The Add button lets you add a word to the spell− checker dictionary. A status bar in
the spellcheck window lets you know how far the spell checker has advanced through the
document. Help, Stop, and Cancel buttons are also available. If the spell checker has no
suggestions for a word, that word does not appear in its dictionary, and the Replacement field
shows the word as is. You can edit the Replacement field yourself to specify any changes you want.

Explore the menus of the Message Composer windows for any option not covered here. A few
things to note: the View menu lets you add fields to the top of your messages; on the Options menu,
you can select notification of delivery; and the Edit menu offers Find and Replace options for
specific words or phrases that appear throughout the message.

Tip Clean Spaces in the Edit menu is a quick way to tidy up your paragraphs if the lines
are of widely varying lengths, but be aware that any whitespace formatting (such as
indenting with tabs) will be lost.

When you have finished composing your message, you can send it immediately, queue it to send
later, or save it in your Drafts folder to consider sending later. The first option on the toolbar (an
envelope with an arrow on it) will send the message; the second (a stack of envelopes) will queue it
to send later. When you’re ready to send drafts, click Send Queued from the File menu of the Mail
Reader window. You can delete a message you’ve composed by clicking Delete on the Message
menu or by clicking the little box with an X in the upper right corner of the window. If you decide to
cancel a message after text has been entered, a warning window will open to confirm that you want
to abandon the message completely, as your work on it will be lost.
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When you open a Composer window by clicking the Reply or Reply to All button (or selecting those
options from the Message menu), it comes complete with the recipients and subject already
specified in the headers, plus the quoted text of their message. Enter your reply above or below the
message, remove parts of the original message that don’t apply to your reply, and send the
message as you would a new message.

Using the KMail Address Book

The Address Book is a handy feature that stores a list of email addresses, among other information,
and it can save you the time and hassle of searching elsewhere when you need to send a message.
Launch the Address Book from the KMail File menu.

Figure 9.23: Launching the Address Book
To add people to your address book, select New Contact from the Address Book File menu, and the
Entry Editor window opens.
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Figure 9.24: Adding an Entry to the Address Book
You can store a lot of information for each entry by using all three tabs: General, for phone
numbers, addresses, etc.; Details, for assistants’ and spouses’ names, birthdays, etc.; and All
Fields, which allows you to add custom fields and to select a range of fields to view together.

To get rid of an old address, select it from the list in the top frame, and click the Remove button. If
you’ve made an error in an entry or a deletion, press the Cancel button. Finally, when you are
finished making changes, additions, and deletions to the address book, click OK.

Once you’ve added contacts to the Address Book, you can use it in a couple of ways. First,
whenever you’re starting a message, clicking on the button to the right of the To:, CC:, and BCC:
header fields will bring up a window with all of your contact names and emails. Simply click on the
name you want, and the information is filled in automatically.
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Figure 9.25: Selecting a Name from the Address Book for a New Message
A second way to use the address book is for the creation of distribution lists, which are groups of
email addresses included under an umbrella name and address, sometimes called an alias. Using
distribution lists saves you from entering the same names and email addresses every time you send
a message to the same group of people. It’s a particularly handy feature when working on projects
or on committees.

To create one, select Distribution List from the Address Book File menu, click the list, and enter a
name. On the next screen, highlight the contact names (in the lower window) that you want included
on that specific list. Click the Add Entry button, and the names will appear in the upper window,
which is the actual list. Buttons also are available for changing email addresses, removing individual
contacts, and deleting entire lists.
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Figure 9.26: Creating a Distribution List
When you are finished, the distribution list name will appear in the main address book window as
another available contact name.

In addition to being available in KMail, your address book and the contacts it contains are
accessible in other KDE applications, such as the various faxing applications and KOrganizer. You
can add, change, and delete entries and lists in the address book from any application that uses it,
and the changes will be made universally.

Other Features of KMail

KMail offers many ways for you to customize its use according to your preferences and habits. A
few of the more useful features are the toolbar, shortcuts, and search capabilities.

Configuring the KMail Toolbar

If you frequently use a feature that is not included on the standard toolbar, KMail has a handy
feature that lets you add it. On the Settings menu, select Configure Toolbars.
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Figure 9.27: Toolbar Configuration Window
The list on the left shows all the available options; on the right are the tool buttons currently selected
to appear on the toolbar. In the center are arrows pointing up, down, left, and right. For example,
say you want to add Quit to your toolbar. Start by selecting Quit from the list on the left, then click
the right arrow button, and Quit is automatically moved to the list on the right. If you want to change
the order of the buttons on the toolbar, select an action from the list at the right, click the up or down
arrow, and watch how the order changes.

Not all actions have a tool icon to the left of their description. You should not add an action without
an icon to your toolbar, as it will not have an actual button with which you can activate the
command.

Configuring KMail Shortcuts

Shortcuts, sometimes called key bindings, are sequences of keys that initiate menu or toolbar
actions without using the mouse to point and click. It is much quicker to use a keyboard shortcut
than a mouse− driven action if your hands are already on the keyboard, so if you have the shortcuts
for your most common actions memorized, you can finish your tasks in less time.

Many actions have a default shortcut already set. Here’s a list of KMail actions that also shows what
the tools look like.
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Some actions, like Unread (which marks a message as unread again), do not have a default
shortcut, but you can configure your own. In the Settings menu, select Configure Shortcuts.
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Figure 9.28: Key Binding Configuration Window
At the top of the configuration window is a list of actions that you can browse alphabetically. When
you have selected an action, specify None, Default (if one is not available, this item is unavailable
and dimmed), or Custom. If you select Custom, your mouse icon turns into the inserting text icon,
also called the I− bar. The button next to it will show the current shortcut (or none), and as you type
in your keyboard sequence, it will show the keys you’ve pressed.

If you want to exit without implementing your shortcut settings, click Cancel. You can save your
changes by clicking OK, or restore all the default shortcuts by clicking Default.

Searching through Your Messages

If you have a large number of messages and want to find one in particular, you can find it more
easily with the Search functions of KMail. Start by selecting Search Messages from the Edit menu.

Figure 9.29: KMail Search
The Search in Folders pop−up menu lists all of your mail folders, so if you know the message is in a
specific folder, you can search only there. If you’re not sure where the message is, you can select
the Search in All Folders option.
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You can search by the Subject, From, To, CC, or Organization header or by the complete message.
Click the pop−up menu next to Where under the folder choice. Then enter what you are searching
for next to the Contains pop−up menu, and KMail will look for messages that match your criteria.

Email with Netscape

Although KMail is the default email application in KDE, other options are available such as
Netscape Messenger, which is included in the Netscape Internet browser. If you choose to use
Netscape for email, open the Netscape browser. From there, click the Communicator menu and
select Messenger.

Incidentally, if you are using the Mozilla web browser and the mail client is installed, you can set up
your email account or accounts here in the same way you would with Netscape, which will be
described shortly. Mozilla was the original code name for the product that came to be known as
Netscape Navigator, and later, Netscape Communicator. Mozilla now refers to Netscape’s
opensource Internet software.

Figure 9.30: Opening Netscape Mail
The menus and toolbar are located at the top of the window, along with an indicator bar that keeps
track of your current action.

185



Figure 9.31: Netscape Messenger
The layout of Netscape Messenger is similar to KMail, with the Mail/News folder frame running
down the left side, the message header frame at the upper right, and the message content
appearing at the lower right. Much of the screen is activated by mouse clicking, as in KMail. If you
click the toggle box next to the Local Mail item in the folder frame, it will expand to show the
subfolders or collapse into a single line, conserving screen space.

Also, right− clicking will activate a pop−up menu of actions that you can access directly, instead of
having to click the toolbar or menus.
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Figure 9.32: Mouse−Activated Menus
The New Message window allows you to specify your recipients, attachments, and any other
message information through the menu options and toolbar items.
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Figure 9.33: Netscape Mail Message
To send and receive mail, you need to make sure that the right preferences are set for Netscape
Messenger. You can access these by choosing Preferences from the Edit menu. In the Preferences
dialog box, toggle the arrow (click it with the mouse) next to Mail & Newsgroups to access those
areas for review. Then click the subsection to view or change your settings. The preferences for
Identity, Mail Servers, and Newsgroups Servers are the ones that control your email and newsgroup
access and are the same as those for KMail.
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Figure 9.34: Netscape Preferences

Other Email Agents

Pine, Mutt, and Elm are a few of the text− based email programs available. While programs that
take advantage of a graphical user interface have the advantage of intuitive use, text− only
programs are popular as well. Keep in mind, however, that your mouse will not work to select or
send messages. Instead, you will need to become familiar with some keyboard commands and use
the arrow keys to navigate.

Start these mail programs by typing the program name (all in lowercase) on the command line in a
terminal window. (See Chapter 13 for an explanation of how to use the command line and terminal
windows.) The most frequently used keyboard commands are usually shown at the top or the
bottom of the screen, such as M for mail. The H or ? keys are often keyboard shortcuts to help for
these programs, and Q often will quit the program, taking you back to the terminal window’s
command line.

Usenet

As mentioned at the beginning of this chapter, Usenet newsgroups are used to exchange news,
information, data, and debate over the Internet. Ideally, newsgroup names are organized in a
hierarchical structure for easy access, but in practice, a group may be created and thrive outside of
that organizational structure. The group names in the formal structure are organized from general to
specific, separated by a period. For example, comp.os.linux.announce is for announcements
relevant to the Linux OS, part of the broader topic Computer.

These are a few of the other broad topics:
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News: information about Usenet news.• 
Talk: current issues and debates.• 
Soc: social issues, culture.• 
Rec: games, hobbies, sports, arts.• 
Sci: scientific topics.• 
Alt: anything; originally an “alternate” hierarchy.• 

Articles and messages are posted to news servers (computers that do nothing but handle
newsgroup data) and transmitted to other news servers to be read by anyone in the world. Posts
that generate follow−up feedback are called threads, as in a “thread” of conversation. Articles with
harshly condemning content are known as flames.

Each newsgroup has its own character and its own code of conduct, which may or may not be
explicitly stated. Some are very formal, and others are informal and chatty. Some allow criticism and
correction without censure, while others do not. If a group is moderated, that means a person or
group of people approves incoming messages before they are posted, to keep a topic on track and
the tone civil. Otherwise, the direction, content, and tone of a newsgroup are affected by anyone
who participates.

KNode

KDE’s default news reader is called KNode. You can find it listed in the Internet module of the K
menu.

Figure 9.35: The KNode Window
KNode and KMail are closely related, so you should recognize the toolbar and organizational layout.
The first time you open KNode, you may be prompted with the KNode Preferences dialog box. If
not, or when you want to configure KNode for personal use, select Configure KNode from the
Settings menu.

190



Figure 9.36: KNode Configuration
Here you can set up your identity, as well as state your newsgroup server and mail server. Your
network administrator should provide you with the newsgroup and mail server names. For KNode
you can configure rules for navigation, filtering, security, posting, and message appearance. The
configuration screens of KNode are very similar to the ones in KMail, so explore and customize until
you find a setup that works for you.

If you are not already subscribed to newsgroups, you can get started by selecting Subscribe to
Newsgroups from the Account menu.
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Figure 9.37: Subscribing in KNode
If there are no groups available, a dialog box will open to ask you if you want to fetch a current list.
Click Yes, and KNode will access the list of available newsgroups from your news server, which
may take a little time. An indicator bar at the lower left of the KNode window displays the status of
any activity requiring a download (such as downloading the list of available groups from the server
or downloading messages in a group).

The newsgroups carried by your news server are shown in a collapsible alphabetic listing on the left
side of the Subscribe to Newsgroups dialog box. You can scroll through the list with the scrollbar,
the PAGE UP and PAGE DOWN keys, and your keyboard’s arrow keys.

You can toggle a hierarchy to expand or collapse by clicking the small box with a + (plus) or −
(minus) sign to the left of the group name. A complete newsgroup name has a larger box to the left
of it that you can check or uncheck to subscribe and unsubscribe.

Figure 9.38: Selecting a Group
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Once you’ve subscribed to groups, the three frames that make up the KNode screen become more
accessible. You can collapse and expand the groups under your news−server icon in the leftmost
frame, select messages in the subject frame at the top right, and view the body of the articles in the
message view frame at the lower right.

Tip The application switches focus through the three windows of KNode and KMail when you
press the TAB key.

Figure 9.39: Using KNode
The KNode toolbar contains options to check the server for new messages, post an article or a
follow up to an article, read the next message, filter messages, or search for articles.

Tip As with KMail, you can configure the toolbar to show a custom selection of buttons with
the Configure Toolbar, on the Settings menu.

Once you’ve set up your news server and subscribed to some groups, whenever you want to read
newsgroup messages, click the news listing and select the group. Reading messages, replying to
them, and following threads work the same in KNode as they do in KMail.

The KNode manual accessed from Contents on the Help menu is quite comprehensive and worth
checking out if you plan to use newsgroups and Usenet.

Usenet News with Netscape

While KMail and KNode are separate applications for KDE, Netscape (and Mozilla) handle email
and Usenet access to newsgroups in a single application. You can set up news−server connections
on the Preferences menu (under the Edit menu). Again, if this information isn’t already set up,
contact your system administrator for help.
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Figure 9.40: News Preferences
To subscribe to newsgroups, select Subscribe from the File menu. This brings up the Newsgroup
dialog box, where you can find newsgroups in the alphabetical list of groups.
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Figure 9.41: Selecting Newsgroups in Netscape
It may take a while for all of the available newsgroup names to download from your news server. If
you are already subscribed to some groups, a purple check mark will appear to the right of the
group name. Find additional newsgroups from the alphabetical list, or click the Search tab to search
for newsgroup names that include your search text.

If you find a newsgroup you want to subscribe to, click the dot to the right of the group name. It will
change to a check mark, indicating that this is a group you want to consult from time to time. To
unsubscribe from a group, click the check mark, and your subscription will be disabled.

Once you have subscribed to some groups, you can see them listed in the folders pane, under the
heading News. Simply scroll and toggle through the groups to check for new posts, and reply, save,
or print, in the same way you would handle email messages in Netscape.

Faxing

Several faxing options are available in KDE, and each has different requirements and offers
different capabilities. In general, faxing applications all have compatibility and feature set limitations.
Because faxing is an important office task, brief descriptions of the programs available under KDE
are offered in this section. Faxing from your computer is one area, however, where you definitely
want to seek guidance from a system administrator, because phone lines and, more often than not,
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a fax server (back end) are involved.

K Send a Fax

K Send a Fax is a simple fax utility for use with the KDE printing system, enabling fax support for
virtually all KDE applications. K Send a Fax can be found on the Utilities module of the K menu; in
some versions it appears under the name Send a Fax or Kdeprintfax. This utility is intuitive and
works quite simply once it has been installed and set up by the network administrator.

To send a fax with K Send a Fax, you must provide the name and fax number of the recipient, as
well as the message body and filename to be sent. The pop−up screen where you enter this
information looks similar to KMail’s Composer window. Clicking the Add File icon opens a second
window to your home directory, where you can select a file to send or move to other directories to
grab the desired file to attach. Once you’ve added a file, complete the Fax Number, Name,
Enterprise, and Comment fields. Finally, click the Send Fax icon. If you make a mistake, click Abort.
If error messages are returned, click the View Log icon for a description of what went wrong.

Figure 9.42: K Send a Fax Main Window
Tip Remember that the entries you’ve added to your address book are available in all KDE

functions, including K Send a Fax.
KFax

KFax is part of the KDE graphics package. It’s a file viewer capable of displaying and printing all
common fax file formats (typically with the .g3 extension). It’s a viewing and printing application that
does not send faxes. It can be accessed from the Graphics module on the K menu in order to view
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and print faxes stored on your computer from any other fax application. For instance, if someone
emailed a fax file to you, you could open, view, and print it with KFax.

The application itself is fairly basic. Select the file you want to open, then view the fax page or
pages, magnify, or print as necessary.

Figure 9.43: Viewing a Fax in KFax
Faxing utilities is another area that KDE developers are continually working on, adding to, and
improving.
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Chapter 10: Accessing the Web

Overview

KDE offers many tools that you can use to browse the Web. In Chapter 3, you learned how to use
Konqueror as a file manager. In this chapter, the topic is using Konqueror as a web browser, along
with other browser possibilities such as Netscape and Opera. The focus is how to take advantage of
the many customization options Konqueror offers, so you can make the browser serve your needs
and preferences. At the end of this chapter, you will find a discussion of ways to create your own
web pages, using word−processing applications and Quanta Plus.

Before diving into web browsing, shortcuts, bookmarks, and so on, let’s go over a few basic terms
you should know to use the Web effectively and to understand the rest of this chapter. If you’re a
web− browsing pro, feel free to skip to the next section, “Konqueror in Detail.”

Internet: a decentralized, global network that connects millions of computers for the purpose
of exchanging data, information, news, opinions, and so on.

• 

Web: short for World Wide Web, a system of internet servers that supports specially
formatted documents.

• 

Web browser: a software application that displays web pages on your computer.• 
Website: a location on the Web owned and managed by a person, group, company, or
organization. It may contain a single web page or many files, graphics, and other
information, usually on a related topic.

• 

URI: Uniform Resource Indicator, the generic term for all types of names and addresses for
objects on the Web.

• 

URL: Uniform Resource Locater, the specific address for a web page on the Web.• 
IP address: an identifier code assigned to each computer and device on a network.• 
Domain: a group of computers and devices on a network that are administered together, for
example, mail.example.com and http://www.example.com/

• 

Network: two or more computers linked together.• 
HTML: HyperText Markup Language, the common language used to create documents for
the Web. Tags and attributes for elements such as headings, font size, and colors are used
to create documents that can be viewed by any web device or browser.

• 

Online: The status of your computer when it is connected to the network or the Web.• 
Protocol: An agreed−upon or standard method for transmitting data between two machines.• 

Konqueror in Detail

You’ve learned that Konqueror automatically opens to your home page when it launches. By
default, this is the file listing of your home directory, but the system administrator may have changed
it to another web page. Some offices set the home page as a company page. The address of the
website, or the URL, appears in the Location bar.

The Basics of Getting Around

Start your navigation by entering the URL, or address, of a website in the Location bar (something
like http://www.linuxjournal.com/ for example) and press ENTER. Notice that the left arrow above
the Location bar becomes active as you move to the new page. This is the Back button, and clicking
it returns you to the previous page. Now the Forward button, or right arrow, is active, and you can
click it to get to the second web page you visited.

198



Figure 10.1: Launching the KDE Browser to the Home Page
One of the great features of web pages is their ability to direct you to related material by the use of
hyperlinks. Hyperlinks are specially formatted words and images (image maps) that, when clicked,
automatically take your browser to another web page. You can usually recognize hyperlinks
because they are underlined by default and often appear in a differently colored font. You can also
spot both hyperlinks and image maps by moving your mouse pointer over them; if the arrow
changes to a hand, it’s a link.

Sometimes links open in a new browser window, but often your main Konqueror page follows the
link, and the original page is lost. You can usually use the back arrow to return to the previous page,
but this can take a long time (each page will load again). Plus, sometimes you can go back only so
far, and sometimes you may want to see both pages at once. In these cases, you will want to open
a link in a new instance of your browser, so move your mouse pointer over the link and right− click.
From the menu that pops up, click New Window. This will launch a new instance of the browser that
follows the link.

Links are primarily used to access other web pages, but they can also be used to access different
types of files, such as streaming audio and video, PDFs, and downloads. When you click a link to
one of these other file types, Konqueror will try to choose the proper application to open them. See
Chapter 11 for information on how to help Konqueror choose which application to use with different
file types.

If you need to stop the loading of a web page because it is taking too long, or you need to browse
elsewhere, click the Stop button. Konqueror loads text first and then images, so stopping a page
while loading will generally make the text of the page visible but show broken image links.

The Reload button (located next to the Stop button) is useful for checking whether a page (a news
or discussion site, for example) has been updated. It is also useful if you are developing your own
web page and want to see changes as you make them.
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Tip The marvels of the ALT−F2 Run box continue. It works much the same as the
Konqueror Location bar by launching Konqueror and displaying the web page of any
URL you enter.

If you stopped a page from loading, or if it did not load properly, you can click the Reload button to
try again. Reloading the page still may not display the page properly; this may be the result of poorly
written HTML, broken image links, or network congestion.

Getting to Know Your History

You learned how to use the Location bar and its AutoComplete feature in Chapter 3, and the Back
and Forward buttons were just discussed. Another option for navigation that Konqueror provides is
the Go menu.

Figure 10.2: The Go Menu
The Go menu maintains a list of up to 11 URLs: the current URL you are browsing and the URLs of
the ten pages you visited prior to this one. The page you are viewing currently will have a check in
the box next to it. To revisit one of the last ten URLs, open the Go menu and click the page you
want to visit. Unfortunately, the Go menu provides the title of the page, so if the website you are
visiting uses the same title for each page (like “Welcome to http://www.site.com/”), this feature will
not be too useful.

Searching the World Wide Web

Searches are a big part of web browsing, and people have different search preferences. Search
engines such as Lycos, Yahoo, and Google are popular sites you can visit to conduct a search. To
save time, Konqueror offers two shortcuts for web searching: internet keywords and web shortcuts.
Because they can help make your search more economical, let’s talk a bit about each.
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Internet keywords are words or phrases typed into the Location bar that redirect your browser to a
related site. Companies often pay for internet keywords to drive traffic to their sites with these
redirects. For example, you could simply type CNN in an empty Location bar and be taken directly
to http://www.cnn.com/ If Konqueror fails to match an internet keyword, however, it will automatically
use the search engine you have designated in the Configure Konqueror menu as the default (to be
explained shortly).

A web shortcut is a form of shorthand for requesting a web search of a specific topic on a specific
search engine from the Location bar. In Konqueror, the syntax for using a web shortcut is
shortcut:string, where shortcut is the abbreviation for the search engine and string is what you are
searching for. For example, if you want to search Google to find out more about Mars, you can type
gg:mars

in the Location bar. Konqueror will recognize your web shortcut and display the resulting matches
for Mars found by the Google search engine.

Figure 10.3: Enhanced Browsing
To configure your system’s setup for internet keywords and web shortcuts, go to Konqueror’s
Settings menu and choose the last option, Configure Konqueror. A list of icons will appear in the left
sidebar of the Configure menu. Click Enhanced Browsing. The right window will display two main
sections: Internet Keywords and Web Shortcuts.

The Keywords section includes a check box that enables the use of internet keywords, as well as a
drop− down box that lets you set the search engine of your choice as a backup, should the keyword
search return nothing. In other words, if you were to type a word in the Location bar that no one was
paying for as an internet keyword, your browser would direct you to the designated search engine.

If you disable internet keywords, the selected search engine will also be disabled. Unfortunately, if
the website that sponsors the specified internet keyword is unavailable, Konqueror does not switch
to the search engine backup.
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Figure 10.4: Using Shortcuts
A variety of shortcuts should be present already in the Enhanced Browsing window. To add a web
shortcut, you need to know how your favorite site turns your query into a URL. Google is easy; it
puts your search after ?q=. I f  you want to search for Linux, for example, the URL is
http://www.google.com/search?q=Linux That’s called a GET, and it’s the most common kind of web
search.

Other sites, such as the Linux Journal site, are trickier because they use a different type of form,
called a POST, that doesn’t put your search query in the URL.

You can almost always make a web shortcut for POST forms by faking them out with a query
embedded in the URL and making them perform a GET. Use View Source on the search form, and
look for the input tag that specifies the search box. It will look something like this (from the Linux
Journal site):

The name query is what we want. Just put it at the end of the URL of the search results page (not
necessarily the same as the URL of the search form) like this:

Finally, add the magical name \1. What does \1 do? Konqueror knows to replace it with your search
term. So the Search URI is

Now that we have the information we need, go back to the Configure Konqueror menu, select the
Enhanced Browsing dialog box, and click Add. Fill in the New Search Provider dialog box like this:
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Click OK. Then click OK again to leave Settings.

Now press ALT−F2 and type lj:kde. There’s your search result window, already full of KDE news
from everyone’s favorite Linux publication.

If you want to change a web shortcut, select the shortcut and click the Change button. Once you
have made your changes, click Apply, and then OK. You can test your changes by entering the new
shortcut in Konqueror’s Location bar. Web shortcuts can be disabled using the check box, but the
search engines will still be available in the Keywords section.

Setting a New Home Page

Changing what appears as your home page is probably one of the first things you will want to do
when you are comfortable using Konqueror. In a corporate environment, you will want to select the
home page that gives you the widest access to the internal documents you use most often. Many
companies set up a corporate page as the default home page for employees. For personal use,
think of the web page that provides the most entertainment or information for you. The goal is to
reduce the number of times you must enter a URL manually in the Location bar to retain access to
all the information you need. You’ll learn how to create a simple web page you can use as a
personal home page later in this chapter.
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Figure 10.5: Changing the Home Page
The process for changing your home page is a simple one that can be done at any time. Select the
Settings menu and choose Configure Konqueror. The Settings dialog box will pop up, and in the
middle of the right window, you will see a field titled Home URL. The default is ~, which is how your
computer thinks of your home directory. To change your home page, type the new URL,
remembering to keep the http:// in the Home URL field, and click OK. If you ever want to change
back to the default, you can click Use Default or type ~ in the Home URL field and click OK.

Using Bookmarks

If you are familiar with the idea of bookmarks from using other web browsers, skip to the next
section to learn how to import any bookmarks you might have already.

Like their real−world counterparts, Konqueror bookmarks are placeholders, allowing you to access
web pages rapidly without having to remember the URLs. Using the Bookmarks menu, you can add
and edit bookmarks at will and store them within folders, or submenus, and move them around so
they suit you best. Bookmarks were designed with ease of use in mind, and you will find that they
can be great time−savers. While you can access your bookmarks through Konqueror’s Bookmarks
menu, you’ll find that the Bookmark toolbar allows you to access your bookmarks directly on the
desktop. We’ll get to the bookmark toolbar shortly.

Creating Bookmarks

Before you can do anything fancy with your bookmarks, you must actually have some. Think of a
web page you visit often (or would, if only you could remember the URL), and go to it. For example,
if you have an interest in space exploration, you might go to http://www.jpl.nasa.gov/ which is a
NASA web page on the subject.
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Figure 10.6: Creating a Bookmark
Once the desired page is in your browser, open the Bookmarks menu (on the menu toolbar) and
click Add Bookmark. Selecting the Bookmarks menu again will display the NASA URL at the bottom
of the menu. Subsequent bookmarks will be added below the existing ones.

Planning ahead can save you a lot of time when it comes to locating the bookmarks you’ve created.
The Bookmarks menu has a New Folder option that is helpful for organizing them. Using this option,
you can place your bookmark in the appropriate folder, along with those for other related sites.
Creating a folder called News and adding only news− related websites will let you locate news links
faster and keep your main Bookmarks menu uncluttered. Unfortunately, you cannot move or delete
your bookmarks directly from the Bookmarks menu. For that you’ll need to open the Bookmark
Editor.

Tip Try to keep folder themes general; 20 folders for 21 bookmarks may provide more of a
hassle than a benefit.

The Bookmark Editor
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Figure 10.7: The Bookmark Editor
The Bookmark Editor is a simple application that lets you manage the layout and content of your
bookmarks. If you want to make any significant changes to your bookmarks, you will need to use it.
It can be accessed by selecting Edit Bookmarks from the Bookmarks menu (on the toolbar) once
you have launched Konqueror. The primary uses of the Bookmark Editor are to organize, rename,
and delete your current bookmarks. Additionally, you will use the Bookmark Editor when importing
or exporting bookmarks to or from other browsers.

Tip Remember that you must save any changes you make in the Bookmark Editor.

Organizing Bookmarks

The Bookmark Editor provides a few options to help maintain your bookmarks and keep them
organized. Like the Bookmarks menu in Konqueror, the Insert menu in the Bookmark Editor
provides the option to create a new folder. However, the Bookmark Editor also allows you to choose
where you want the folder. New folders will appear below whichever line you have selected in the
editor window with your mouse pointer.
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Figure 10.8: Creating a New Folder
You can move both folders and individual bookmarks using the drag− anddrop feature. Select the
item you want to move, and hold down the left mouse button. Move the mouse pointer to the
intended destination and release. Remember that changes must be saved before they will become
apparent.

Figure 10.9: Adding a Separator
The Separator bar is another option for organizing your bookmarks. Select a bookmark somewhere
in the middle of the editor window, and click Insert Separator on the File menu. A red, white, and
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blue bar will be inserted into your list of bookmarks. Once you save your bookmarks, go back to the
Bookmarks menu in Konqueror, and you will see the thin separator line you added.

Tip If you are using the bookmark toolbar, do not use separators.

Separator bars are an easy way to set apart bookmarks visually. The ability to add separators,
combined with the abilities to create folders and move bookmarks, allows you to arrange and
organize your bookmarks in the most convenient way.

If you prefer basic organization, like bookmarks arranged in alphabetical order, select the bookmark
folder you want to adjust, and select Sort Alphabetically from the Edit menu.

Editing Bookmarks

Suppose you accidentally delete a bookmark; can you get it back? As with other areas of
Konqueror, Undo and Redo buttons let you reverse any changes you have made since you opened
the Bookmark Editor or since you last saved your work. This is a very important point to remember:
you must save your work to see it in Konqueror, but doing so disables the Undo and Redo buttons
until you make new changes that have yet to be saved.

When you add a bookmark, the default value for the bookmark’s name is the title of the web page
you are bookmarking. Often these titles can be very long or not particularly useful, and renaming
them to something easier for you to remember will make them much more useful. In addition,
should the URL associated with one of your bookmarks change, you can make the alteration by
selecting Change URL in the Bookmark Editor.

Figure 10.10: Changing a URL Association
Many ways are available to rename your bookmarks, all of which are simple and intuitive. The
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simplest way is to double− click the name or URL of the bookmark, which will make that area
available for editing, then enter a new name or URL. When you have renamed the bookmark, either
press ENTER or click the mouse somewhere away from the bookmark to get out of Edit mode.
Remember, you have to save your changes before they appear in Konqueror.

If you are in the Bookmark Editor and want to open a bookmark directly, click Open in Konqueror in
the Bookmarks menu of the Bookmark Editor, and you will launch a new instance of Konqueror
open to that bookmark. This is helpful because it allows you to view changes to your bookmarks
before you save them.

Each bookmark on your list probably has an icon next to it. Many of these icons are set
automatically by their respective websites; they’re often the logo of the site or company. Changing
the icon associated with a bookmark is another easy way to set apart visually a subset of
bookmarks. To do this, click the bookmark and select Change Icon either from the Edit menu or
from the menu that appears when you right− click. The Filesystem icons are the defaults to choose
from, but you can adjust the icons you see by changing the category in the dropdown box at the
upper right.

Figure 10.11: Changing a Bookmark Icon
If the icon you want to use is not among the available options, select Other Icons. This will enable
the Browse button and let you navigate your directories to find the icon you want to use. If you need
a review of how to navigate your directories, see Chapter 3.

When you find that you’re overrun by bookmarks, many of which you no longer use, it’s time to
clean house. You can delete a bookmark, or folder containing multiple bookmarks, simply by
selecting it and pressing the DELETE key. If you have not yet clicked Save after deleting a
bookmark, you can click the Undo button to bring it back.
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Importing and Exporting Bookmarks

For users of the Netscape or Mozilla web browser who are moving to Konqueror and already have
bookmarks, the Bookmark Editor allows you to import your existing bookmarks instead of manually
recreating them. Open the File menu and select Import Netscape Bookmarks or Import Mozilla
Bookmarks, and Konqueror instantly will bring over your existing bookmarks.

Figure 10.12: Importing Bookmarks
You can choose to add the imported bookmarks to the ones already created in Konqueror, or you
can replace your existing Konqueror bookmarks entirely. Once you have imported your bookmarks,
remember to save. And don’t worry; your bookmarks will not disappear from the other browser.

Figure 10.13: Imported Netscape Bookmarks
Exporting your bookmarks from Konqueror to Netscape or Mozilla is as easy as importing and only
one click away. Open the File menu and select Export to Netscape Bookmarks or Export to Mozilla
Bookmarks. There will not be any confirmation, but you can launch the other browser to make sure
your bookmarks arrived. If you have your Netscape browser open when exporting bookmarks from
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Konqueror, Netscape will warn you that your bookmarks have changed and ask if you want to
reload them; say yes. Exporting bookmarks does not mean they disappear from Konqueror.

Konqueror also allows you to access bookmarks in Netscape without importing them. On the
Settings menu, select Show Netscape Bookmarks in Konqueror Windows. This will place a check
mark by the option. Click the Save button, and open the Bookmarks menu in Konqueror. Just below
New Folder, you will notice that a new section for Netscape Bookmarks has been added. You will
not be able to edit, move, or delete your Netscape bookmarks through Konqueror or the Bookmark
Editor using this option, however, because your Netscape bookmarks are still in Netscape.

The Bookmark Toolbar

The bookmark toolbar is located at the top of your browser window, with all the other toolbars, and
is dedicated solely to bookmarks. A few steps are necessary to set up the bookmark toolbar, but if
you regularly visit the same sites, it is quite useful. You can make it appear by choosing the Show
Bookmark Toolbar option in the Konqueror Settings menu. If you have not created any bookmarks,
a large, empty toolbar will appear beneath your Location bar. If your Bookmark toolbar is empty, but
you have already created some bookmarks, then you have not selected a toolbar folder.

Figure 10.14: Setting the Bookmark Toolbar
To select a toolbar folder, launch the Bookmark Editor. Within the main window, select the folder
that contains everything you want on your toolbar, then click Set as Toolbar Folder in the Edit menu.
This option is available only if you have selected a Folder icon. Once you save, your Bookmark
toolbar will refresh to show any changes.
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Figure 10.15: Setting the Toolbar Folder
When using the bookmark toolbar, it is important to remember that separators should be removed
from your toolbar folder in the Bookmark Editor, as they will clutter the toolbar. This comes at the
expense of the visual−aid separators offered in the Bookmarks menu. Additionally, items appear in
your bookmark toolbar in the same order as they appear in your toolbar folder—you cannot have
the two in different orders.

Using Plugins

Some websites use file types that are not known to your web browser (Flash or Shockwave files, for
example). Often, they will have a link from which you can download an application known as a
plugin to read this file type. When these files appear, click the link, follow the download instructions,
and install the application, which will automatically associate itself with the file types it can access.
Many times office users do not have the permissions needed to install plugins, so be sure to consult
your system administrator.

By and large, using plugins provides more enjoyment of the Web because they allow you to access
more types of files. You may find, however, that due to your browsing habits, you are always being
forced to turn on plugins you could get by without. Because plugins take up space on the hard drive
and in the memory, having a lot of plugins may slow down the entire machine.

Konqueror provides a basic on/off check box for plugins. In Konqueror’s Settings menu, click
Configure Konqueror, and select Konqueror Browser from the pop−up menu. The fifth tab of this
Konqueror Browser menu is titled Plugins, and it provides a simple check box for enabling or
disabling plugins. The default allows plugins and, if you do not have any specific plugin problems,
can be left alone.

The Netscape Plugins section of the Configure Konqueror menu, back on the vertical Settings
menu, gives you several options for managing any Netscape Plugins you may already have. You
will notice that this area is divided by two tabs: Scan and Plugins.
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Tip When downloading a new plugin, it is unlikely that you will find one specifically for

Tip Konqueror. Install the Netscape version, and then click Scan Here.

Figure 10.16: Scan for Plugins
The main window on the Scan tab displays the directories from which Konqueror currently is
accessing your Netscape plugins. It is unlikely that you will need to make any changes, as these are
the default directories Netscape uses. You can click the Scan for New Plugins button if you have
added any new plugins to Netscape and want Konqueror to take full advantage of them. While you
can enable Konqueror to scan each time KDE restarts, it is not necessary if you do not add new
plugins to Netscape with any regularity.

The primary use of the Plugins tab is to show which plugins you have and with which file types they
are associated. While you do not need to change anything here, if you are ever asked if you have
access to a particular plugin, this is the place to look. You might find it easiest to ask which
extension the file type uses to see if you have a plugin for it. Extensions are normally three
characters and are easy to spot in the main window. They are also called suffixes, for example,
.sdw or .pdf.

Saving Web Pages and Images

The Web is full of information and images that you will want to keep for later reference. Although
you can set bookmarks for easy access to websites online, you need to save them to your hard
drive to access while offline or in case the site or page comes down. Konqueror allows you to save
websites and images to your hard drive in the same way you save a regular file.
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Figure 10.17: Saving a Web Page
Go to the web page you want to save to your hard drive. Once there, open the Location menu and
select Save As, which will open a dialog box. You will see that the filter is set to HTML files, and the
location is the name of the web page you want to save. If you like, you can alter the name of the
web page and save it as a file, as you learned in Chapter 3. Doing this will save the page itself to
your hard drive, but images are files of their own and, unless they are embedded in the page, will
appear as broken links in your local copy.

Figure 10.18: Saving an Image
Saving images from the Web to your hard drive is equally easy. Find the image on the web page,
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right− click on it, and select Save Image as. The image will be saved to your hard drive in the usual
manner.

To open the files you’ve saved on your hard drive, follow the same procedures you learned for
regular files back in Chapter 3. Click the Location menu, select Open Location, change directories
to the one containing the file, and click OK. The page or image will be displayed.

Tip New for KDE 3.0 is the Archive Web Page option under the Tools menu. It’ll save selected
web pages quickly and easily.

A word of warning: when a web page displays images, it looks for them in a specific place, based on
the pathname listed in the text file. This pathname most often reflects where the images were stored
on the website. Therefore, you may need to change the pathname in the web−page file to reflect the
path where the images are stored in your directory.

Printing a Web Page

Printing information from the Web is a common and useful task. You learned about printing in
Chapter 3, and printing web pages is no different from printing anything else. Open the page
containing the information you want, and select Print from the Location menu or click the Print
button on the toolbar.

A dialog box will appear that lets you choose the correct printer to use and adjust the number of
pages that will be printed. The Properties button leads to a small menu where you can change the
page layout from portrait (vertical) to landscape (horizontal).

Should you want to see the web−page information in plain text (source text) instead of HTML,
simply right− click a web page, and a dialog box will come up that contains the option View
Document Source.

Figure 10.19: Viewing the Source
Some sites use frames, which means that what you are seeing is multiple pages that have been
“framed” to look like one page. You often see this where a scrollbar exists independently of the main
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window on a site. For these sites, when you select the View menu, you will notice that View Frame
Source has been enabled. View Frame Source will display only the text in the frame of the site that
contains your mouse pointer. View Document Source, however, will display the text for the entire
page and all of its component frames.

Other Options

With KDE 3.0, Konqueror adds a few new web options that can be found on the Tools menu. These
options include Translate Web Page to and from the various listed languages and Validate Web
Page to confirm that a page meets WWW standards, which is useful if you write anything that will be
viewed on the Web.

Customizing Konqueror

Konqueror offers many ways to customize its appearance and functionality, based on individual
preferences and needs. A single area within Konqueror has been designed for managing most
aspects of its operation, the KDE Control Module. You can access it from the Settings menu by
choosing a submenu titled Configure Konqueror. Selecting this option actually launches the Settings
module. Apart from allowing you to adjust your home page, search engine, and plugins, as you
have already learned, this module also lets you adjust the way that your browser displays links and
fonts, interacts with Java, and manages cookies from the sites you visit.

Figure 10.20: KSettings
Konqueror Browser Setup

Selecting Konqueror Browser from the list of icons in the column on the left will change the right
window. Five tabs are displayed: HTML, Appearance, Java, JavaScript, and Plugins. We have
already covered plugins in this chapter, so let’s talk about the rest.
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HTML

The HTML section provides basic management options that control how Konqueror interacts with
hyperlinks, style sheets, and other items. (Style sheets are parameters for page layouts, including
font size, page size, and the like.) The default setting will change your mouse pointer to a hand
when it is over a link within a web page. The link itself will become underlined at the same time.
Some people choose to have either the mouse pointer change shape or the links be underlined, but
not both. As you become more familiar with browsing, experiment to see what feels most
comfortable to you. If you find you are having trouble identifying links by the default settings, go
here to make links always appear underlined.

Figure 10.21: Configuring HTML
Image files are larger than plain text files, and they can slow down the speed with which Konqueror
can load a page. If you are interested in loading image−heavy pages quickly, consider unselecting
the Automatically load images option. Once you apply the changes, an icon will appear in your main
toolbar that looks like a drop of red, blue, and green paint with a green plus sign in its lower right
corner. Now, loaded pages will display images as empty boxes. If you want to load images on the
specific page you are browsing, clicking this icon will reload the page with images. Using the Reload
button will load the page without images once again.

Tip Automatically loading images may be nice, but it can increase the time it takes to load the
page.

Style sheets allow you to create web−page layout preferences that will override a website’s own
design. This can be handy in an office where people share computers. Say five people who have
different preferences as to how the browser should display a web page take turns using the
browser. Each can select a particular style sheet, instead of adjusting the individual settings when it
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is that person’s turn to use the browser. The creation of style sheets, however, is beyond the scope
of this book. If you find that you rarely or never change your settings, then creating style sheets is
probably unnecessary for you.

Appearance

The Appearance section allows you to set default information about how fonts are displayed in
Konqueror. The size of the font is defined by a number, and the style of the font is defined by its
style name. The Font Size section of Appearance is not an absolute setting for your system; it is
relative and depends on the specifications of the sites you visit. This means that if you choose
Medium, the size displayed will be whatever the website tells your browser to display; it simply takes
the website’s font as is. Experiment with different fonts to find something that allows you to view
pages comfortably.

Figure 10.22: Configuring Appearance
Java and JavaScript

Java and JavaScript are programming languages that build applets and embedded code and allow
web developers to make their web pages more detailed. They also introduce some security issues.
Konqueror defaults disable Java across all sites and enable JavaScript. You can adjust the settings
based on your security concerns, but these are mostly the concerns of your system administrator.

Cookies

Cookies are little files stored on your computer’s hard drive that websites use to manage information
about your visit to their sites. Cookies are often feared because they allow a website to track some
information about you, but if you take an active role in their management, cookies can enhance your
browsing quite a bit. Cookies allow a site to remember you from one visit to the next or to maintain
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your information while browsing a website. You will want to consider what information is being used
and who is using it when you decide how to interact with cookies. Konqueror provides great
flexibility in managing who you allow to put cookies on your hard drive, as well as giving you a look
at what information is being stored in the cookie.

Figure 10.23: Setting Cookie Policy
Cookie Policy

The first thing you need to decide is whether you want to allow cookies. If you do want to allow
them, leave the Enable Cookies option selected. Otherwise, unselect it to disable the use of cookies
entirely. Disabling cookies will disable the Policy tab, but it does not affect cookies already on your
hard drive. Skip ahead to the next section, “Cookie Management,” to learn about any cookies
already on your hard drive.

The simplest option for cookies, other than disabling their use, is to accept them by default. This
option allows great ease of use, as any site you browse that uses cookies can leave one on your
hard drive. By design, then, that site interacts with you differently based on your previous visits,
without any further interaction required on your part. Recognize, however, that accepting cookies by
default also means that you have no control over who puts a cookie on your hard drive. Visiting one
site might result in multiple cookies not only from the site itself, but from advertisers and third parties
as well. Some advertisers, for example, can collect information about the sites where you have
collected their cookies and develop a demographic model based on your web− browsing habits.
This model can then be used to target you for specific types of advertising. This is not to say that
any advertisers or websites owned by the same parent company are using cookies for this purpose.
However, it is important to realize that you, the user, are an important commodity to the site you are
browsing.

Tip Be aware that while you interact with a site, it is also interacting with you.
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A third option for your cookie policy lets you control which sites you allow to leave cookies on your
hard drive. With this option, you will be asked each time you go to a new site whether to accept or
reject a cookie. How you answer determines your ongoing policy for cookies from that site.

Tip If the domain asking to give you a cookie is not the one you are trying to visit, it is probably an
advertiser.

As you allow or deny sites the use of cookies, you will find each site added in the Policy window.
The site will appear in the Hostname column, and your policy will appear in the Policy column. To
change or delete your policy for one of the hosts in your Policy window, select the hostname and
click the Change or Delete button. To add a policy without visiting a site, click the Add button and fill
in the appropriate information. If you do not include “www” before the period preceding the
hostname, your policy will be effective for that entire domain.

Cookie Management

The Management tab gives you information on the cookies from domains where you agree to
accept them, either by default or by confirmation. There are two columns in the main window, one
listing the domain that gave you the cookie and one listing the name of each cookie. By default,
multiple cookies are collapsed under each domain heading. Click the plus symbol next to the
domain to expand the entire list of cookies. When a domain is selected, it is displayed in the Domain
section of Cookie Details. Selecting an individual cookie from that domain will fill in the remaining
fields in Cookie Details. This gives you the chance to see exactly what a site is storing in its cookie.
Some of the values will appear garbled because they are encrypted or make use of codes known
only to the site.

Figure 10.24: Managing Cookies
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Crypto

The Crypto section of the control module is where you manage things like certificates and the
Secure Socket Layer (SSL). Certificates are attachments to electronic messages that provide some
assurance that you are dealing with the machine you think you are communicating with. SSL is a
protocol used to securely transmit information between machines over the Internet. When you enter
into a secure connection, the little lock on the Konqueror toolbar will appear locked. Unless you
understand what you are doing and the ramifications of selecting or unselecting individual ciphers,
leave the settings at their defaults. Think of ciphers as codes your computer uses to talk to other
computers during a secure transaction.

Figure 10.25: Configuring Crypto
Tip During a secure transaction, the lock symbol on Konqueror should appear locked.

User Agent

The user agent is a string of text your browser sends to a website to identify itself. By default,
Konqueror’s user agent string looks like this:

This tells the website to treat Konqueror as though it were a Mozilla 5.0 browser, and if it has
problems with Mozilla, to then treat it like Konqueror or X11. The reason for passing Mozilla initially
in the user agent is to provide the greatest chance for compatibility with the website. It is the sad
truth that some web sites are not designed using the proper standards. If you find that a website is
not rendering properly, changing the user agent might make it interact with you differently and clear
up the problem. Currently, Mozilla is more widely recognized in website development circles than
Konqueror.
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Figure 10.26: Configuring the User Agent
To add or change a user agent, first enter the web address in the When Connecting To field. This
can e i ther  be the speci f ic  URL (www. examplecompany.com) or  the ent i re domain
(.examplecompany.com). Now you can either select a user agent string from the drop− down box
for Send User Agent String, or you can type your own. The list provided has a wide variety of
options, but let’s create a new one for this example:

Now you can create an alias that will appear in t he list of user agents available in the future,
something like KonqOnLinux.

Next, click Add to add this user agent to your shortcuts and to the list of available user agents. You
will need to apply these changes as well.

Other Applications

Now that we’ve covered how to use Konqueror as a web browser, and all the ways you can
customize it to make it most efficient and comfortable, let’s briefly look at a few other applications
that relate to the Web: file transfer protocols and other browsers.

FTP and KBear

File Transfer Protocol (FTP) is the standard protocol used for uploading and downloading files on
the Internet. If you are familiar with FTP, KBear’s interface is self−explanatory. If not, KBear comes
with some great help files to get you started. Be forewarned that KBear will have trouble if you are
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using an FTP proxy. An FTP proxy is a computer on your connection, located between yours and
the one with which you are trying to exchange files, that lets the other computer think it is your
computer. Such a proxy, or stand− in, might be desirable for security reasons. These are mostly the
concerns of system administrators; check with them before making changes. The KBear software
package is compatible with KDE. If it is not installed on your system already, you can download it
from http://kbear.sourceforge.net/

Netscape

Netscape Navigator is a web browser that works well with KDE, but you might experience the odd
display issue or problems with compatibility between the Netscape and KDE clipboards. Netscape
should be located under the internet module on the K menu. To configure Netscape, open the Edit
menu and select Preferences.

Opera

Opera is a relatively new web browser, known for its speed, standards compliance, and small size.
You can download a free, adware version (meaning there’s a permanent, revolving advertisement
on the menubar) and install it within a few minutes, if you have superuser access on your machine.
If not, talk to your system administrator. Everything you have learned about Konqueror in this book
translates well to Opera, and it is worth checking out. It is extremely quick, considering the number
of features available. Opera has a retail version that disables the ad field present in the free version.

Figure 10.27: Opera 5

Building Web Content

Although this book is not a how−to for building web content, a few simple procedures will be
covered because they are a part of Konqueror and KDE. These are basic tips and programs and
only the tip of the iceberg, so to speak.
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Using Save to Make HTML

Many of the word−processing and office applications discussed in this book have an option
available when you save a document that will automatically create an HTML file of that document, in
addition to the original plain−text file. To access this option, open a document in your word
processor of choice. Choose the File menu and select Save. Go to the File Type box on the dialog
box that pops up and use the scrollbar to find HTML, then click it. In a few seconds, you will have
the new file saved as filename.html. From there, you can open it in your browser and see a
web−formatted document.

Tip The File menus of some word processors list Save as HTML on the main drop−down menu,
saving you a few seconds and clicks.

Using Quanta Plus

Quanta Plus is a web development environment designed to allow the user to create web pages of
any complexity using a simple graphical interface. Quanta Plus is fully compatible with KDE. If you
do not have it on your system already, download it from http://quanta.sourceforge.net/ As always,
you may need to consult your system administrator for permission before installing extra software.
For users who are unfamiliar with the syntax or structure of HTML tags (the specifications that turn
pages into web pages), having a graphical interface is very comforting. While HTML is beyond the
scope of this book, the following section walks you through the process of creating a very simple
web page with Quanta Plus.

How to Build a Hello World Page

Launch Quanta Plus by selecting it from the Development module on the K menu. Above the main
window, you will see a piece of paper with a shooting star on it. Click it.

Figure 10.28: Getting Started
A dialog box opens. Type Hello World in the title and click OK. The dialog box will then close.

224



Figure 10.29: Hello World
You should see in the main window that the Quick Start feature has filled in some HTML tags. Your
cursor should now be located between a <body> tag and a </body> tag. Whatever you type
between these two tags will be the text on your page. Type This is my home page!.

Now preview this page. In the upper right toolbar, click the eye icon; this will show you what your
page looks like to a browser (it should say, “This is my home page!”). Click the eye again to see the
text of the page.
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Figure 10.30: Previewing Your Page
Save the file and open it using Konqueror, just like any other file.

Figure 10.31: The Final Result
Although Quanta Plus has everything you need to develop a first−rate website, it is beyond the
scope of this book to cover it in detail. When you have time, explore the options available and play
around with designing a web page. You can do things like incorporate different colors and fonts;
include lists, graphs, and pictures; and make the page interactive. Be sure to read the
documentation on the Help menu to learn how to create an interesting, informative, and unique web
page.
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Chapter 11: Customizing Your Desktop
KDE makes it simple for you to modify your desktop’s look and feel according to your unique tastes.
This chapter shows how to change your desktop’s background color(s), activate different
screensavers, resize icons, and even alter the behavior of your mouse, windows, and menus. Most
of what is covered here is not crucial for completing everyday office− related tasks, but it can make
your user experience more personal and perhaps even more pleasant.

Using the Control Center

The Control Center provides the interface that allows you to configure your desktop environment
and many KDE applications, including spell check for text editing. However, the control settings you
specify here will not affect applications that are not KDE−specific, such as OpenOffice or The GIMP.

Figure 11.1: Control Center Introduction Screen
To open the Control Center, click on the Control Center icon (the monitor with the circuit board) on
the panel. On the left side of the window, you will see a list of items you can customize, including
File Browsing, Look & Feel, Network, Peripherals, Sound, and Web Browsing.

Click on the category (or module) you want to customize to access a dropdown list of all the
subcategories available within that larger category. (A single click on the category name will close
this drop− down list.) Clicking on a subcategory from the drop− down list will launch a window to the
right that showcases all the options for that subcategory.

When you are working with specific items in the Control Center, the following buttons are available
on the bottom of the window: Help, Defaults, Apply, and Reset. Their actions are rather obvious.
Help, Defaults, and Reset are good to have for occasions when, for example, you go overboard with
custom colors.
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Tabs are located at the top of the Control Center window and provide further information about the
available options. The three tabs on the sidebar at the left (Index, Search, and Help) are always the
same. Index displays the full list of available categories. Search lets you find what you need when
you know what you want to change but aren’t sure of its category, and Help provides information on
the particular item you have selected. Note that, for the most part, the different versions of KDE
have the same modules, though the categorization may be varied slightly. If something mentioned
here isn’t listed under the same module in your version, use the Search tab to find its location.

Figure 11.2: Maneuvering the Tabs to Search
Depending on the category you have selected, the right side of the window may also have tabs.
These change as you change categories and may include topics like Install, Layout, and Shortcut.

Spend some time exploring the Command Center to learn about all the things you can customize to
meet your needs.

File Browsing

The File Browsing module (the first module listed in the left sidebar of the Control Center window)
deals with the relationships between files and applications and the look and feel of the Konqueror
File Manager. Different types of files require different applications to open them (refer to the
sections on “Opening Files” and “Dealing with Microsoft Word Documents” in Chapter 3).

Tip File types are often referred to as MIME (Mulurpose Internet Mail Extension) types. The MIME
type of a file almost always can be determined by the file’s extension. For example, files ending
in .jpg are JPEG image files.
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File Associations

If you click the File Associations subcategory, you can check and configure (or reconfigure) the
relationships between MIME types and the applications necessary to use them. This module tells
Konqueror which applications to launch for the various types of files to be opened. For example, by
default, KDE recognizes files with a .pdf extension as PDF files and opens them automatically with
Acrobat Reader, rather than try to open them with something like KView (which doesn’t work). Most
of the relationships between file types and applications are already configured for you. If not, this is
where you change or add to these settings, to be sure that files are opened with your preferred
application.

To begin setting up these relationships, simply click on the appropriate file type from the list called
Known Types, and you’ll see the right sidebar fill in with options. On the top right, you can add
filename patterns, so that every possible extension for a given file type will be recognized.

Figure 11.3: Filename Patterns
In the Application Preference Order box, you can add applications for each particular type of file by
clicking the Add button and selecting a program.
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Figure 11.4: Choosing Applications
You can change the order of applications that Konqueror launches to open a file type by highlighting
the program and clicking the Move Up and Move Down buttons, as appropriate. This way, you can
make sure your first choice is the first one attempted.

Tip Another way to alter a file/application relationship is by using the Open With option on the
menu that appears when you right−click a file (refer to Chapter 3 for more on using Open
With).

File Manager

File Manager, another subcategory of File Browsing, allows you to customize the appearance of
your File Manager window. The Behavior tab has options for actions such as Open directories in
separate windows and minimizing memory use. It also allows you to enable Show file tips, which
gives you small yellow popup boxes with information on a file when your mouse pointer hovers over
it. Clicking the Appearance tab allows you specify the font type, size, and color to be used in the File
Manager. It also provides the options to enable Word−wrap icon text, Underline filenames, and
Display filesizes in bytes, which all refer to the way things appear in the File Manager. Use the
Trash tab to select whether you want confirmation messages to appear when you delete, shred, or
move things to the trash. And finally, the Previews tab contains options for file previews in
Konqueror. Here you can specify the protocols for the previews you want to be available. Some of
these previews can take a lot of time to load, depending on your computer, so you may want to
disable them for certain protocols. You can also specify a maximum file size for previews.
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Figure 11.5: Customizing File Manager
Quick Copy & Move Plugin

This subcategory allows you to configure kuick, or the KDE Quick Copy & Move Plugin. If you copy
or move a file from one directory to another (using the dragand− drop method or other methods
within the Konqueror File Manager), you will be able to undo the function quickly if you make a
mistake, by clicking on the Edit menu and selecting Undo. This Control Center module is where you
decide how many directory edits you want cached and whether you want the cached target
directories available as menus.

231



Figure 11.6: Customizing the Quick Copy & Move Plugin

Information

The Information module allows you to access important information about the configuration and use
of your system, such as which devices are connected, how much of your system’s resources they
are using, and how much total memory is being used. For users working in a networked office
environment, the most important subcategories here are probably Block Devices and Memory.

Block Devices shows the partitions of your hard drive, the amount of the drive being used, and the
other data− related devices you have on your computer, such as floppy and CD−ROM drives. It
provides the names of these devices, as listed in the /dev (device) directory, and their mountpoints.
This information is helpful for setting up icons for these devices on your desktop, but it will probably
be used more by system administrators than regular users.

The Memory item gives information about your computer’s random access memory (RAM). RAM is
one of the most important factors in your computer’s speed and general performance. The
information in this subcategory indicates whether you have enough RAM for optimal performance.
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Figure 11.7: Memory Information Can Give You an Idea How Strained a Computer’s Memory
Resources Are

Look & Feel

To alter the design of your desktop so it is more aesthetically pleasing and to personalize some of
its functionality, simply click the Look & Feel module on the left side of your Control Center window.
Then click any of the options (Background, Colors, Fonts, Style, and so on) to make your desired
changes. When you are through making changes within any of the subcategories, be sure to click
the Apply button before closing the window.

Tip If you decide you don’t like the changes you made, you can always click Defaults, and then the
Apply button, to go back to the KDE defaults.

Tip The Look & Feel category is also accessible from the K menu, under Preferences.

Most of the customization options are self−explanatory, once you click them to see the choices that
pop up on the right side of the window, but here’s a rundown.

Background

The Background module gives options for changing the background color of your full desktop
screen. You can choose a common background for all desktops, or you can give each desktop a
separate color, or even its own wallpaper. The default setting applies a common background to all
desktops, so uncheck the Common Background box to customize background color for each
separate desktop.
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Figure 11.8: Background Module
Note that the default number of desktops is four. As you’ll see later in the “Desktop” section of this
chapter, you can add up to 16 desktops.

You can make your desktop a flat color, or a variety of different gradients, by clicking the Mode
drop− down menu. Once you have it set up as you want, be sure to click Apply to save the settings.
If you forget to do this and try to close the window, all is not lost. A dialog box will appear that asks
you if you want to save the new settings.

You can change the colors of different desktops by highlighting a given desktop (listed at the top of
the window by number), clicking the bar, and choosing the color you want from the rainbow swatch
there. The little monitor at the upper right of this window will give you a preview of the color. Again,
once you have the color you want, click Apply.

If you want to use wallpaper (a background image or design) rather than a plain color, click the
Wallpaper tab to specify how you want the images to appear: single or multiple, centered, tiled,
scaled (which means spread out to take up the full screen), and so on. KDE has several built− in
wallpapers you can choose from by clicking the Wallpaper drop− down menu.
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Figure 11.9: Wallpaper Options
By clicking on the Browse button and entering the path and filename in the Location bar, you also
can access one of your own image files to use as wallpaper, rather than using one of the designs
provided by KDE. Again, check the preview monitor to make sure everything is as you want it before
you click Apply.

Color

The Color module under Look & Feel (Figure 11.10) allows even more complex customization. Here
you can alter the colors of active and inactive windows, window backgrounds, buttons, links, and so
on. You can even change the color of the text that appears on windows and menus. Choose from a
list of preconfigured complementary color schemes for your window design, or select your own
colors for each of the separate parts by clicking the name on the Widget Color drop− down menu
and selecting the color from the bar below it. For reference, a “map” detailing the various window
parts appears at the top, and it also provides previews as you make your choices.

If you make up your own color scheme, you can give it a name and save it by clicking the Save
Scheme bar. It will now appear on the Color Scheme menu the next time you decide to make
changes.

Tip The scheme you choose for your windows, buttons, and so on will be constant for all of your
desktops. You can’t have different color schemes for each desktop like you can with
backgrounds.
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Figure 11.10: Color Module
Desktop

Clicking Desktop in the Control Center displays options that set the way your icons are arranged,
whether you can see hidden files (usually configuration files that you don’t use on a regular basis),
the menus that are visible, and so on. Another feature you can change on the Desktop tab is the
action taken when clicking on the desktop with each of the different mouse buttons. Look at the
drop− down menus for each button to see the possibilities. Also, you can set which types of files you
want to have automatic previews of, such as image, PostScript, and PDF files.
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Figure 11.11: Desktop Module
Clicking the Appearance tab allows you to alter the size and type of the font for the icons on your
desktop (more about creating icons in the “Icons” section in this chapter). You also can choose the
color of the text that appears below your icons and whether that text is underlined.

Figure 11.12: Icon Appearance
The Number of Desktops tab lets you add more desktops than the four you get by default—up to 16
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separate desktops. Clicking this tab also allows you to give each virtual desktop its own name,
which will appear in the control bar at the bottom of your screen to help you stay organized. To add
more desktops, simply slide the button at the top of the window until you have the number of
desktops you want. Once they’re activated, you can assign names by clicking on each one and
typing the name in the appropriate box.

Figure 11.13: Number of Desktops Tab
The Paths tab allows you to change the directory paths for the Desktop, Trash, Autostart, and
Documents directories. Changing a path automatically moves the contents of the directory. You do
not have to do it manually.
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Figure 11.14: Configuring Desktop, Trash, Autostart, and Documents Paths
Fonts

The Fonts customization feature is self−explanatory. It allows you to choose different fonts for
different parts of your desktop. Simply click the Choose button for each of the different desktop
sections (Toolbar, Menu, etc.), select your favorite fonts, or change font sizes. You are given a
preview screen showing what each font will look like before you click Apply. If you make changes
and decide you liked the appearance better the way it was to begin with, click Defaults, and you’ll be
back where you started.
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Figure 11.15: Font Options
Icons

If you choose to customize your icons, you’ll see a window with two tabs: Theme and Advanced. On
the Theme tab, you may have the option to change the color theme (depending on the version of
KDE that you have). You can download and install new themes here from the KDE website, as they
become available.
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Figure 11.16: Changing Icon Theme
On the Advanced tab you can change the size or color of icons, depending on whether they’re
active or disabled (use the Set Effect button). The area labeled Use of icon lets you choose which
type of icons you want to configure, for example, the toolbar or panel icons.

Figure 11.17: Advanced Icon Customization
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Launch Feedback

Launch Feedback allows you to Enable Busy Cursor—the little blinking representation icon that
appears next to the cursor of whichever program’s icon you have clicked, showing that the program
is in the process of launching. Here you can enable (or disable) the taskbar notification of a program
launch, and you can select how long it takes for the startup indication to timeout.

Figure 11.18: Launch Feedback
Menu Settings

Depending on your distribution, you may have a Menu Settings module. This simply lets you choose
whether you’d like your main menu to be specific to your distribution or the standard K menu. Here
you can also select extra menus to add to your panel. Note that this module may not appear in the
Control Center with some distributions.
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Figure 11.19: Menu Settings Module
Panel

This module lets you alter your panel, the row of buttons, and so forth at the bottom of your screen.

Figure 11.20: Panel Customization
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The Position tab allows you to change the panel’s location (by default it is along the bottom of your
screen), alignment, and size. You even can specify the exact percentage of desktop width/height
that it uses.

If you aren’t fond of the panel and like to have all of the screen available for your own purposes,
choose the Hiding tab. Put a check mark in the appropriate boxes to enable automatic hiding, and
your panel will disappear when you’re not using it. If you discover that you do need the panel,
simply move your mouse pointer to the place where the panel had been, and it will magically
reappear. If you have a panel display hiding enabled, you can even adjust the amount of time it
takes for the panel to disappear once your mouse pointer has left its vicinity. Slide the button to the
number of seconds that should elapse before the panel disappears after you move away from it.
You can also choose manual hiding, if you don’t want automatic hiding. With this option, you simply
click the arrow on the far right or far left of the panel to hide it yourself.

Figure 11.21: Enabling Panel Hiding
Selecting the Look & Feel tab allows you to change the color of each separate button on your panel
(if you have Enable background tiles checked). This makes the panel icons look more like a row of
actual buttons. It also allows you to select Enable icon zooming and Show tooltips.
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Figure 11.22: Enabling Background Tiles
The Menus tab allows you to choose which menus you want to have available from the K menu and
to customize whether you want hidden files to appear in your file browser menus, as well as the
number of entries you want to appear. You can also customize your Quick Start entries here. Quick
Start is a feature that adds the most recently or frequently used items to the top of the K menu. Here
you can decide if you want the most recently or frequently used items, and how many you would like
to appear.
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Figure 11.23: Panel Menu
The next tab is Applets. Applets are small programs launched from within another program. By
enabling applets, you give yourself quick access to various programs from your panel. For example,
the knewsticker applet shows news headlines (gathered from various news sites) within a small box
on your panel. If you catch a headline that interests you, click it, and Konqueror will take you to the
full story.

Tip If your version of KDE does not have an Applets tab in the Panel module, these same
configuration options are available by going to K menu • Configure Panel • Add • Applet. Applet
has a submenu of the different applets to choose from, and once one is chosen and activated,
simply right−click on it to access its Preferences menu and configure it from there.

Getting applets working and onto the panel involves a few steps. Here’s how to set up knewsticker:
on the Applet tab you will see two lists, identified as Trusted Applets and Available Applets. Above
the menu is a checklist where you can mark the security level. (Load only trusted applets internal is
the default and most secure option because it allows you to decide which applets get loaded.) If
knewsticker (or the applet you want loaded) is in the right column (Available Applets), you’ll need to
move it to the left column (Trusted Applets).

To do this, click knewsticker (or any applet you want to load), and then click the double left arrow.
This will cause knewsticker to load. If you don’t have knewsticker in either column, you can
download it, and any other KDE applets, from http://apps.kde.com/

Once that is done, you’ll need to go to the K menu and select Configure Panel. From the submenu,
select Add, then Applet, and then News Ticker from the list of applets presented. Unfortunately,
many of the applets listed here are not listed by their names (KNewsTicker) but by what they do
(News Ticker). The selections shouldn’t be too hard to figure out. See the “News Ticker” section to
customize the behavior and content of this applet.

Screensaver

You can choose to enable one of the screensavers provided by KDE by clicking this option. Put a
mark in the Enable screensaver box and check out the possibilities by clicking whichever
screensaver name sounds most interesting— if you have time to kill, check out all of them with the
preview monitor. You can also click the Test button at the bottom of the screensaver list, which
actually shows the highlighted screensaver on your full screen (simply click the mouse to return to
the Control Center), but won’t permanently activate it until you click Apply.
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Figure 11.24: Screensaver Activation
The Setup button, next to the Test button, is for setting the speed and other attributes of the
different types of screensavers. For a Banner screensaver, you can type in your own message or
inspirational quotation, which will then move across the screen (with the color and speed of your
choice) in place of the default KDE banner.

In the Settings section of the window, you can choose the amount of time it takes for the
screensaver to activate, and whether a password is required to turn the screensaver off and return
to the desktop.

Tip It is best to leave the Priority marker set to Low. This determines the priority your computer
should give to this process. Moving it to High will improve the animation, but could cause other
background processes to have difficulties.

Shortcuts

The Shortcuts feature allows you to customize the keyboard shortcuts for certain tasks for which
you are probably accustomed to using the mouse. Depending on your version of KDE, this module
may be called Key Bindings rather than Shortcuts, though they do the same thing. It’s a good idea
to view this information, even if you don’t want to change it. These keyboard shortcuts can save you
a lot of time by allowing you to perform frequent functions without taking your hands off the
keyboard.

There are two main tabs: Shortcut Schemes and Modifier Keys. Under Shortcut Schemes, there are
three subtabs: Global Shortcuts, Shortcut Sequences, and Application Shortcuts. On the Global
Shortcuts tab, you’ll see a list of actions (such as Kill Window and Logout) and their corresponding
keyboard shortcuts. For example, to log out, you can simply press CTRL− ALTDELETE, instead of
using the mouse to click your way out.
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To change one of these settings, highlight the action, then click the Custom button at the bottom of
the window, and make your changes in the dialog box that appears. Click OK when you are done.

You can also change the shortcuts to different preconfigured schemes with which you may be more
familiar, by clicking on the Current Scheme drop− down menu (for example, a Mac Scheme or Unix
Scheme).

Figure 11.25: Keyboard Shortcuts
The Shortcut Sequences tab allows you to view the shortcuts for moving between windows and
different desktops. To change settings, use the method described above.
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Figure 11.26: Shortcut Sequences
Application Shortcuts are basically the same thing as Global Shortcuts, except (obviously) they’re
for specific applications like KWrite or Konqueror. Some of the functions you are likely to perform
with these keyboard shortcuts are saving, printing, and cutting and pasting. You can use the
defaults or customize these shortcuts in the same way you would with Global Shortcuts.

Figure 11.27: Application Shortcuts
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Style

The Style section of the Control Center lets you customize the look and feel of your widgets.
Widgets are things like buttons and check boxes. KDE provides a list of possible widget themes
from which to choose. Note that this particular customization section does not give you any
previews.

You must click Apply to see what happens. If you want to go back to your previous styles, you’re out
of luck if you don’t remember your settings. But you can always select the KDE default widget style
and theme to return to the style you had—before you started messing with any of these
customizations.

Figure 11.28: Customizing Your Widgets
On the Effects tab, you can alter GUI effects, such as changing tooltip behavior to Animate or Fade.

There are also style options for your toolbars on the Miscellaneous tab. You can choose to have
icons only, text only, or a combination of both—depending on how cluttered or sparse you like your
toolbars to look.

Another option is Highlight buttons under mouse, which simply means that when your mouse
pointer is hovering over a button, that button will be highlighted. If you uncheck this box, there will
be no indication that your mouse pointer is on top of a button. Here is where you can also enable or
disable the transparent toolbars. Tooltips can be enabled or disabled here as well.

Taskbar

Taskbar lets you configure whether you want all windows open on all desktops to show up at once
on the taskbar of the desktop that is active, or if you want only the windows that are open on the
active desktop to be shown, and whether you want the windows list button displayed on the taskbar.
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You also can activate or deactivate Group similar tasks, Sort tasks by virtual desktop, and Show
application icons.

You can alter mouse button actions here to change what happens when you click on the taskbar
with the different buttons. See the drop− down menus for all the options for each button.

Figure 11.29: Configuring the Taskbar
Theme Manager

The Theme Manager lets you install KDE themes. On the left side of the window is a list of
preinstalled themes. Clicking on them gives you a preview in the right part of the window. On the far
right are four buttons. Add lets you browse to the location of themes you have downloaded. Save As
lets you change the current theme under a new name, so you can make changes without damaging
the original. Create lets you save your current desktop settings as a theme of your own, and
Remove removes the theme from your list. The Contents tab allows you to select or deselect certain
areas if you don’t want a theme to affect all parts of your desktop.

Tip You can find many additional themes to add at http://kde.themes.org/

251



Figure 11.30: Theme Manager
Window Behavior

The Window Behavior module lets you specify how you want your windows to act. For example, you
can choose whether making a window active requires a click, or whether it will follow your mouse
(with the windows moving to the front as your pointer hovers over them). On the keyboard section,
you can switch between KDE mode and CDE mode, which means that pressing ALT−TAB or
CTRL−TAB, respectively, will switch between windows.

If you select the Traverse windows on all desktops option, then pressing ALT−TAB or CTRL−TAB
will take you through all windows on all desktops rather than only the active desktop.
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Figure 11.31: Window Behavior
On the Actions tab, you can customize each of your mouse buttons so that they have different
effects on the movement of windows, as well as the keyboard commands. As noted in the Help field
for this module, you can make these modifications only if you use KWin as your window manager. If
you use a different window manager, changes in settings here will have no effect.

Figure 11.32: Customizing Window Behavior
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The Moving tab lets you configure how you want the windows to look while they are moving. The
Advanced tab provides more fine−tuning for window behavior such as shading, which means that
windows roll up into the titlebar when that action is enabled.

Figure 11.33: Moving Window Configuration Options

Figure 11.34: Advanced Options for Window Behavior
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Window Decoration

The Window Decoration module allows you to select preconfigured styles for the borders of your
windows. This mainly changes your widgets and the color of window borders.

Figure 11.35: Window Decoration

Network

The Network module contains several items for the configuration of the system itself. Most of these
areas are best left to your system administrator and are beyond the scope of this book. However, a
few of them pertain to general user configuration, like email and news ticker.

Email

This module is simply for entering the user’s basic email information and sending bug reports to
KDE.
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Figure 11.36: Entering Email Information
News Ticker

In the News Ticker section, you can change the settings for the news ticker. By default, knewsticker
gathers news information from Linux news sites, such as Slashdot, Freshmeat, and Linux Weekly
News, but it can be set to any news site you like. On the General tab, you can determine frequency
of news search, scrolling speed, font, and color.
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Figure 11.37: Configuring the News Ticker
On the News sources tab, you can determine the sites that are checked. Highlight the news source
you want, and click Add.

Figure 11.38: Choosing News Sources
An Add News Source... dialog box will appear. Enter the name of the site (not the URL, simply the
name by which you know the site— Linux Journal, for example).
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Figure 11.39: Add a News Source
News sites generally have a file that contains both headlines and teasers for articles. This is where
knewsticker gets its information. These files frequently end with an .rss or .rdf extension. The source
file for the Linux Journal web site, for example, is found at http://www.linuxjournal.com/news.rss So
simply enter this in the Source file box, click OK, and you’re done. If you right− click on the news
ticker display itself, you will be presented with the list of news sites you have chosen. Select one,
and you get an option to check news at that site, or you can go directly to one of the headlines
listed.

Peripherals

From the Peripherals module, you can access settings for your digital camera, keyboard, and
mouse.

The digital camera module is where you enter the model of camera you’re using by clicking on the
little camera icon on the top right of the window. Other options will become available, depending on
the type of camera you’ve entered.

The options available for the keyboard are limited and depend a great deal on the hardware design
of the keyboard itself, as well as the X server being used. You may be able to adjust the key click
volume, if that feature is available on your system. In general, you will most likely never need to
fiddle with the keyboard section of the Peripherals module.

Mouse

You will probably find the mouse options in the Peripherals module more useful. Mouse
configuration is broken into two sections, designated by the General and Advanced tabs. On the
General tab, you can map your mouse buttons for left−handed users and designate that a double−
click (rather than the default single− click) is necessary to launch or open a program, file, or menu
item. You can also choose to configure the mouse so that icons are selected automatically when the
pointer passes over them. This may be useful when you want to select an icon without opening it.
Other options include making the pointer change shape (into a hand) when it passes over an icon,

258



or having a dialog box open when the pointer passes over an icon that states what the icon is or
does. The final option is to make the cursor larger, about twice the normal size, which is useful for
easier visual navigation.

Figure 11.40: Available Options to Customize Your Mouse
The settings on the Advanced tab affect your mouse speed and the time intervals between mouse
movements—things like the time span within which a double− click must occur to be considered a
double− click instead of two single clicks. The default settings will be acceptable for most users,
although tweaking them may be useful for graphics work when you are working at the pixel level.
Feel free to experiment, but be careful about how fast you set the pointer acceleration, or the
pointer will fly off the screen.
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Figure 11.41: Advanced Mouse Options

Personalization

With the Personalization module, you can further refine your desktop environment by customizing
such things as the way currency is written for your particular region and your password settings.
Here’s a quick overview of the options available under Personalization.

Accessibility

Accessibility provides special features for disabled users, such as a visual bell instead of an audible
one and mouse navigation with number keys. It lets you specify the length of time a key must be
held down for it to repeat, and it also allows the user to move the mouse with the Num pad (numeric
keys) rather than with the mouse itself.

Country & Language

Country & Language controls the language, numeric, and time settings and can be changed to
match the standards of your geographical location. If you live in France, for example, and want to
change the way currency is displayed on your system so that the thousands separator is a period
instead of a comma, this is where you accomplish that. You also can specify whether the date
should be shown in month/day/year or day/month/year format, among other things.
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Figure 11.42: Regional Customizations
Crypto

Security is always an important issue with computers. As you move across the Internet, you go
between secure and unsecured websites. Luckily, your system is set by default to warn you of
certain security issues and risks. All of this information can be seen in the Crypto menu item. From
there, you can make changes to security measures like SSL (Secure Sockets Layers) and
certificates. Although security is beyond the scope of this book, you should certainly familiarize
yourself with security issues surrounding computers and the Internet. See Chapter 10 for a brief
overview of this topic.

Konsole

The Konsole module is where you can customize your terminal windows. For example, you can
select the default terminal application and the colors for your terminal windows. See Chapter 13 for
more detailed information on configuring terminal windows and using the command line.

Passwords

The Passwords module gives you access to options for setting up passwords. You can select one
star or three stars (the number of stars that show up on the screen when you type each letter). Or
you can select no echo, so there is no onscreen indication of how many letters are in your
passwords. Finally, you can specify the amount of elapsed time before password reverification is
requested.

Session Manager

The Session Manager is where you set up your login/logout screens. For example, you can enable
Confirm logout or Save session for future logins. You can also select the default action for what
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happens after logout: Login as different user, Turn off computer, or Restart computer.

Spell Checking

The Spell Checking item allows you to customize some spell− check options, such as Consider
run−together words as spelling errors. It also allows you to choose which dictionary you’d like KDE
to use.

Power Control

The Power Control module basically does what you would think, given its title, depending on your
specific installation. You can monitor your batteries ( especially useful for laptops), configure your
power−saving features, control power settings for your laptop, or set an alarm to alert you when
your batteries get too low.

Most of these settings have to do with laptops, but the Energy setting will allow you to control how
long it takes for your display to go into sleep mode. To get out of this power−saving mode once it
has activated itself, all you need to do is move your mouse or press a key.

Figure 11.43: Energy Setting

Sound

Assuming that you have a sound card and speakers on your system, KDE allows you to make a
variety of noises with your machine— anything from sounds associated with computer events to
playing music CDs and more is possible.

KDE includes a nice CD player called KsCD for playing music CDs. From the K menu, go to
Multimedia, and you’ll see it in the submenu. Despite its simple appearance, the player has some
nice functionality, including the ability to provide information by way of Internet connectivity.

On the Sound menu in the Control Center, you will find the Audiocd IO Slave item. This allows you
some control over the behavior of KsCD (or any CD player you may have on your computer).
Selecting it presents four tabs.
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Figure 11.44: The Audiocd IO Slave Items
The first tab is CDDA Settings, which tells the computer where to look for the CD−ROM drive. In
most cases, it is probably best to check the Determine device automatically and Never skip on
errors boxes. The next two tabs allow you to determine settings for sound quality of both Ogg Vorbis
and MP3 digital music file formats. (Ogg Vorbis is a more recent sound format that has the
advantage of being open source.)

The last tab is CDDB Settings. CDDB stands for CD database, an Internet service that provides title
and track information for music CDs. Here, you can enter where your computer goes to access this
information.

Tip The Debian Linux distribution comes with the freedb settings by default. Normally, the only
necessary step here is to check the Enable CDDB Lookups box. The freedb site provides a
free service and seems to have a very good database.

The CD player sends data to the CDDB service, which then recognizes the CD and sends back title
and track information that is displayed on the CD player.
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Figure 11.45: Title and Track Information
Tip Clicking on the i (Information button) in KsCD presents further features. If the system knows

the artist being played (by way of a CDDB), this button allows you to search the Internet for
CDs, news, and tour dates of the artist.

System Notifications

System Notifications is also on the Sound menu in the Control Center. This lets you control the way
you are notified when certain events occur, such as errors, startup, the opening or closing of a
window, and so on. Simply scroll through the list of possibilities (there are too many to mention
here), and see if there are any you want to customize. If so, click the little box with the plus sign and
choose a notification method. Choices include: Log to file, which will log the event notification to a
file and not make it known to you overtly; Play sound; Show messagebox; and Standard error
output.
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Figure 11.46: System Notifications

System

The System module is the place where you configure your system’s controls. To make alterations to
many of these items, you will need to have root or superuser privileges, because alterations here
cause changes to your entire system. For example, to make changes to the Boot Manager (LILO) or
to the Date & Time module, you’ll need to be logged in as root.

Figure 11.47: System Module
The Login Manager allows you to customize the login screen. You can select a different
background, choose which language it should use, choose which users have access, and choose
whether you want automatic or passwordless login ability. Here, too, you need superuser privileges
to make alterations.
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Figure 11.48: Login Manager
The Printing Manager tells you how your printer is configured and will show you which jobs are in
the queue. It is best to leave this area to your system administrator.

Figure 11.49: Printing Manager

Adding Icons

For programs and utilities you use frequently, it’s helpful to create icons on your desktop for quick
launching. Creating icons is a simple process, whether you want to add them to the panel or the
desktop itself. You can also move icons around or remove them completely.

Panel Buttons

Within the panel, icons are referred to as buttons. To add one, start by opening the K menu and
selecting Configure Panel • Add • Button. At this point, the K menu will be replicated. Click on the
application you want from this menu, and the icon will appear on your panel bar. This icon will be
the same image as the one located next to the application name in the K menu. For example, say
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you want to add an icon for KCalc; go to K menu • Configure Panel • Add • Button • Utilities • KCalc.

Figure 11.50: Steps to Make a KCalc Icon
Once the icon appears on your panel bar, all it takes is a click to launch the program. If you want to
move it to another spot on the bar, right− click the icon, and select Move from the pop−up menu.
The mouse pointer will change to a four−way arrow that you can slide around on the bar. When it’s
at the location you desire, click, and the icon will move to the new location.

Figure 11.51: Types of Menus that Pop Up to Move or Delete an Icon from a Panel
If, instead, you want to move the icon off the panel and onto the desktop, this is also an easy step.
Place your pointer over the icon, hold down the left mouse button, drag to the desired location on
the desktop, and then release the button. A menu will appear asking if you want to copy, move, or
link the icon to the new location. Once you’ve made your choice, the icon will appear in that new
location.

Desktop Icons

You may eventually may install programs on your computer that weren’t there originally and need to
add icons for those programs on your desktop. Or there may be a particular document you use
frequently that you want to access with a single click from the desktop.

To add an icon for an application, right− click any empty spot on your desktop. You’ll be presented
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with a menu, the top item of which is Create New. From there, you’ll find a submenu. Select Link to
Application. A dialog box will appear, allowing you to set up the icon. Remember that an icon is a
link or a representation of a program that tells the computer to go to that program’s location and
launch it.

Figure 11.52: Adding a Program Icon to the Desktop
On the General tab, enter the application name. On the left side of the box is a button with a generic
KDE icon. Clicking it will bring up thumbnails of all the possible icon images from which you can
choose. The Permissions tab allows you to determine who will be able to use the link. On the
Execute tab, fill in the command that the computer will use to launch the program. This is the same
as what you would enter in the Run Command box to launch a program. On the Applications tab,
enter the name that will appear under the icon. You also can assign the file types associated with
that application here. When you’re done, click OK, and you’ll have your icon.
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Figure 11.53: Icon Choices
To create an icon for any file or directory, simply right− click that file or directory from the Konqueror
File Manager display. For example, the Autostart directory is handy to have on your desktop
because you will probably change its contents frequently. Autostart is a directory, but it is also a
program—one that launches the programs or files placed in it (see the “Desktop Icons” section of
Chapter 2). Open your home directory, and add .kde3 (the number will be different, depending on
the version of KDE you are using) after your name in your home directory pathname. One of the
subdirectories displayed there should be Autostart. Right− clicking presents the usual menu. Select
Copy, and drag the copy to the desktop. When you release the mouse button, another pop−up box
will appear, giving you the option to copy the image to the desktop. Now any file or program you
copy into Autostart will launch when you log in.

As time goes by, you may use some programs more than before and other programs less often. To
regain space on your panel and desktop, it’s helpful (and easy) to remove icons. If the icon is on the
panel, right− click it, and choose Remove. If the icon is on the desktop, right− click it, and choose
Delete.

Adding Items to the K Menu

You can add new menu items (with submenus, if desired) to the K menu with KDE’s Menu Editor.
Go to K menu • System • Menu Editor to access the editor.
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Figure 11.54: Opening the Menu Editor
Click the new item icon at the top−left corner of the window to add a new entry to your K menu. A
dialog box will appear, asking you to provide a name for the new item.

Figure 11.55: Naming a New Menu Item
Type the name of the item you want to add, and click OK, and you will be able to insert the
information in the Menu Editor window, such as Comment (not required) and Command (the
command used to open the program on the command line). Then choose the appropriate type from
the drop− down menu (application or link).

Note You may need your system administrator’s help filling in this information, depending on
where the program is stored.

You can select an icon for the item by clicking on the question mark icon button, which will take you
to a window full of available icons from which you can choose. Once you find the appropriate icon,
simply click on it, and you will be taken back to the setup window, with the icon you’ve chosen
showing (rather than the default question mark icon). Click Apply to add the new item to your menu.
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Figure 11.56: Adding Mozilla (and Its Icon) to the K Menu
To add a submenu to an existing or newly created item, highlight the menu item for which you want
the submenu, and then click on the New Submenu icon (just to the right of the New Item icon). From
there, the steps are exactly the same as you take to create a new menu item, except that the item
will appear as a submenu item when you are finished. You can choose icons for submenu items in
the same way you choose them for new menu items.
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Chapter 12: Making Job Backups

Overview

As reliable as computers generally have become, many things can still happen to cause corruption
or even loss of data. Power outages, hardware failures, and even others tampering with your files
provide good reasons for making backup copies of your work. If you are in a networked office
environment, you probably have a system administrator who is responsible for making regular
backups of the system data—most likely on a tape device—but you may want to back up portions of
your own files as well. Maybe you have a project you want to refer to at some time in the distant
future but don’t want it taking up space in your home directory until then, or perhaps you have a job
that is so essential, the regular system backup doesn’t provide enough security to protect it. Maybe
you need to copy large files on some type of transportable media to send to someone, or maintain
archives of projects that are no longer current. In any case, you might have a number of reasons for
backing up portions of your work.

For small jobs, a floppy disk might be sufficient. The “Making the Konqueror File Manager Your
Friend” section in Chapter 3 discusses accessing the filesystems of floppy disks, and the “Working
with Files” section explains copying files. If the files you want to back up exceed the standard 1.4MB
limit of a floppy disk, however, you’ll need to go to a medium with more capacity, such as a Zip disk
or an LS120 Super Disk, which hold 100MB and 120MB, respectively (note some Zip disks hold
250MB). The problem is that although almost every computer has a floppy drive, not all have Zip or
LS120 drives, making those options less than ideal for transporting data in some situations. CDs are
another option. Their standard 650MB capacity and the ubiquity of CD drives make them a good
choice.

This chapter explains how to make backups to these portable media.

The Ark Archiver Backup Utility

KDE includes a GUI program for using various popular UNIX backup formats. The program is called
Ark. It can group files together into a single file and even compress them so they take up less space
on your portable media. Unpacking files created by Archiver is covered in the “Working with Files”
section of Chapter 3. Here we show you how to create file archives.

In some cases, simply copying whole files or directories onto the backup media— in the same way
you would copy them into another directory on your hard drive—may be sufficient. However,
compressing the data in some way is often a more efficient, “cleaner” method.

The Ark utility provides a way to do this compression. Open Ark from the Utilities submenu of the K
menu. Your goal is to group the files you intend to back up into either a single file or at least fewer
files. For instance, if you back up your home directory, you may want to have a separate archive file
for each of its subdirectories.
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Figure 12.1: The Ark Utility
To create a new archive file, select New from the File menu. This will present a window with a
directory display. The default is your home directory. A sidebar display is on the left to speed the
browsing of files.

Figure 12.2: The Create a New Archive Window
Type the name you want to give your new archive file in the Location bar at the bottom of the
window. In the bar at the top, type the pathname of the directory you would like displayed. The
directory displayed in the top bar is where the archive file will appear when created. The format that
Ark creates is determined by the extension you append to your filename. For example, .tar is the
extension for the popular tar format, and .tgz (or .tar.gz) is the format for a gzipped ( compressed)
tar file. So if you want your archive file to be compressed, make sure your filename ends with .tgz
(for gzipped tar file). These two may be the only formats you need, unless you work with the files on
computers with other, non− UNIX− compatible operating systems. In this case, you may need the
Zip format, though other operating systems’ archivers may understand the .tgz format.

Once you have named your archive file and clicked OK, you will return to the first Ark window.
Notice that the window’s titlebar at the top now includes the name of the archive you entered. From
here, you can select the files you want included. Choose Add File from the Action menu. In the
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window that appears, you can select the files you want included in the archive file. To select multiple
files that appear together in the display, highlight either the first or last file, press the ENTER key,
and use either the up or down arrow key to highlight adjacent files.

Figure 12.3: Selecting Multiple Files
After the files are selected, you can view, open, or delete from the main Ark window. The mere act
of naming an archive file and adding files to it creates the archive file. If you then add or delete files
in the Ark window, the archive file will immediately update. Look in the directory where you made
the file, and it will be there. Now you have a single backup file that you can copy conveniently to any
portable media. Refer to the section “Accessing Files on Removable Media—CD−ROM and Floppy
Disk Drives” in Chapter 3 to access the filesystems of any floppy, Zip, or Super Disk drive on your
system (the process of copying files onto a writable CD−ROM drive is a bit different and is covered
in the next section). Once you have mounted the drive, copying your archive files via the Konqueror
file manager is the same as copying them from one place on your hard drive filesystem to another
(see “Working with Files” in Chapter 3).

Burning Data to CDs with KOnCD

The process of putting data onto a CD is somewhat different from recording data to other media and
is referred to as burning. CDs that are both writable and readable are available, but the most
common type for making backups is write− once, read− only. This means that once they have data
written to them, they become read− only. The data remains “burned” there permanently.

In addition to making backup CDs with KOnCD, you can also make audio CDs that are playable in
an ordinary CD player.

Preparation

You will need a CD recorder—either a CD−R (CD− recordable) or CD−RW ( CDrewritable) type—
and a few disks. The differences between the two types of CD recorders are much like the
differences between permanent and washable marking pens. You can erase and re− record over a
CD−RW disk, but once you record onto a CD−R disk, it’s permanent. Another difference is that
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CD−RW disks may be used only in a CD−RW drive, while CD−R disks may be recorded and played
in either a CD−R drive or a CD−RW drive. Audio CD−Rs can usually be played in an ordinary CD
player too. Have a look at the CD media table for more details.

Erase Record in
CD−R drive

Play in
CD−R drive

Record in
CD−RW drive

Play in
CD−RW drive

Play in CD
player

CD−R data disk no yes yes yes yes no
CD−R audio disk no yes yes yes yes yes
CD−RW data disk yes no no yes yes no
CD−RW audio
disk

yes no no yes yes no

Of course, there’s no way to know whether a disk recorded on one drive will play on another drive
until you try it. The cheaper drives are less tolerant. To ensure that your disk can be played in the
widest variety of drives, choose high−quality CD−R disks. On the other hand, if erasing appeals to
you, and you don’t expect to use the disks except in CD−RW drives, choose high−quality CD−RW
disks.

If your system does not have KOnCD, it can be downloaded from the program’s home page
http://www.koncd.org/

You’ll also need read/write access to the CD device. If you need this access added, contact your
system administrator.

While KOnCd is running, it will create a temporary file on your hard drive equal to the total size of
the data you’re recording. This file is called the CD image, or in KOnCd−speak, “the image.” Verify
that you have sufficient free space on your hard disk for this file.

Tip Once you’ve successfully recorded a few CDs, try KOnCd’s Burn on−the−fly option,
which avoids the temporary file. This works only if your computer is fast and lightly
loaded.

Burning a CD makes precise demands on CD technology. One common problem is buffer underrun,
where the CD recorder needs a piece of data immediately, but the computer does not have it ready
yet. By the time the data arrives, the disk has already spun beyond that point and is ruined. These
disks make excellent coasters, but they are unplayable, so always keep a few extra blank disks on
hand. Also, while buffer underruns abort the recording process immediately, other errors may not be
detected. Always try reading a disk after you record it, especially if it’s a backup disk. If you expect
to read the disk in another player, don’t assume it will work; try it to make sure. Once you’ve made a
few disks on a particular machine and read them with the other player, you’ll get a feel for how often
it succeeds and how vigilant you need to be. But since we’re talking about backups here, extra
vigilance is better than not enough.

Starting Up

Start KOnCd by choosing it from the K menu (Multimedia • KOnCd), or by typing koncd in the Run
Command box.
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Figure 12.4: KOnCd Main Window
Tip Depending on your system’s file permissions, you may need to be root to run KOnCd

or access certain features.
First let’s take a short technical diversion to verify that KOnCd recognizes our drive. Press the Setup
button in KOnCd’s main window.

Figure 12.5: Setup Window
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You should see an entry for both Reader and Writer. If not, you probably got an error message and
may need to consult your system administrator.

While you’re in the Setup dialog, choose the Enable Burn−Proof option. Burn−Proof is a technology
that eliminates buffer underruns. It’s effective only if the drive also has the Burn−Proof feature.

Click the Users tab to specify which users are allowed to run KOnCd. Otherwise, only root can
make CDs.

When you’re finished with the Setup window, select Save.

Backing Up Files

In the main KOnCd window, click the Master CD button.

Figure 12.6: Master CD Window
The top section in this window, called CD data, contains a number of tabs. Here you indicate which
directories and files to back up. The three buttons below this let you add an entry (the folder icon),
delete an entry (the scissors icon), or delete all entries (the trashcan icon). Let’s add the directory
/tmp/burnable. Press the button with the folder icon. A Select Directory dialog box opens. Go to the
directory and press OK.
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Figure 12.7: Select Directory Dialog Box
CDs generally hold a maximum of 650MB. To verify how much data you have selected, click the
Calculate button. If there are items inside the source directories you don’t want to back up, you can
use the Exclude dirs and Exclude files tabs to exclude them.

There is a fourth important tab in the Data section: the Image tab. If the tab is hidden, use the little
right arrow to scroll to it. Here you specify the path/filename of the image file (that temporary file).
Choose a directory with sufficient space, and choose a filename ending in .iso. You don’t have to
use that extension, but that’s the convention. For instance: /tmp/cd.iso.
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Figure 12.8: Master CD Dialog with Image Tab Visible
The Boot−Image section isn’t important because we’re not creating a bootable CD.

Image−Type (the button with the pencil icon) opens a dialog box containing a type selector and a lot
of check boxes. The default image type (Unix Rock− Ridge) is fine if the disk will be read only on
Linux or other UNIX systems. If the disk will be read on Windows systems also, choose Rock−Ridge
+ Win9x/NT. Click Save.

Figure 12.9: Set Image Type Dialog Box
Back in the Master CD window, you can choose the CD identification tab and fill in the text fields.
These are optional.
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In the CD−Writer section, choose an erase mode (if the disk is a CD−RW) and the recording speed.
Choose the maximum speed supported by both your CD drive and your disk. If you don’t know the
appropriate speed, you can either experiment or use a relatively slow speed, such as 8x.

In the Options section of the Master CD window, there are several check boxes. Create CD−Image
and Write CD are preselected because these are the actions you usually want to take. But you can
choose any other options desired:

Bootable CD: makes a disk you can boot from. Not covered here.• 
Dummy mode: “Let’s not and say we did.” Useful to verify that everything is ready to go
before actually burning a CD.

• 

Multisession: allows you to come back and record more stuff later, if there’s space left on the
disk. This works even with CD−R disks. The catch is that some CD−ROM drives will
recognize only the first session.

• 

No fixiating: leave it unchecked for now. (Note: there are some incompatibilities between No
fixiating and Multisession, and between No fixiating and audio CDs. Read the online help for
more information.)

• 

Leave image: means KOnCd won’t delete the huge temporary disk file it creates. Select this
if you plan to write several identical disks. Then, after making the first disk, uncheck the
Create CD−Image box. That will save you several minutes.

• 

Force mode: makes the program ignore errors. Don’t select this; it’s not a good idea if your
highest priority is to ensure the backup is reliable.

• 

Ignore medium size: ignores the disk’s idea of what its own capacity is. Don’t select this
option.

• 

Eject CD after write: This is just a convenience. It does what it says.• 

Finally, click Start at the bottom of the Master CD dialog. The recording process will begin. With
luck, in a few minutes you’ll have a shiny new backup.

When finished, it’s a good idea to mount your CD−ROM drive with your newly made CD (see
Chapter 3) and verify that everything is readable.
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Chapter 13: Using the Command Line

Overview

Some might ask, Why would I want to use the command line? The best answer is that it can save
you a lot of time, particularly if you are doing repetitive tasks. For example, sophisticated editing can
be performed in vi or Emacs with many fewer keystrokes than when performing the same task using
a mouse− based GUI editor. And for repetitive editing, programs such as sed can automate the task
for you, as can awk for report generation.

Before we scare you away, you can be a successful user of your KDE environment without ever
seeing the command line. If you spend most of your time in an office suite, such as OpenOffice, or
running a custom application, you can skip this chapter confidently and get on with your life with
KDE.

If, on the other hand, you need the power of the command line, KDE offers a lot of advantages:

Support for multiple terminal windows on one graphical screen.• 
Selection of various screen and character sizes.• 
Session management, including the ability to send signals.• 
Emulation of different terminal types and support for various character sets.• 

Terminal Windows

To enter commands you must open a terminal window. This is a program that brings up a text−
based window and starts a command interpreter (called a shell). See “The Shell” later in this
chapter.

The easiest way to start a terminal window is to click on the terminal icon on the KDE panel.

Figure 13.1: Terminal Icon
An alternate way of starting a terminal window is by pressing ALT−F2 to bring up a Run Command
dialog box and entering the name of a terminal application, such as Konsole or xterm.

Tip With the combination of mulle desktops, which you learned about in Chapters 2 and

Tip 11, and terminal windows you can have tens or even hundreds of shells running. This
could prove to be very useful if you need to monitor many remote systems.

Konsole

The default terminal application in KDE is Konsole. Another common terminal application is xterm.
By default, the icon will bring up Konsole.
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Figure 13.2: Konsole Terminal Window
The Konsole terminal window has menus across the top, a scroll bar on the right, and icons on the
bottom. The first icon, labeled New, makes it possible to create additional terminals within this single
KDE window. Following the New

icon are the icons for the terminals you create. By default you have only one, but each click on New
will create another. You can then click on the terminal icons to switch between them.

Tip You can use CTRL and the left and right arrow keys to switch between the terminal
windows within Konsole.

The menus allow you to perform various configurations. In the File menu, you can request various
types of terminals or exit Konsole completely.
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Figure 13.3: Konsole with Sessions and Signal Menus
The Edit menu allows you to send a signal to the current terminal and to rename a terminal session.
Send Signal allows you to send an asynchronous event to the program running in your current
terminal window. Signals and signal handling are advanced topics, most of which are beyond the
scope of this book. A simple example, however, is the hangup signal. If you were connected
remotely to a computer system and the connection was dropped (by a callwaiting interrupt on a
phone line, for example), the programs you were running would be sent a hangup signal. The
programs then have the option of deciding what they want to do with this signal.

You can use the Rename session menu item to change the names of your terminal windows. By
default, they are labeled as Terminal or Shell and are numbered sequentially. Changing the name
can make it a lot easier to remember which window does what.

Tip Some distributions include a command−line command, titlebar, or xttitle, that allows you to
change any terminal window title; simply type titlebar or xttitle followed by a space and
whatever you would like to name the terminal.

The Settings menu allows you to configure the terminal window.
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Figure 13.4: Konsole with Settings Menu
The Schema configuration options let you set a combination of foreground and background colors,
sizes, and fonts. Size allows you to change the number of columns and lines in the window, and
font allows you to change the size of the characters within the window.

The Show options allow you to turn on and off the various types of ancillary information around the
outside of the window itself. You can turn the bottom menubar, the top toolbar, and the frame border
on and off. Don’t panic if you turn off the toolbar. You can also call up the Settings menu by right−
clicking your mouse while the cursor is within the terminal window.

These settings are only for the current session within Konsole. If you want them to affect future
invocations, use the Save Settings button.

The Help menu gives information about Konsole or, by selecting Contents, lets you search the
online manual.

xterm

A second type of terminal window is xterm. It can be started by entering xterm

in a Run Command box. You should know about xterm only because there may be cases where
Konsole is not recognized by a remote system. This can happen if the remote system was, for
example, a mainframe running something other than Linux. Generally, Konsole is a better choice
and has more capabilities.

The Shell

The shell is the program that interprets the commands you enter and invokes the appropriate
programs to perform the requested tasks. In other words, the shell performs some basic functions
that make it easier for you to communicate with programs. These functions include:

Command−line editing: enables you to backspace and edit within the line you are entering.• 
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Job control: allows you to control (start, stop, and terminate) multiple programs from one
shell invocation.

• 

Control of input and output files: normally a program receives input from your keyboard and
sends output to your screen. The shell gives you the ability to change the location of these
data files to other programs or files on your computer system.

• 

Command history: lets you call up, edit, and execute previously entered commands.• 

Shell Choices

Linux systems come with a choice of shells. Each has its advantages and disadvantages. For
example, some programmers find the editing features of csh (called the C shell) to be very
appealing. Some see the compact size of ash as an important consideration, and for some, the
standardized nature of ksh (called the Korn shell) eases their transition between Linux systems and
other UNIX platforms.

The most popular shell among Linux users is Bash, which stands for Bourne Again Shell. The name
comes from UNIX history. The first shell that offered its own programming language—that is, the
ability to make control decisions within a saved set of commands based on conditions that could be
tested for—was written by Steven Bourne of, at the time, AT&T. Bash took these capabilities and
has expanded them over the years.

Learning all there is to know about a shell is easily the subject for a whole book. For the purposes of
this chapter, we will use Bash as our shell. Most of the information presented, however, applies to
virtually all available shells.

Tip The shell tcsh, an enhanced clone of csh from UC Berkeley, is available for those who are
familiar with csh and want to use its advanced history and scripting features.

Shell Prompt

The character string that the shell displays when it is ready to accept your command input is called
the shell prompt. This prompt can be configured to be as simple as a single character or it can be
generated dynamically each time.

The default shell prompt is typically a combination of useful information about your current
environment. As I write this, my prompt reads

fyl@nicaragua:~/KDE/Command > 

This string offers three pieces of dynamic information:

fyl is my user name.• 
nicaragua is the name of this computer.• 
~/KDE/Command is the name of my current directory. Note that ~ is shorthand for my home
directory.

• 

Occasionally you may see a single > character when you are expecting either your usual shell
prompt or the prompt from an applications program. The >

character is the default secondary shell prompt and means the shell is expecting more input from
you. Most commonly, this situation occurs when you have typed one quotation mark and the shell is
expecting you to type a matching quotation mark. The quickest way out of this problem is to press
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CTRL−C. This will end the execution attempt and return you to the shell prompt.

Tip The shell prompt can be changed by setting the PS1 environment variable.

Control Characters

The shell interprets various control characters allowing you to edit the lines you enter and perform
other local tasks. Signify that you have completed entering a command line by pressing the ENTER
key. Prior to pressing ENTER, the two basic editing keys are BACKSPACE and CTRL−U. Pressing
the BACKSPACE key erases the most recently entered character. Entering CTRL−U deletes all the
characters you have entered on the current line, allowing you to start over.

Once you have pressed the ENTER key, control is turned over to the application. For example, if
you type in ls −l and press ENTER, the shell turns over control to the ls program. Thus, the
BACKSPACE and line− delete character sequences can no longer be interpreted by the shell. If you
want to terminate the execution of a program, you can press CTRL−C. This will send an interrupt to
the program.

If you want to suspend the execution of a program, press CTRL−Z. This suspends the program and
returns you to the shell prompt. Entering the fg command (followed by ENTER) will resume the
suspended program.

You can also enter bg (followed by ENTER) to resume the suspended program in the background.
This means the program will be restarted, but you will receive a shell prompt. This is useful when
you want to run a time− consuming report program and redirect both its input and output streams to
files.

Finally, you can use CTRL−S to pause the output of a running command. CTRL−Q resumes the
output. Note that program output may scroll by too fast to make effective use of these control
sequences. Generally, you will be better off using a pager program such as more or less, both of
which allow you to view the output a screenful at a time. For example, if the output of the ls −l
command is more than a screenful, you can enter ls −l | more.

Tip Some programs require that you send them an End−of−File (EOF) character to signify
that you have completed your input. To send this character, press CTRL−D.

Pipes and Redirection

By default, the shell establishes three connections with the terminal window. These connections are
called standard input, standard output, and standard error. In UNIX documentation you will
commonly see them abbreviated as stdin, stdout, and stderr.

The stdin connection is connected to the keyboard. Programs read your keyboard input by reading
from stdin. The stdout connection is connected to your screen and is the way that programs send
their output back to you. The stderr connection is also connected to your screen and is the way
programs send output about problems and abnormalities.

There are two output streams (stdout and stderr) so that it is possible to send error information to
your screen, even though the normal output of the command is being sent somewhere else (to a file
or possibly to another program).
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The tools to connect these streams to other places are called pipes and redirection. A pipe allows
you to connect the output of one program to the input of another program, that is, connect stdout of
one program to stdin of another program.

For example, say you have a program called bigreport that produces a great deal of output, and you
want to view it a screenful at a time. We previously discussed the more program that allows viewing
by the screenful.

Thus, you want to run the program bigreport and send its output (stdout) to the input (stdin) of more.
The vertical bar character (|) is used to represent the pipe, so the command to perform this task
looks like this:

bigreport | more 

The preceding example shows spaces around the pipe character. These are allowed but not
necessary. The following command would work also:

bigreport|more 

Of course, you probably don’t have a program called bigreport available to you. So, to practice,
enter a command that will produce a lot of output. Try the following command:

ls /bin | more 

You should see output like this:

Figure 13.5: Stdout Piped to more
Note that the word More appears at the bottom of the screen in reverse video. This tells you that
you are still in the more program rather than at the shell prompt. Pressing the space bar will display
the next screenful. Pressing Q

will terminate more and return you to the shell prompt.
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The more program and its more capable cousin less are very handy. To find out about additional
capabilities, enter ? at the more prompt.

With pipes we connect two programs together. With redirection we can tell a program to read either
input from a file or write output to a file. To redirect stdout to a new file, use the > character. Going
back to the previous example, we could get the ls command to write its output to the file ls.output by
entering the following command:

ls /bin > ls.output 

As with pipes, the spaces around the redirection character are optional. Now that we have this
information in a file, the next trick is actually reading it. All we need to do is use the more command
again and redirect its input (stdin) from the file we created. The input redirection operator is <, so we
enter:

more < ls.output 

The operation of more is virtually identical to the way it was before—that is, the shell handled piping,
and here it handles redirection. The more program itself knows nothing of the actual source of the
data. Contrast this with more ls.output where more itself opens the file.

Besides these two forms of redirection, there are others. The following table lists other forms of
redirection.

Character What It Does
> Redirects output (stdout) of the command to the

specified file.
>> Similar to > but will append to a file if it already

exists.
2> Redirects the error output (stderr) of the

command to the specified file.
< Redirects the input of the command (stdin) from

the specified file.
| Joins two commands. Output (stdout) of the

command on the left is sent to the input (stdin) of
the command on the right.

Command−Line Format

The previous section introduced some basic command−line formats. Now it’s time to see how
command lines really work.

• Command lines are made up of words.

• Words are separated by whitespace, which is defined as one or more spaces or tabs, or a
combination thereof.

• The first word of the line is the command itself. This is the program you are asking the shell to run.
It could be a binary program, an alias, or a script to be interpreted by the shell, or one of the many
other interpreted languages, such as awk or Python.

• The remaining words on the command line are called arguments.
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• A special argument, called an option, begins with a hyphen (−). Long options, a special kind of
option, begin with two hyphens (−−). Generally, options are used to modify the way a command
works.

• Multiple commands can be entered on one line by separating them with a semicolon (;).

• You can tell the shell to run a command in the background and thus not tie up your terminal screen
by following it with an ampersand (&).

Examples

Display a long (detailed) listing of all the files in the directory /bin paged through more:

ls −l /bin | more 

Print the date on the terminal, and then write a long list of all files in the directory /bin to the file
/tmp/testme. Note that the redirection applies only to the ls command, not to the date command:

date; ls −l /bin > /tmp/testme 

Command−Line Editing and Shell History

The shell keeps a record of your recent commands and allows you to retrieve them, edit them, and
re−execute them. Depending on the mode in which your shell is set, the history access and editing
will work much like either the Emacs editor or the vi editor. That is, all the text−editing features of
either vi or Emacs that make sense to use on a single line are available within the shell. To select vi
editor mode, enter set −o vi at your shell prompt. To select Emacs editing mode, enter set −o emacs
at your shell prompt.

You can make a permanent change to your editing mode by adding the appropriate set command to
the end of your .bashrc file in your home directory. Note that the change will not take effect until
your next login.

If you are not familiar with either Emacs or vi, you will most likely do better in the Emacs mode. In
this mode, the up and down arrow keys can be used to move through the history list, and diligent
use of the left and right arrows, as well as the BACKSPACE and DELETE keys, allow you to edit
the command. Pressing ENTER executes the resulting command.

If you are in vi mode, press ESC (ESCAPE), and then any vi command that works on a single line
can be used. Use the up and down arrows, or J and K, to move within the lines of the history list.

Command Completion

Besides providing command history, Bash will guess the name you mean if you are entering the
name of a file. Once you have entered enough of a filename to make it unique, press TAB. If it is in
fact unique, Bash will fill in the rest of the name. If it is not, nothing happens. At that point you can,
however, press TAB again, and the shell will list all the possible matches and wait for you to
continue entering characters.
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Shell Expansions

A special shorthand called shell expansions is available to allow you to select multiple filenames on
command lines. This expansion capability is one of the most powerful capabilities of the shell that is
useful on the command line. Properly used, it can save you many keystrokes and much time.

? Matches any single character. * Matches any number (zero or more) of any
characters.

~ Shorthand for the name of a home directory. ~ name is replaced with the pathname
of the home directory of user name. If name is omitted, ~ is replaced by the
pathname of your home directory.

[ ] Encloses a set of characters for a single− character match. For example, [aQz]
matches a, Q, or z. A hyphen (−) can be used to specify a range. For example,
[am−pZ] matches a, m, n, o, p, or Z. A leading ^ negates the match string. For
example, [^a−z] matches anything except a lowercase letter.

$ Introduces a shell variable. The variable is replaced with its value as saved by the
shell. For example, $HOME is replaced with the pathname of your home directory.

\ Turns off the special meaning of the following character. For example, \? matches a
? instead of any single character, and \ [ matches a [ instead of introducing a set of
matched characters.

Tip Don’t confuse shell expansions with regular expressions. They have some similarities, but they
have different capabilities available in different places.

Quoting

Besides the use of backslash (\ ) to protect a character from shell expansion or interpretation, there
are other quoting characters. Of course, a backslash can be used to turn off their special meaning.

" Disables the special meaning of all characters except $ in the enclosed string. This is
commonly used when you want to treat multiple words as a single argument.

' Disables the special meaning of all characters in the enclosed string.
` Executes the enclosed string as a command and replaces it with the output of the

executed command.
Examples

The echo command displays its arguments back to the screen. In this example, echo displays the
string entered, but $HOME will be replaced with the value of the HOME environment variable, which
is the pathname of your home directory.

echo "My home directory is $HOME" 

In this example, $HOME is displayed literally instead of being replaced with the value of the
environment variable.

echo 'My home directory is $HOME' 

The date command returns the current date and time as a 26− character string. In this example, the
backquoted reference is replaced by the result of executing the date command before the line is
printed:

echo "The current time is `date`" 
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Conventions

The remainder of this chapter uses certain conventions in its examples as a metalanguage to help
you understand the commands.

Monospaced font Monospaced font is used to indicate examples.
[ ] Square brackets are used to show optional information that may be

included within a command and shouldn’t actually be typed. Don’t
confuse this use with the character− matching operation.

Boldface Boldface identifies the proper syntax for typing particular commands—
in other words, the way the commands should be set up and typed.

italic Parameters to be replaced are shown in italic. The word used is
intended to be descriptive. The most common example is file to
represent a filename. Plurals (for example, files) are used to indicate
where multiple instances are permitted.

option The option keyword can be replaced with any of the available command
options. Using options indicates that more than one may be used.

File Hierarchy

You learned about files back in Chapter 3, where you could move around the file hierarchy by
pointing and clicking. When using the shell, you need to know how to move around the hierarchy
because you don’t get any graphical clues.

Tip Although Linux allows any character (including control characters) in filenames, it is best to
stick to letters, numbers, and some safe, special characters, such as _ , ., and ,.

Naming the Pieces

By convention, the slash character ( /) is used to separate the levels in the file hierarchy. The top
level of the whole file hierarchy, usually referred to as the root, is identified by /, and all other files
are located relative to it.

The location of a file within the hierarchy is called its pathname. Pathnames can be specified
relative to your current directory—that is, where you are now— or relative to the root directory. A
pathname starting with / signifies that it is relative to the root and is called a full pathname. If a
pathname does not start with a /, it is relative to your current directory and is called a relative
pathname.

Each directory in the hierarchy has two special files in it named . (dot) and .. (dot dot): . is a
synonym for the current directory, and .. is a synonym for the parent of the current directory. They
are always there, so you can use them as shorthand to help you move around the hierarchy.

Examples

My home directory is called fyl and lives under the directory home, which is off the root
of the hierarchy. The full pathname of my home directory is /home/fyl. 

If I am in my home directory, as described in the preceding example, and your home directory is
called jill, also located under home, then /home/jill is the full pathname to your home directory. ../jill
is the relative pathname to your home directory.
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Moving About

To move about the hierarchy and know where you are, there are two commands you need to know:
cd and pwd.

The simplest, pwd, tells you the name of your current directory. It takes no arguments.

You can use cd in three ways. First, just entering cd with no arguments will move you to your home
directory. You can, of course, check the results by entering pwd.

If you know the location of a directory relative to the root, you can follow cd with the full pathname of
the desired directory. For example, many of the programs you will use from the command line are
located in the directory /usr/bin. Entering cd /usr/bin will change /usr/bin to your current directory.
Similarly, entering cd /var/spool will make the system spool directory your current directory.

File Manipulation Utilities

Now that you can move around the filesystem and know what commands look like, it’s time to try a
few.

ls—Listing Directory Contents

You have already seen this command in earlier examples. It produces a list of names and, if so
requested, other information, about the specified files. The most basic case is ls, which lists all files
in your current directory whose name does not start with a dot (.).

The general form of the command is: ls [ options] [ files]

Common Options

−a Includes files whose names start with a dot. (Linux treats any file whose name
starts with a dot as hidden, meaning that the names are not displayed by default.)

−l Includes file size, ownership, and permission information.
−R Recursive— includes subdirectories.
−t Sorts by last modification time.
−u Sorts by time of last access instead of last modify.
Examples

Lists all files in your current directory sorted by last modify time

ls −lt 

Lists files in /usr/bin whose name starts with gif; make it a long list:

ls −l /usr/bin/gif* 

cp—Copy Files

The cp command copies one or more files. In the most basic form, you specify a source filename
and a destination filename:
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cp [ options] source destination 

If the final argument is a directory, then all specified files are copied to that directory under their
same name:

cp [ options] files directory 

Common Options

−a Archives by preserving the file attributes and including subdirectories but not
following symbolic links.

−−help Displays a help message.
−p If possible, preserves file attributes such as owner, modify time, and access

permissions.
−R Recursively includes subdirectories.
−v Explains what is being done.
Examples

Make a copy of harry in your current directory. The copy is given the new name chest in the
directory tmp.

cp harry /tmp/chest 

Copy all files whose names start with a or b in /tmp to your current directory, preserving file
attributes:

cp −p /tmp/[ab]* . 

Copy all files in the directory /home/bill/secret and any subdirectories into /tmp/savebill.

cp −R /home/bill/secret/* /tmp/savebill 

mv—Rename or Move Files

The mv command moves or renames files. You need not concern yourself with the distinction, as
mv does what is necessary. Much like the cp command, there are two formats.

In the most basic form, you just specify a source filename and a destination filename:

mv [ options] source destination 

Common Options

−−help Displays a help message.
−i Prompts before overwriting any files (interactive).
−u Moves only older or brand−new nondirectories.
−v Explains what is being done.

Tip Some Linux distributions include a shell alias that sets the −i option by default. Type
alias at the shell prompt to see your current list of aliases.
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Examples

Move the file harry in your current directory to /tmp, and name the new file chest in the directory
tmp:

mv harry /tmp/chest 

Move all files whose names start with a or b in /tmp to your current directory, prompting before
overwriting any files:

mv −i /tmp/[ab]* . 

rm—Remove Files

The rm command deletes one or more files. It can also be used to force the removal of directories.

rm [ options] files 

Common Options

−f Forces removal without prompting.
−−help Displays a help message.
−i Prompts before any removal (interactive).
−r Recusively removes the contents of directories.
−R Recursively includes subdirectories.
−v Explains what is being done.
Examples

Remove the file harry from your current directory:

rm harry 

Remove all files whose names start with a or b in /tmp:

rm /tmp/[ab]* 

Remove the directory called Garbage that is in your current directory, including all of its files and
subdirectories. In this case, the −R option can be either upperor lowercase:

rm −r Garbage 

Tip Sometimes you need to r emove a f ile whose name star ts with a hyphen. To do this, preceed
the name with ./, which doesn’t change the meaning of the file location, or use the full
pathname.

mkdir—Create a Directory

The mkdir command creates directories. This is the same as making a new folder with Konqueror:

mkdir [ options] dirnames 
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Common Options

−−help Displays a help message.
− m mode Sets directory permissions to mode masked by your umask value. Uses the

symbolic values (e.g., a=rwx) for all permissions for everyone or octal numeric
values ( 777). See the "How Permissions Work" section in this chapter.

−p Creates any missing parent directories for each argument. Mode is set to
umask modified by u+wx. Arguments corresponding to existing directories are
ignored.

−v Explains what is being done.
Examples

Make a directory named Harry in your current directory and a directory named Chest in /tmp:

mkdir Harry /tmp/Chest 

Make a directory named Harry in your current directory and force the directory permissions to
everything for user, read, and execute (search) for group, and nothing for others. (See the “How
Permissions Work” section in this chapter.)

mkdir −m u=rwx,g=rx,o−rwx Harry 

Repeat the preceding directions, only using a numeric mode specification:

mkdir −m 750 Harry 

Create the directory Chest as a subdirectory of the directory Harry in your current directory. Also,
create Harry if it doesn’t exist:

mkdir −p Harry/Chest 

rmdir—Remove a Directory

The rmdir command is the opposite of the mkdir command. It removes empty directories.

rmdir [ options] directories 

Common Options

−−help Displays a help message.

−p Removes a directory and then tries to remove each component of the pathname.

−v Explains what is being done.

Examples

Remove the directory named Harry in your current directory and a directory named Chest
in /tmp: rmdir Harry /tmp/Chest 
Remove the directory Chest as a subdirectory of the directory Harry in your current directory.
Then, if Harry is empty, delete it as well: rmdir −p Harry/Chest 
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Text Editors

This section introduces the most common editors used with Linux on the command line, but an
entire book could be written on each editor. In the case of vi and Emacs, that has already
happened.

Don’t confuse these text editors with word processors. These are programs designed to let you
enter and edit text. Their text−formatting capabilities are limited to setting line−length limits.
Traditionally, these editors were used in conjunction with text−processing programs, such as troff, to
produce typeset documents.

Emacs

Emacs is a project of the Free Software Foundation. Many people see it as a work environment
rather than only an editor. It includes its own built− in programming language, so you can customize
its operation.

Joe

Less popular than Emacs or vi, Joe has a lot to offer the beginner. Besides its easy−to−use default
mode with on−screen menu, it can emulate the basics of Emacs and vi.

vi

vi is the most popular, by far, of the available editors. There are many flavors of vi, including nvi,
vim, vile, elvis, and stevie. All share what is called a moded system, where you enter text in one
mode and edit in another. The users and developers of vi pride themselves on minimizing the
number of keystrokes required to complete a task.

lpr—Send File to a Printer

The lpr command can be used to spool a file for printing. This is similar to the menu choices in GUI
applications and the drag−and− drop capability in KDE.

lpr [ options] [ files] 

If no files are specified, then lpr reads from standard input.

Common Options

− m [ user] Sends email to user (you as default) when the job has printed.
−P ptr Sends the file to the printer named ptr instead of your default

($PRINTER).
−r Removes the file after printing.

File Attributes and Permissions

Associated with each file and directory are two ownership fields and a set of permissions.
Ownership and permissions are used to restrict access to files.
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How Permissions Work

Each file has an owner, which is the user ID associated with the file. It also belongs to a group,
which by default is set to the default group of the user who created the file. For example, your
system might be set up so that everyone in a department is in the same group. To share a file with a
member of another group, you could change the group owner to the owner of the other group.

There are a total of nine basic file permissions, divided into three groups. Those groups are
associated with the file owner, the group the file belongs in, and everyone else.

Within those three groups, permission to read the file, write to the file, and use the file as an
executable program are available. In addition, there are similar permissions associated with each
directory.

Note that when you create a file, you are the owner. A normal user cannot change that ownership. If
such a change is necessary, your system administrator must log on as the root user to make the
change.

You can think of the permissions as a three− digit octal number. The leftmost digit represents the
user’s permissions. The next one represents the group’s permissions, and the last digit represents
the permissions of everyone else.

Within each digit, a 4 represents file− read permission, a 2 represents filewrite permission, and a 1
represents file−execute permission or the ability to search for directories. It is only necessary to add
up these values for each digit in order to set the permissions. For example, 754 represents read,
write, and execute permission for the file owner (7=4+2+1), read and execute permission for the
group (5=4+1), and only read permission for everyone else.

As an alternative, the permissions can be specified symbolically using a combination of letters (u, g,
and o to represent user, group, and other, respectively, and r, w, and x to represent read, write, and
execute permission, respectively). The letter a is used to represent the combination of u, g, and o.

These letters are combined using punctuation to specify the permissions. Using an equal sign (=)
sets the permissions to the value specified, a minus sign (−) indicates permissions to be removed,
and a plus sign (+) represents permissions to be added.

If more than one of the ownership/punctuation/permissions strings is required (for example, if you
want to add group write and remove read for other), you combine the sets with a comma (,). If all
this sounds harder than the numeric specification, it is. But it is there if you wish to use it.

To use the example 754 from the preceding numeric explanation, you could specify
these same permissions as u=rwx,g=rx,o=r. 

chmod—Change File Permissions

The chmod command is used to change file (and directory) permissions. Specify the desired
permissions symbolically or numerically in octal:

chmod [ options] mode files 
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Common Options

−c Like −v but only reports if a change is made.
−f Suppresses error messages
−−help Displays a help message.
−R Changes file and directory permissions recursively.
−v Explains what is being done.
Examples

Change the permissions on the file harry in your current directory to read and write for the owner,
read for the group, and nothing for everyone else:

chmod 640 harry 

Change the permissions on the directory Harry and anything it contains to read and execute for
owner only:

chmod −R 500 Harry 

Tip There are three additional permission bits for each file and directory that may be of
interest to the advanced user. Type man chmod for details.

chgrp—Change File Group

The chgrp command is used to change the group to which a file (or directory) belongs:

chgrp [ options] group files 

Common Options

−c Like −v but only reports if a change is made.
−−help Displays a help message.
−R Changes file and directory permissions recursively.
−v Explains what is being done.
Examples

Change the group on harry in your current directory to buenas:

chgrp buenas harry 

Change the group ownership on the directory Harry and anything it contains to buenas:

chgrp −R buenas Harry 

Tip The chown command can change both the owner and group of a file, but only the superuser is
permitted to change file ownership.

Information

file—Guess File Type

Sometimes you need an educated guess as to what is contained in a file. The file command will do
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this for you. It uses a combination of innate intelligence and a magic number file to come up with a
reasonable guess.

file files 

Examples

Guess the type of the file harry in your current directory:

file harry 

Guess the type of all files in /tmp:

file /tmp/* 

man—Online Documentation

If you are looking for the description of a command or a command that works with something in
particular, the man command can help.

Examples

To display documentation on a specific command, use:

man [ section] command 

To search for all commands related to a keyword, use:

man −k keyword 

Examples

Display information about the more command, defaulting the section number:

man more 

Display information about the more command, specifying the section number. Note that all user
commands are in section 1, system calls in section 2, library functions in section 3, and so on. You
will almost always want section 1:

man 1 more 

List a synopsis of all commands related to the keyword permissions:

man −k permissions 

Sorting and Searching

Linux comes with a whole host of utilities for finding things and manipulating data. What you see
here is a very small subset. For serious data manipulation and reporting, look into awk, Perl, and
Python.

299



Using pipes to string these commands together and connect them to pager commands, such as
more, is very common. This is where the toolkit aspect of Linux comes into play.

grep—Searching for Strings in Files

The grep command is used to locate a data pattern within a file. It gets its strange name from the
command you would need to type into the original UNIX editor in order to perform this task.

In its most basic form, grep only displays lines that match the specified character string. However, to
take fu l l  advantage of  grep you need to understand regular  expressions,  a special
pattern−specification language.

grep [ options] string files 

Common Options

−c Counts the number of matched lines rather than actually printing them out.
−i Ignores the case of the letters in the match string.
−l Prefixes each output line with the line number within the input file.
−v Inverts match, only displaying lines that do not match.
Examples

Display all lines that contain the string cool in the file harry in your current directory:

grep cool harry 

Display all the lines that do not contain the string real cool in the file harry in your current directory
and page the output through more:

grep −v "real cool" harry | more 

Display all the lines in a long list of the files in your current directory that contain the string Oct
followed by a space. Page the output through more:

ls −l | grep "Oct " | more 

find—Locating a File

The find command has a very complicated syntax and a lot of options but, because of this, is
extremely powerful:

find [ paths] expression 

The paths portion tells find where to start searching. It then continues recursively under the
specified starting point or points.

The expression part is a series of conditions used to specify the file you want to find, plus, if you
wish, the action to be taken to each match. The default action is simply to print the name of the file.
By default, all the specified conditions must be met. They are matched in order from left to right. For
“or” rather than “and” conditions, use an −o connecting expression.
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Common Options

−name filename The filename must match. Note that the shell wildcard characters can be used in
the match, but the match string must be quoted to prevent the shell, rather than find, from doing the
expansion.

−group group File belongs to group group.
−name filename Like − iname but case− insensitive.
−newer file Desired file was modified more recently than file.
−v Explains what is being done.
Examples

Look for the file harry, starting in your current directory:

find . −name harry 

Repeat the preceding example, but ignore the case and match any file whose name starts with
harry:

find . −iname "harry*" 

Look for any file whose name matches harry or chest in your current directory and the home
directory of bill:

find . ~bill −name harry −o −name chest 

locate—Locating a File

Although find will always find a file, it can take a long time. The locate command uses a database
that is created regularly (usually daily) to try to find a matching file.

It is sometimes desirable to combine locate with grep to narrow down the match.

locate [ options] pattern 

Common Options

−I Ignores the case of the match.
−−help Displays a help message.
Examples

Locate any file whose pathname contains the string picture:

locate picture 

Locate any file whose pathname contains both picture and Secret:

locate picture | grep Secret 
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System−Related Commands

Here is just a brief introduction to some system− related commands. While you saw much of this
functionality with the KDE−specific graphical commands, there may be an advantage to using the
command line with some of these.

Think about what you have learned about grep, for example. You could use grep to select specific
lines from the output of the ps command.

ps—Process Status

Each active program in Linux is called a process. When you enter a command, you start a process.
If you enter multiple commands, connected by pipes, you are starting two or more processes.

In addition, the system has many daemons. These are programs that take care of the system and
perform background processes for you. A good example is the print spooler—the program that
monitors the print queues and interacts with the printer.

By default, ps shows only processes that are owned by you.

ps [ options] 

Common Options

A Shows all processes associated with a terminal.
T Shows all processes associated with this terminal.
L Shows a long display format.
F Shows the ASCII art process hierarchy.
Tip There is an amazing array of options available to format and sort the output. See the man

page for details.
Examples

Display all your processes:

ps 

Display all processes associated with a terminal in the long format:

ps al 

Display a process hierarchy tree for all terminal− related processes.

ps af 

top—Ongoing Process Status

If you want to see an ongoing display of current processes, top is the answer. Processes are sorted
with the most active at the top. There are many options and interactive commands, but 99 percent
of all runs are just top alone. Terminate top by pressing Q.

top 
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df—Display Free Disk Space

This command displays the location, mount point, size, amount used, and percentage used of all
mounted filesystems of nonzero size. Many options exist, but the default is almost always what you
need.

df 

du—Display Disk Space Usage

This command estimates file usage recursing downward from the specified location or locations.

du [ options] files 

Common Options

−a Writes counts for all files, not just directories.
−h Prints sizes in human− readable format.
−−help Displays a help message.
−s Prints summaries for each argument.
Examples

Show usage of all files under your current directory:

du 

Show summary usage information for /usr/bin and /bin:

du −s /usr/bin /bin 

Conclusion

This chapter has only scratched the surface as far as the capabilities of the command line.
Hundreds of commands are available at the shell prompt and a lot more capabilities are within the
command line of the shell. In addition, the shell offers a built− in programming language that makes
it possible to make decisions and execute commands selectively.

Complete books have been written on shell programming. If you would like to know more, we
suggest you take a trip to a good technical book store and find a book that is a good fit for you.

Also, SSC offers two reference cards, one on Bash and the other on the Korn shell as part of its
Linux Library series. You can check them out, as well as other SSC books and reference cards at
http://store.linuxjournal.com/
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Appendix A: Openoffice Default Key
Binding/Keyboard Shortcuts

OpenOffice Writer

F2  Insert Formula
F3  Run AutoText Entry
F5  Navigator On/Off
F7  Spell Check
F8  Extended Selection On
F9  Update Fields
F11  Stylist On/Off
F12  Numbering On/Off
Down Arrow To Line Below
Up Arrow To Top Line
Left Arrow To Character Left
Right Arrow Go Right
HOME  To Beginning of Line
END To End of Line
PAGE UP To Previous Page
PAGE DOWN To Next Page
RETURN Insert Paragraph
ESCAPE Cancel
INSERT Type Over or Insert Mode
SHIFT + F5 To Next Frame
SHIFT + F8 MultiSelection On
SHIFT + F9 Calculate Table
SHIFT + F11 New Template (apply)
SHIFT + F12 Bullets On/Off
SHIFT + Down Arrow Select Down
SHIFT + Up Arrow Select to Top Line
SHIFT + Left Arrow Select Character Left
SHIFT + Right Arrow Select Character Right
SHIFT + HOME Select to Beginning of Line
SHIFT + END Select to End of Line
SHIFT + PAGE UP Select to Previous Page
SHIFT + PAGE DOWN Select to Next Page
CTRL + 1 Line Spacing: 1
CTRL + 2 Line Spacing: 2
CTRL + 5 Line Spacing: 1.5
CTRL + B Bold
CTRL + D Double Underline
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CTRL + E Center
CTRL + I Italic
CTRL + J Justify
CTRL + L Align Left
CTRL + R Align Right
CTRL + U Underline
CTRL + Y Style Catalog
CTRL + Z Undo
CTRL + Down Arrow Move Current Line Down
CTRL + Up Arrow Move Current Line Up
CTRL + Left Arrow To Word Left
CTRL + Right Arrow To Word Right
CTRL + HOME To Beginning of Document
CTRL + END To End of Document
CTRL + PAGE UP To Header
CTRL + PAGE DOWN To Footer
CTRL + SPACE Insert Nonbreaking Space
CTRL + BACKSPACE Delete to Start of Word
CTRL + DELETE Delete to End of Word
CTRL + Minus (−) Insert Soft Hyphen
CTRL + SHIFT + B Subscript
CTRL + SHIFT + F Repeat Search
CTRL + SHIFT + P Superscript
CTRL + SHIFT + R Restore View
CTRL + SHIFT + T Unprotect Sheet
CTRL + SHIFT + F9 Update Input Fields
CTRL + SHIFT + F11 Update Template (apply)
CTRL + SHIFT + F12 Numbering Off
CTRL + SHIFT + Down Arrow To End of Table
CTRL + SHIFT + Up Arrow To Beginning of Table
CTRL + SHIFT + Left Arrow Select to Beginning of Word
CTRL + SHIFT + Right Arrow Select to Word Right
CTRL + SHIFT + HOME Select to Beginning of Document
CTRL + SHIFT + END Select to End of Document
CTRL + SHIFT + BACKSPACE Delete to Start of Sentence
CTRL + SHIFT + DELETE Delete to End of Sentence

OpenOffice Calc

F2 Set Input Mode
F4 Data Sources
F5 Navigator On/Off
F7 Spell Check
F8 Status of Extended Selection
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F9 Recalculate
F11 Stylist On/Off
F12 Insert Group
DownArrow Move Down
Up Arrow Move Up
Left Arrow Move Left
Right Arrow Move Right
HOME To Beginning of Document
END To End of Document
PAGE UP Page Up
PAGE DOWN Page Down
ESCAPE Cancel
BACKSPACE Delete Contents
INSERT Paste Special
SHIFT + F4 Relative/Absolute References
SHIFT + F5 Trace Dependents
SHIFT + F8 Status of Expanded Selection
SHIFT + F11 Save as Template
SHIFT + Down Arrow Select Down
SHIFT + Up Arrow Select Up
SHIFT + Left Arrow Select Left
SHIFT + Right Arrow Select Right
SHIFT + HOME Select to Beginning of Document
SHIFT + END Select to End of Document
SHIFT + PAGE UP Select Page Up
SHIFT + PAGE DOWN Select Page Down
SHIFT + SPACE Select Row
SHIFT + BACKSPACE Undo Selection
CTRL + 1 Line Spacing: 1
CTRL + 2 Line Spacing: 2
CTRL + 5 Line Spacing: 1.5
CTRL + B Bold
CTRL + D Selection List
CTRL + E Align Center Horizontally
CTRL + I Italic
CTRL + J Justify
CTRL + L Align Left
CTRL + R Align Right
CTRL + U Underline
CTRL + Y Style Catalog
CTRL + Z Undo
CTRL + Down Arrow To Lower Block Margin
CTRL + Up Arrow To Upper Block Margin
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CTRL + Left Arrow To Left Block Margin
CTRL + Right Arrow To Right Block Margin
CTRL + HOME To Beginning of File
CTRL + END To End of File
CTRL + SPACE Select Column
CTRL + BACKSPACE To Current Cell
CTRL + SHIFT + 1 Number Format: Decimal
CTRL + SHIFT + 2 Number Format: Exponential
CTRL + SHIFT + 3 Number Format: Date
CTRL + SHIFT + 4 Number Format: Currency
CTRL + SHIFT + 5 Number Format: Percentage
CTRL + SHIFT + 6 Number Format: Standard
CTRL + SHIFT + B Subscript
CTRL + SHIFT + F Repeat Search
CTRL + SHIFT + P Superscript
CTRL + SHIFT + R Redraw
CTRL + SHIFT + T Sheet Area Input Field
CTRL + SHIFT + F9 Recalculate Hard
CTRL + SHIFT + Down Arrow Select to Lower Block Margin
CTRL + SHIFT + Up Arrow Select to Upper Block Margin
CTRL + SHIFT + Left Arrow Select to Left Block Margin
CTRL + SHIFT + Right Arrow Select to Right Block Margin
CTRL + SHIFT + HOME Select to Beginning of File
CTRL + SHIFT + END Select to End of File

OpenOffice Impress

F2 Text
F3 Enter Group
F4 Position and Size
F5 Navigator On/Off
F7 Spell Check
F8 Edit Points
F11 Stylist On/Off
F12 Outline View
DELETE Delete
SHIFT + F3 Duplicate
SHIFT + INSERT Paste
SHIFT + DELETE Cut
CTRL + 1 Line Spacing: 1
CTRL + 2 Line Spacing: 2
CTRL + 5 Line Spacing: 1.5
CTRL + B Bold
CTRL + C Copy
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CTRL + E Center
CTRL + I Italic
CTRL + J Justify
CTRL + L Align Left
CTRL + N New
CTRL + O Open File
CTRL + P Print File
CTRL + Q Exit
CTRL + R Align Right
CTRL + S Save Document
CTRL + U Underline
CTRL + V Paste
CTRL + W Close Window
CTRL + X Cut
CTRL + Y Style Catalog
CTRL + Z Undo
CTRL + F2 Slide Show
CTRL + F3 Exit Group
CTRL + SHIFT + A Ungroup
CTRL + SHIFT + B Subscript
CTRL + SHIFT + G Group
CTRL + SHIFT + K Combination
CTRL + SHIFT + P Superscript
CTRL + SHIFT + F8 Fit to Frame

OpenOffice Draw

F2 Text
F3 Enter Group
F4 Position and Size
F5 Navigator On/Off
F7 Spell Check
F8 Edit Points
F11 Stylist On/Off
DELETE Delete
SHIFT + F3 Duplicate
SHIFT + INSERT Paste
SHIFT + DELETE Cut
CTRL + 1 Line Spacing: 1
CTRL + 2 Line Spacing: 2
CTRL + 5 Line Spacing: 1.5
CTRL + B Bold
CTRL + C Copy
CTRL + E Center
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CTRL + I Italic
CTRL + J Justify
CTRL + L Align Left
CTRL + N New
CTRL + O Open File
CTRL + P Print File
CTRL + Q Exit
CTRL + R Align Right
CTRL + S Save Document
CTRL + U Underline
CTRL + V Paste
CTRL + W Close Window
CTRL + X Cut
CTRL + Y Style Catalog
CTRL + Z Undo
CTRL + F3 Exit Group
CTRL + Plus (+) Bring Forward
CTRL + Minus (− ) Send Backward
CTRL + SHIFT + A Ungroup
CTRL + SHIFT + B Subscript
CTRL + SHIFT + G Group
CTRL + SHIFT + K Combination
CTRL + SHIFT + P Superscript
CTRL + SHIFT + F8 Fit to Frame
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Appendix B: What Does What: Matching Your Task
with the Appropriate Program
The following programs are frequently included with major Linux distributions and are used to
perform common office tasks. The program name is listed in the first column, which is usually how it
appears in the K menu. The second column shows the command you type in the Run Command
dialog box to launch a program, and the third column describes what the program does. Note that
the program names and commands may vary slightly for some applications, depending on the
version of KDE and the installation.

Program Command What It Does
AbiWord abiword A cross−platform word processor
Acrobat Reader acroread Views and prints Adobe PDF files
Ark (Archiver) ark An archiving tool for managing compressed files
Emacs emacs An extensible, multiplatform text editor
Find Files kfind Locates files within a directory hierarchy
The GIMP gimp The GNU Image Manipulation Program
gv gv Views and prints PostScript and PDF files
ImageMagick display Views, reads, and writes images in

multiple formats
KAddress Book kaddressbook An address manager
KArm karm Personal time tracker
Kate kate A multidocument text editor with syntax

highlighting
KBear kbear A graphical FTP client
KCalc kcalc A scientific calculator
KChart kchart A chart and diagram application
KDE Application Finder kappfinder A menu updating tool
(KAppfinder)
KDE Floppy Formatter kfloppy Formats 3.5" and 5.25" floppy disks
KDVI (DVI Viewer) kdvi Views and prints DVI files produced by the TeX

typesetting system
KEditBookmarks keditbookmarks A bookmark editing tool
KFax/KFaxView kfax Displays and prints all common fax file formats
KGhostView kghostview Views and prints PostScript and PDF files
KIconEdit kiconedit A graphics editor for creating icons
Kivio kivio A flowchart program
KJots kjots A note−taking and organizing application
Klipper klipper A clipboard cut−and−paste utility
(Cut & Paste History)
KLpq

(View Print Job Queue)

klpq Shows the print queue and allows

you to remove print jobs
KMail kmail The KDE mail client
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KMix (Sound Mixer) kmix Allows you to change the volume of your

sound card
KNewsTicker kticker Downloads and displays news headlines from
(News Ticker) selected sites
Program Command What It Does
Knode knode A Usenet news reader
KNotes (Pop−up Notes) knotes A tool for placing pop−up notes on your desktop
Konqueror konqueror A document viewer, file manager, and web

browser
Konsole (Shell) konsole A terminal emulator window, also known as a

shell
Kontour kontour A vector−based drawing application
KOrganizer korganizer A personal information manager, including a

calendar and scheduler
KPager (Desktop Pager) kpager Gives a thumbnail view of all virtual desktops
KPaint kpaint A painting program
KPasswd kdepasswd Allows you to change your KDE password
KPilot kpilot Enables your Palm/Palm Pilot/Visor to exchange

information with your computer
KPresenter kpresenter A presentation program
KRuler kruler Measures the size of desktop objects and images
KsCD (CD Player) kscd KDE’s CD player
KSnapshot ksnapshot Takes screenshots of an entire desktop or
(Screen Capture) a single window
KSpread kspread A spreadsheet program
KTimer ktimer A task scheduler
Kugar kugar A business report generator
KView kview An image viewer with format conversion and

image−processing capabilities
KWrite (Advanced Editor) kwrite A text editor with syntax highlighting support
Menu Editor kmenuedit Allows you to reconfigure the K menu
Noatun noatun A plugin−based multimedia player
(KDE Media Player)
Open Calc scalc A spreadsheet program
Open Draw sdraw A raster−based image graphics program
Open Impress simpress A presentation program
Open Writer swriter A word processor
Send to Fax kdeprintfax Views and faxes files
Xpdf xpdf A PDF file viewer
XScreenSaver xscreensaver A screensaver and locker for the X Window
(Lock Screen) system
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Appendix C: Creating and Maintaining a GPG Key for
Kmail
KMail’s GPG integration is great, but you need a GPG key to use it. Here is the basic information
necessary to create and maintain a GPG key. We can’t provide an entire GPG tutorial here, but this
introduction should be enough to get you started as a user who wants to correspond confidentially
with a few people.

Generating Your Key

The first time you run GNU Privacy Guard, by typing gpg on the command line, it will create a
.gnupg directory and write a blank options file in your home directory, then exit.

Run gpg again with the − − gen−key option, by typing gpg −−gen−key on the command line, to
generate a new key. GPG will prompt you for several options. The defaults are secure and
convenient for almost any use.

The last step in the key generation process is selecting a passphrase. If someone steals your
computer or gains access to a copy of your home directory, he or she will not be able to use your
key to decrypt or sign anything without this passphrase.

However, if someone steals your computer or makes a copy of your home directory, he or she will
be able to make an unlimited number of guesses at your passphrase very quickly. So pick a good
one—no t just a word, short sentence, or poem.

Your passphrase should be rude or embarrassing, and contain letters, numbers, and punctuation.
Nobody will ever see it, so reveal your innermost thoughts or fantasies, which would be hard for
others to guess. Using a naughty passphrase will remind you not to type it where others can see. If
there are no numbers or punctuation in your naughty thoughts, add them in inappropriate but
easy−to− remember places.

There are three more important steps to take when you first create a key. First, save the key ID and
fingerprint, which you will need to prove to other people that the key is yours.

You can do this by cutting and pasting the last three lines of output from generating your key, which
look something like this:

pub 1024D/5BAD9DC9 2002−05−24 Joe Test (test key drivel do not use) 
<joe@example.com> 
   Key fingerprint = C321 0ACC 837E 3CCA 9EA1 0359 C9A8 2939 5BAD 9DC9 
   sub 1024g/B5B76E08 2002−05−24 

Your key ID is the 8 hex digits after “pub”— in this case, 5BAD9DC9. If you need your key ID and
fingerprint again, type $ gpg −−finger joe@example.com.

And the last thing? Generate a revocation certificate. Don’t worry, we aren’t throwing away your
hard work by revoking your key. We’re making it possible for you to revoke your key if you need to
do so but your computer is gone. (If someone sees you type your passphrase, then steals your
computer, you will be happy you had this certificate.) To create the revocation certificate, type

$ gpg −−gen−revoke 5BAD9DC9 > gpg−emergency.txt 
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Follow the prompts, then print the gpg−emergency.txt file, and keep it someplace safe, away from
your computer.

Posting Your Key to a Keyserver

Remember the .gnupg directory that GPG created the first time we ran it? Enter that directory, and
edit the file options. Your system administrator should tell you what keyserver to use; otherwise,
check http://www.pgp.net/ for a server near you.

Let’s say you have decided to http://keyserver.example.com as your keyserver. Add the line

keyserver keyserver.example.com 

to your options file, save it, and quit your editor. (At Linux Journal, we use http://wwwkeys.pgp.net/)

Now you can post your key to the keyserver with the command

gpg −−send−keys 5BAD9DC9 

(use your own key ID).

Signing Other People’s Keys

KMail automatically tells GPG to get senders’ keys from the keyserver when you get mail from
them.

Keysigning Events

Some people hold keysigning events to sign each other’s GPG keys. This helps people from around
the world who don’t know each other communicate. Don’t worry about not knowing much GPG
before you attend an event; the organizer will send you a step− by−step guide to follow.

OpenPGP and GPG Documentation

Detailed documentation is available at http://www.gnupg.org/docs.html
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